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Preface

Intended Audience
Welcome to Release 11i of the Using Oracle Workflow in Oracle Order Management.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area

■ Oracle Order Management

■ Oracle Workflow

If you have never used Oracle Order Management or Oracle Workflow, Oracle 
suggests you attend one or more of the Oracle Order Management or Oracle 
Workflow training classes available through Oracle University.

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This guide contains the information you need to understand and use Oracle Order 
Management and Oracle Workflow.

■ Chapter 1 of this manual provides an introduction about how Oracle Workflow 
is implemented and used in Oracle Order Management.
xi



■ Chapter 2 discusses how orders in Oracle Order Management are processed 
using Oracle Workflow.

■ Chapter 3 explains how to extend the seeded processes, subprocesses, and 
activities to meet your business needs.

■ Chapter 4 defines and details the workflow processes used in Oracle Order 
Management.

■ Chapter 5 defines and details the workflow subprocess used in Oracle Order 
Management. 

■ Chapter 6 defines and details the workflow function activities used in Oracle 
Order Management.

■ Appendix A of this manual displays all navigation paths within the application.

■ Appendix B of this manual addresses troubleshooting for expected and 
unexpected errors. 

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/. 

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This 
documentation may contain links to Web sites of other companies or organizations 
that Oracle does not own or control. Oracle neither evaluates nor makes any 
representations regarding the accessibility of these Web sites. 
xii



Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Order Management and Oracle Workflow

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

■ Online Help - Online help patches are available on Oracle MetaLink.

■ About Documentation -This document lists new features available by patch 
and identifies any associated new documentation. The About Doc is available 
on Oracle MetaLink.

Related User’s Guides
Oracle Order Management and Oracle Workflow share business and setup 
information with other Oracle Applications products. Therefore, you may want to 
refer to other user’s guides when you set up and use Oracle Order Management or 
Oracle Workflow.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Order 
Management and Oracle Workflow (and any other Oracle Applications products). 
This guide also includes information on setting user profiles, as well as running and 
reviewing reports and concurrent processes.
xiii



You can access this user’s guide online by choosing ”Getting Started with Oracle 
Applications” from any Oracle Applications help file.

User Guides Related to This Product

Oracle Advanced Pricing User’s Guide
This guide describes how to set up modifiers, price lists, formulas, pricing 
agreements, pricing rules, and how to price special orders in Oracle Advanced 
Pricing.

Oracle Inventory User’s Guide
This guide describes how to define items and item information, perform receiving 
and inventory transactions, maintain cost control, plan items, perform cycle 
counting and physical inventories, and set up Oracle Inventory.

Oracle Manufacturing Scheduling User’s Guide
This guide describes how to use Oracle Manufacturing Scheduling to view and 
reschedule single discrete jobs or the entire shop floor. This guide also details how 
to use the drag and drop functionality to view and reschedule jobs, operations, and 
resources.

Oracle Master Scheduling/MRP and Oracle Advanced Supply Chain Planning 
User’s Guide
This guide describes how to anticipate and manage both supply and demand for 
your items. Using a variety of tools and techniques, you can create forecasts, load 
these forecasts into master production schedules, and plan your end-items and their 
component requirements. You can also execute the plan, releasing and rescheduling 
planning suggestions for discrete jobs and repetitive schedules.

Oracle Order Management User’s Guide
This guide describes how to enter sales orders and returns, copy existing sales 
orders, schedule orders, release orders, create price lists, and discounts for orders, 
run processes, and create reports.
xiv



Oracle Receivables User’s Guide
Use this manual to learn how to implement flexible address formats for different 
countries. You can use flexible address formats in the suppliers, banks, invoices, and 
payments windows.

Oracle Release Management User's Guide
This manual describes how to manage high volume electronic demand by 
continually incorporating your customers demand into your order and planning 
processes. By explaining how to validate, archive, manage and reconcile incoming 
planning, shipping and production sequence schedules with updates to sales orders 
and forecasts, it enables you to electronically collaborate with your customers to 
more accurately manage demand. It also describes how to plan, create and manage 
trading partner layers for trading partner specific customizations.

Oracle Shipping Execution User’s Guide
This guide describes how to set up Oracle Shipping Execution to process and plan 
your trips, stops and deliveries, ship confirmation, query shipments, determine 
freight cost and charges to meet your business needs.

Oracle Supplier Scheduling User’s Guide
This guide describes how you can use Oracle Supplier Scheduling to calculate and 
maintain planning and shipping schedules and communicate them to your 
suppliers.

Oracle Work in Process User’s Guide
This guide describes how Oracle Work in Process provides a complete production 
management system. Specifically this guide describes how discrete, repetitive, 
assemble-to-order, project, flow, and mixed manufacturing environments are 
supported.

Oracle Workflow User’s Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes.You also use 
this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.
xv



Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.
xvi



Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Applications Product Update Notes
Use this guide as a reference for upgrading an installation of Oracle 
Applications. It provides a history of the changes to individual Oracle 
Applications products between Release 11.0 and Release 11i. It includes new 
features, enhancements, and changes made to database objects, profile options, 
and seed data for this interval.

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in 
more than one currency, use this manual before implementing Oracle Order 
Management. This manual details additional steps and setup considerations for 
implementing Oracle Order Management with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle Order Management with Oracle 
Applications' Multiple Organization support feature, so you can define and support 
different organization structures when running a single installation of Oracle Order 
Management.
xvii



Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Order Management. implementation team, as well as for users responsible 
for the ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.

Oracle Configure to Order Implementation Manual
This manual explains how to set up Oracle Applications to use the configure to 
order functionality.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on MetaLink

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes API’s and open interfaces found in Oracle Order Management Suite.

Support

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Order Management. 
and Oracle Workflow working for you. This team includes your Technical 
Representative, Account Manager, and Oracle’s large staff of consultants and 
support specialists with expertise in your business area, managing an Oracle8i 
server, and your hardware and software environment.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.
xviii



Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.

Your Feedback
Thank you for using Oracle Order Management, Oracle Workflow, and this manual.
xix



Oracle values your comments and feedback. At the end of this guide is a Reader’s 
Comment Form you can use to explain what you like or dislike about Oracle 
Workflow, Oracle Order Management, or this guide. Send your comments to the 
electronic mail address mfgdoccomments_us@oracle.com and indicate if you 
would like a reply.
xx



Introd
1

Introduction

Topics covered in this chapter include the following:

■ Using Oracle Workflow in Oracle Order Management on page 1-2

■ Setting Up Oracle Workflow in Oracle Order Management on page 1-2

■ Viewing Processes in Oracle Workflow Builder on page 1-3

■ Viewing Workflows in Oracle Order Management on page 1-4

■ Seeded Data Files on page 1-6

■ Item Types on page 1-10
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Using Oracle Workflow in Oracle Order Management
Using Oracle Workflow in Oracle Order Management
Oracle Order Management uses Oracle Workflow to control the sequence of events 
that occurs in the processing of sales documents such as orders, quotes, blanket 
sales agreements, returns, order lines, and return lines. Oracle Workflow manages 
activities, executes functions, sends notifications, maintains completed activity 
history, detects errors, and initiates error processes. Oracle Order Management also 
uses Oracle Workflow to enable you to track the history of orders.

Oracle Order Management enables you to model your business processes in terms 
of generic order processes. When defining a new workflow, you can begin with the 
basic activities of order processing. You can model your business processes by 
copying and editing seeded processes or by using seeded and custom activities as 
components.

This guide provides details about how to extend Oracle Workflow in Oracle Order 
Management to best meet your business needs. This guide also provides detailed 
information regarding the workflow processes that come seeded with Oracle Order 
Management.

For information regarding implementation and setup of Oracle Workflow, refer to 
the Oracle Workflow User’s Guide. For information regarding the setup and 
implementation or Oracle Order Management, refer to the Oracle Order Management 
Implementation Manual.

Setting Up Oracle Workflow in Oracle Order Management
There are certain setup requirements to complete before using Oracle Workflow 
with Oracle Order Management. This guide details the requirements for setting up 
and using Oracle Workflow in Oracle Order Management. First review all seeded 
Oracle Order Management workflow data to determine if the seeded flows meet 
your business requirements. You may decide to use Oracle Workflow Builder to 
define new workflow processes.

The Oracle Workflow User’s Guide provides a list of setup steps for Oracle Workflow, 
and explains the setup necessary for all modules. For example, the guide explains 
that an access level of 100 in Oracle Workflow Builder is necessary. Do not change 
this access level.

Warning: Oracle does not provide support if the access level of 
100 is changed.
1-2 Using Oracle Workflow in Oracle Order Management



Viewing Processes in Oracle Workflow Builder
For more information about extending the seeded Oracle Order Management 
workflow processes, refer to Chapter 3, Extending Oracle Order Management 
Seeded Workflows.

For more information about setting up Oracle Workflow, refer to the Oracle Workflow 
User’s Guide.

Viewing Processes in Oracle Workflow Builder
From within the Oracle Workflow Builder you can view the different workflow 
processes discussed in this manual and their associated functions, messages, 
subprocesses, notifications, and properties.

To view processes in Oracle Workflow Builder, complete the following steps:

1. Within Oracle Workflow Builder, select Open from the File menu, and connect 
to the database.

2. Expand the data source, then select the item type branch within that data 
source.

3. Expand the processes branch within your item type and select a process activity 
to display the diagram of the process in a Process window.

 The following image depicts the Oracle Workflow Builder:
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Viewing Workflows in Oracle Order Management
Figure 1–1 Oracle Workflow Builder

Viewing Workflows in Oracle Order Management
From within Oracle Order Management you can view the active workflow 
processes discussed in this manual and their associated functions, messages, 
subprocesses, notifications, and properties. These processes must be in an active 
running state and also associated with a sales order or sales order line in order to 
view them.

To view processes for specific orders within Oracle Order Management, complete 
the following steps:

1. Open the desired order in Oracle Order Management.

2. Navigate to the Tools menu and select Workflow Status.

3. A new window opens and displays the workflow status as an activities list. 
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The following image depicts the Activities List window in Oracle Order 
Management:

Figure 1–2 Activities List Window

4. From the Activities List window you can select the order header workflow 
process or the order line workflow processes associated with the order. 
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Selecting an order line workflow process opens a new activities list for that 
process.

5. Select View Diagram under the activities list to view the actual workflow 
diagram. 

The following image depicts the View Diagram window in Oracle Order 
Management:

Figure 1–3 View Diagram Window

Seeded Data Files
Each of the Oracle Order Management seeded workflows and their associated 
activities are contained in the following seeded data file:

■ oexwford.wft
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The following seeded data file comes seeded with Oracle Discrete Manufacturing, 
and is used in conjunction with Oracle Order Management:

■ ctochord.wft

Seeded Data File oexwford.wft

Item Types
The seeded data file oexwford.wft contains the following item types:

■ OM Change Order

■ OM Order Header

■ OM Order Line

■ OM Standard

■ OM Negotiation Header 

■ OM Blanket Header 

Processes
The seeded data file oexwford.wft contains the following processes:

■ Change Order Process

■ Line Flow - ATO Item

■ Line Flow - ATO Model

■ Line Flow - Configuration

■ Line Flow - Configuration with Authorize to Ship (RLM)

■ Line Flow - Generic

■ Line Flow - Generic with Authorize to Ship (RLM)

■ Line Flow - Generic with Header Level Invoice Interface

■ Line Flow - Generic, With Export Compliance

■ Line Flow - Generic, Bill Only

■ Line Flow - Generic, Bill Only with Inventory Interface

■ Line Flow - Generic, Ship Only
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■ Line Flow - Generic, with Repricing at Fulfillment

■ Line Flow - Return for Credit Only

■ Line Flow - Return for Credit Only with Approval

■ Line Flow - Return for Credit with Receipt

■ Line Flow - Return for Credit with Receipt and Approval

■ Line Flow - Standard Service

■ Order Flow - Generic

■ Order Flow - Generic with Header Level Invoice Interface

■ Order Flow - Return with Approval

■ Blanket Flow - Generic

Subprocesses
The following are the workflow subprocesses contained in oexwford.wft:

■ Authorized to Ship - Line

■ Approve Return - Order

■ Book - Order, Deferred

■ Book - Order, Manual

■ Buy ATO Item Flow

■ Calculate Lead Time - Line

■ Close - Line

■ Close - Order

■ Create Configuration - Line, Manual

■ Create Manufacturing Configuration Data - Line, Manual

■ Create Supply - Line

■ Create Supply Order - Line, Manual

■ Create Work Order - Line

■ Enter - Line

■ Export Compliance Screening - Line
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■ Header Level Invoice Interface - Line, Deferred

■ Header Level Invoice Interface - Order

■ Inventory Interface Non-Ship - Line

■ Inventory Interface Non-Ship - Line, Deferred

■ Invoice Interface - Line

■ Invoice Interface - Line, Deferred

■ Purchase Release - Line, Deferred

■ Purchase Release - Line, Manual

■ Reprice - Line

■ Return Receiving - Line

■ Schedule - Line

■ Schedule - Line, Deferred

■ Ship - Line, Manual

■ Blanket Agreement/Sales Order Generation

■ Enter—Blanket

■ Submit Draft - Negotiation

■ Offer Expired

■ Negotiation Complete

■ Internal Approved

■ Customer Accepted

■ Close - Blanket

■ Execute Blanket

■ Terminate—Blanket

Seeded Data File ctochord.wft

Item Types
The seeded data file ctochord.wft contains the following item types:
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■ CTO Change Order

■ Standard

To learn more about the Standard item type, refer to the Oracle Workflow User’s 
Guide.

Processes
The seeded data file ctochord.wft contains the following process:

■ Notification for Change Order

Item Types
The following section discusses the different item types used in Oracle Order 
Management seeded workflows. Oracle Order Management contains the following 
item types:

■ OM Change Order

■ OM Order Header

■ OM Order Line

■ OM Standard

■ OM Negotiation Header

■ OM Blanket Header

■ Standard

To learn more about the Standard item type, refer to the Oracle Workflow User’s 
Guide.

The following item type is seeded with Oracle Configure to Order and is used in 
conjunction with Oracle Order Management:

■ CTO Change Order

OM Change Order
This item type is used to manage change orders. Change order notification flows are 
created using this item type.

Currently there is one process associated with OM Change Order:

■ Change Order Process
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OM Change Order sets up a framework for sending FYI notifications to the 
resolving responsibilities.

The OM Change Order item type has several attributes associated with it. These 
attributes reference information in the Oracle Order Management application tables. 
The attributes are used and maintained by function activities and notification 
activities throughout the process. The following table lists the OM Change Order 
item type attributes.

OM Order Header
Oracle Order Management includes the concept of an order header. A header can 
contain one or many lines. The OM Order Header item type identifies all Oracle 
Order Management order header process available. Currently there are three 
processes associated with OM Order Header:

■ Order Flow - Generic

■ Order Flow - Generic with Header Level Invoice Interface

■ Order Flow - Return with Approval

The following five subprocesses are associated with OM Order Header:

■ Approve Return - Order

■ Book - Order, Deferred

■ Book - Order, Manual

Table 1–1 OM Change Order Item Type Attributes

Display Name Description Type
Length/Format/Lookup/ 
Type/Frame Target

Resolving Role The recipient of the 
notification or the 
resolver for the failed 
constraints

Text 150

User Text Placeholder for the text 
entered in the 
Notification form

Text 2000

Order Number Placeholder for Order 
Number

Number None

Order Management 
Workflow Administrator

Order Management 
Workflow Administrator

Role None
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■ Close - Order

■ Header Level Invoice Interface - Order

The OM Order Header item type has several attributes associated with it. These 
attributes reference information in the Oracle Order Management application tables. 
The attributes are used and maintained by function activities and notification 
activities throughout the process. The following table lists the OM Order Header 
item type attributes.

OM Order Line
The following section discusses processes associated with the OM Order Line item 
type. This item type identifies all Oracle Order Management order line processes 
available. The processes associated with OM Order Line include the following:

■ Line Flow - ATO Item

■ Line Flow - ATO Model

■ Line Flow - Configuration

■ Line Flow - Configuration with Authorize to Ship (RLM)

■ Line Flow - Generic

■ Line Flow - Generic with Authorize to Ship (RLM)

Table 1–2 OM Order Header Item Type Attributes

Display Name Description Type
Length/Format/Lookup 
Type/Frame Target

User ID User identifier used to set the 
context

Number None

Application ID Application identifier for setting 
the workflow context

Number None

Responsibility ID Responsibility identifier Number None

Order Management 
Workflow Administrator

Order Management Workflow 
Administrator

Role None

Org ID Organization ID Number None

Order Category Order Category Text 30

Header Short Descriptor Header Short Descriptor Document Full window

Notification Approver Notification Approver Role None
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■ Line Flow - Generic with Header Level Invoice Interface

■ Line Flow - Generic, With Export Compliance

■ Line Flow - Generic, Bill Only

■ Line Flow - Generic, Bill Only with Inventory Interface

■ Line Flow - Generic, Ship Only

■ Line Flow - Generic, with Repricing at Fulfillment

■ Line Flow - Return for Credit Only

■ Line Flow - Return for Credit Only with Approval

■ Line Flow - Return for Credit with Receipt

■ Line Flow - Return for Credit with Receipt and Approval

■ Line Flow - Standard Service

The subprocesses associated with OM Order Line include the following:

■ Authorized to Ship - Line

■ Buy ATO Item Flow

■ Calculate Lead Time - Line

■ Close - Line

■ Create Configuration - Line, Manual

■ Create Manufacturing Configuration Data - Line, Manual

■ Create Supply Order - Line, Manual

■ Create Work Order - Line

■ Enter - Line

■ Export Compliance Screening - Line

■ Header Level Invoice Interface - Line, Deferred

■ Inventory Interface Non-Ship - Line

■ Inventory Interface Non-Ship - Line, Deferred

■ Invoice Interface - Line

■ Invoice Interface - Line, Deferred

■ Purchase Release - Line, Deferred
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■ Purchase Release - Line, Manual

■ Reprice - Line

■ Return Receiving - Line

■ Schedule - Line

■ Schedule - Line, Deferred

■ Ship - Line, Manual

■ Wait to Firm - Line

The OM Order Line item type has several attributes associated with it. These 
attributes reference information in the Oracle Order Management application tables. 
The attributes are used and maintained by function activities and notification 
activities throughout the process. The following table lists the OM Order Line item 
type attributes.

Table 1–3 OM Order Line Item Type Attributes

Display Name Description Type
Length/Format/Lookup/Type/
Frame Target

User ID User identifier for the 
workflow initiator

Number None

Application ID Application identifier for 
the workflow initiator

Number None

Responsibility ID Responsibility identifier Number None

Order Management 
Workflow Administrator

Order Management 
Workflow Administrator

Role None

Org ID Organization ID Number None

Lead Time Rollup 
Organization

manufacturing 
organization of Config 
item

Number None

Lead Time Rollup Config 
Item

Configuration item for 
which to calculate the lead 
time

Number None

Lead Time Date Lead time date Text None

Lead Time Category 
Structure

Lead time category 
structure

Number None

Line Category Line category Text 30
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OM Standard
OM Standard is a repository for common functions and lookups. The application 
does not use this item type to create any flows.

There are several lookup types associated with OM Standard. A lookup type is a 
static list of values. These lists can be referenced by activities and by item type, 
message or activity attributes. The following table lists the seeded lookup types 
associated with OM Standard and their lookup codes:

Lead Time Attribute Req 
ID

Lead time attribute req ID Attribute None

Lead Time Request ID Lead time request ID Number None

AFAS Line ID AFAS Line ID Number None

Line Short Descriptor Line short descriptor Document Full Window

Notification Approver Notification Approver Role None

Table 1–4 OM Seeded Lookup Types

Lookup Type Lookup Code

Approval Timeout Actions Continue, Rejected

Check Reservation Status Not Reserved, Reserved

Check Supply Type 
Results

Buy, Drop Ship, Flow Schedule, Incomplete, Work Order

Concurrent Program Retry Abort, Retry

Concurrent Program 
Status

Cancelled, Error, Normal, Terminated, Warning

Config Data results Config Data Created

Config Incomplete Complete, Incomplete, On Hold

Config Item Results Complete, Delink

Config Line Result Config Data Created, Config Data Not Created, Reserved

Config Process Results Complete, Incomplete

Table 1–3 OM Order Line Item Type Attributes

Display Name Description Type
Length/Format/Lookup/Type/
Frame Target
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Enrollment Status Attended, Placed, Requested, Waitlisted

Enrollment Status for 
Advance

Placed, Waitlisted

Enrollment Status for 
Arrear

Attended, Placed, Requested, Waitlisted

Invoice Results Complete, Incomplete, Not Eligible, On Hold, Partial

Invoicing Rule Advanced, Arrear

Lead Time Result Complete, No Routing

Line Category Order, Return

Manufacturing Release 
Status

Eligible, Work Order Completed

Nonstock Flag Nonstock, Stock

Notification Approver 
Source

Created By, Order Created By, Profile Approver

Notification Required Not Required, Required

OM Acceptance Results Accept, Reject

OM Blanket Calculate 
Date Results

Awaiting Start Date, Expire Today, Expired, No End Date, No 
Reminder, Start Date Reached

OM Blanket Close Results Complete, Extend

OM Blanket Date Change 
Results

Expired, Set New Date, Start Date Not Reached

OM Blanket Execution 
Process Results

Expired, Terminate

OM Blanket Execution 
Results

Date Changed, Terminate

OM Blanket Start Date 
Reached Results

Expired, Yes, No, No Pre-Expiration Reminder

OM Check for Eligibility Eligible, Not Eligible

OM Check Expiration 
Results

Complete, Expired Today, Expired, No Reminder

OM Date Range Results Date Changes

Table 1–4 OM Seeded Lookup Types

Lookup Type Lookup Code
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For more information about lookup types, refer to the Oracle Workflow User’s Guide.

OM Export Compliance 
Results

Complete, Hold Applied, Incomplete, Override

OM Negotiation Standard 
Results

Complete, Incomplete, Lost

OM Subprocess Results Complete, Incomplete, Not Eligible

OM Subprocess Results, 
Handles Holds

Complete, Incomplete, Not Eligible, On Hold

OM Subprocess Success 
Results

Complete, Not Eligible

OM Subprocess with 
Partial Processing

Complete, Incomplete, Not Eligible, Partial Complete, Partial 
Incomplete

OM Subprocess with 
Partial Processing, 
Handles Holds

Complete, Incomplete, Not Eligible, On Hold Partial Complete, 
Partial Incomplete

Passes/Fails Fails, Passes

Repricing Date Actual Shipment Date, Fulfillment Date, Promise Date, Request 
Date, Schedule Ship Date, System Date

Repricing Event Line, Price, Reprice Line

Reserved Status Process AutoCreate PO, Reserved

RMA Wait result Complete, Correct Receiving

Shipping Results Non Shippable, Over Shipped Beyond Tolerance, Ship 
Confirm, Unreserve

Source Result Non Shippable, Shippable

Source Type ATO Item, Build, Dropship, Stock

Supply Source Type External, Internal

Unit of Measure Enrollment, Event

Upgrade Purchase Release 
Status

Confirmed, Eligible, Interfaced

Table 1–4 OM Seeded Lookup Types

Lookup Type Lookup Code
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CTO Change Order
The CTO Change Order item type identifies all CTO Change Order workflow 
processes available. Currently there is one workflow processes associated with CTO 
Change Order:

■ Notification for Change Order

The CTO Change Order item type also has several attributes associated with it. 
These attributes reference information in the application tables. The attributes are 
used and maintained by function activities as well as notification activities 
throughout the process. The following table lists the CTO Change Order item type 
attributes.

Table 1–5 CTO Change Order Attributes

Display Name Description Type
Length/Format/Lookup 
Type/Frame Target

Sales Order Number Sales order number Number None

Customer Name Customer name Text None

Line Number Line number of the model Text None

Item Name Item name Text 150

Request Date Request date Text 40

Scheduled Ship Date Scheduled ship date Text 40

Scheduled Arrival Date Scheduled arrival date Text 40

Cancelled Flag Order line is cancelled Text None

Special Text Special text Text 400

Change Order 
Administrator

Change order 
administrator

Role 30

Configuration Changed 
Flag

Configuration is changed Text 5

Quantity Change Quantity change Text None

Notification User Notification user Text 50

Delink Action Flag Delink action flag Text 5

Action Text Action text Text 20
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OM Negotiation Header 
The OM Negotiation Header item type identifies the Oracle Order Management 
order header process available for negotiation. The processes associated with OM 
Negotiation Header include the following:

■ Negotiation Flow - Generic with Approval

■ Internal Approval - Negotiation

■ Customer Acceptance - Negotiation Process

■ Offer Expiration - Negotiation Process

■ Submit Draft - Negotiation

■ Complete - Negotiation

■ Negotiation Flow - Generic

■ Blanket Agreement/Sales Order Generation

Item Attributes
The OM Negotiation Header item type has several attributes associated with it. 
These attributes reference information in the Oracle Order Management application 
tables. The attributes are used and maintained by function activities and notification 
activities throughout the process.

The following table lists the OM Negotiation Header item type attributes.

Table 1–6 OM Negotiation Header Attributes

Display Name Description Type
Length/Format/Lookup 
Type/Frame Target

User ID User ID Number None

Application ID Application ID Number None

Responsibility ID Responsibility ID Number None

Org ID Organization ID Number None
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OM Blanket Header 
The OM Blanket Header item type identifies the Oracle Order Management 
order header process available.The processes associated with OM Blanket 
Header include the following:

■ Blanket Flow - Generic

■ Execute - Blanket

■ Terminate—Blanket

■ Close—Blanket

■ Blanket Agreement/Sales Order Generation

■ Enter—Blanket

Item attributes
The OM Blanket Header item type has several attributes associated with it. 
These attributes reference information in the Oracle Order Management 
application tables.

The attributes are used and maintained by function activities and notification 
activities throughout the process.

The following table lists the OM Blanket Header item type attributes.

Sales Document Type Sales Document Type Text None

Negotiation Short 
Descriptor

Negotiation Short 
Descriptor

Document plsql:OE_NEGOTIATE_
WFSet_Negotiate_Hdr_
Descriptor/&#NID 
(Default)

Pre expire Time Percentage Pre-Expiration Time 
Percentage

Number 10

Table 1–6 OM Negotiation Header Attributes

Display Name Description Type
Length/Format/Lookup 
Type/Frame Target
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Table 1–7 OM Blanket Header Attributes

Display Name Description Type
Length/Format/Lookup 
Type/Frame Target

User ID User ID Number None

Application ID Application ID Number None

Responsibility ID Responsibility ID Number None

Org ID Organization ID Number None

Blanket Short Descriptor Blanket Short Descriptor Document plsql:OM_Blanket_
WFSet_Blanket_
Descriptor/&#NID 
(Default)

Pre expire Time Percentage Pre-Expiration Time 
Percentage

Number 10
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Topics covered in this chapter include the following:

■ Selecting Workflows on page 2-2

■ Assigning Workflows to Transaction Types on page 2-7

■ Workflow Background Engine Processing on page 2-10

■ Scheduling Workflows on page 2-11

■ Repricing Order LInes on page 2-13
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Selecting Workflows
Oracle Order Management comes seeded with several workflow processes. This 
section provides an overview of the header and line level processes that come 
seeded with Oracle Order Management. It also provides recommendations for 
which workflows processes can best meet your business needs.

Assigning workflow processes to header and line level transaction types enables 
you to initiate a process on an order and on an order line. Header level workflow 
processes must be assigned to transaction types in Oracle Order Management. After 
you define a line transaction type, line level processes must be assigned.

You cannot select any order workflow to be used with a line workflow. Some 
workflow steps between an order and line are interdependent based on how 
continue-flow and wait-for-flow activities are paired. Therefore, the same line 
transaction type must follow a different line flow when used with a different order 
transaction type. For example, Order Flow - Generic with Header Level Invoice 
Interface waits for an activity in the line flow to complete. If you do not use order 
and line flows designed to work together your orders or order lines could complete 
too early or never complete.

The inventory item that a line processes may have specific flow requirements. For 
example, a configuration must have a bill of materials and a work order created 
before it can be picked and shipped. The standard item can be picked from stock 
and shipped. Therefore, the workflow for a configuration item is different than for a 
standard item. Both types of order lines can be used for the same line type. The 
Workflow Assignments window displays the following item types to which a 
workflow can be assigned for a given order or order line type:

■ ATO Models, Classes, Options, Items

■ Configured Item

■ Kits

■ Included Items

■ PTO Models, Classes, Options

■ Standard Items

■ Service Items

If the item type code is left blank, the specified workflow assignment applies to all 
item types for which there is no specific assignment. Specify an assignment for the 
configured item type if you plan to use the line type for ATO configurations.
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Header Level Processes
The following list provides an overview of the header processes seeded in Oracle 
Order Management:

■ Order Flow - Generic: This is the most commonly used header flow. This 
process includes activities that book and close the order header. Always use this 
process unless you require the functionality specific to Order Flow - Generic 
with Header Level Invoice Interface or Order Flow - Return with Approval. 
Order Flow - Generic can be used with any line flow for any item type, with 
outbound lines and with return lines.

■ Order Flow - Generic with Header Level Invoice Interface: Use this header flow 
if your business requires that all lines on the order invoice together at the 
header level.

■ Order Flow - Return with Approval: Use this header flow when all lines on the 
order are returns and header level approval is required.

■ Order Flow - Return with Submission and Approval: This flow is seeded for 
Oracle iStore RMA integration. It is not intended to be used as a standard OM 
flow.

Line Level Processes
With the exception of returns, all of the line level processes seeded in Oracle Order 
Management are used for outbound processing.

The following sections provide overviews of the line level processes seeded in 
Oracle Order Management.

Generic Processes
The following line level workflow processes execute typical activities for entering 
and scheduling order lines:

Note: A Workflow assignment is required for a given line type to 
support creation of lines using that line type.

Note: This process must be used in conjunction with Line Flow - 
Generic with Header Level Invoice Interface.
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■ Line Flow - Generic: Use this process for all items except for service items, 
including assemble-to-order (ATO) items, ATO models, kits, and pick-to-order 
(PTO) models.

This flow will not work for configured items generated from assemble-to-order 
models.

When Line Flow - Generic is selected, users must not remember to select different 
processes for assemble-to-order items, assemble-to-order models, or a standard 
items. Outbound lines for all item types (other than Service) can be handled by Line 
Flow - Generic. By selecting Line Flow - Generic, the necessity of selecting a specific 
process for a particular item type is eliminated (this could be useful for customer 
service representatives).

From a setup perspective, Line Flow - Generic is effective because it manages 
several item types. If, however, you are a high volume ATO user, specific Assemble 
to Order (ATO) Processes can improve performance.

■ Line Flow - Generic with Header Level Invoice Interface: Use this process when 
all order lines must invoice simultaneously. Invoice is controlled by the 
AutoInvoice concurrent program. Set up grouping rules in Oracle Receivables if 
only one invoice for the order is necessary.

■ Line Flow - Generic, With Export Compliance: Select this process when 
products exported to a denied party must be checked. This process is 
commonly used in the defense industry, and could be used for screening after 
scheduling but before manufacturing.   If the party (such as the ship to) is 
authorized, the line progresses through the create supply, ship, fulfill, invoice 
interface, and close processes.

■ Line Flow - Generic, Bill Only: Use this process when scheduling and shipping 
are not necessary for an ordered item. This process fulfills the order line, then 
proceeds with invoice interface. For example, this process might be used if an 
invoice was incorrect and an adjustment must be made visible in Oracle Order 
Management.

■ Line Flow - Generic, Bill Only with Inventory Interface: Use this flow when 
products are not shipped but inventory decrement is required. For example, 
some distributors have customers who pick up products in person. The 

Note: This process must be used in conjuction with Order Flow - 
Generic with Header Level Invoice Interface.
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inventory transaction must be accounted for, so the process line moves to 
invoice interface. The product is picked up, so shipping is not necessary.

■ Line Flow - Generic, Ship Only: Use this process if you must ship a product but 
an invoice is not necessary. This flow decrements inventory. For example, this 
process could be used when shipping free samples for a new product, or for 
shipping a non-billable toolset to repair a previously invoiced item.

Assemble to Order (ATO) Processes
Assign the seeded line workflow for the Configured Item line type if your business 
processes ATO configurations. Configured Item refers to the actual item created by 
Oracle Configure to Order for an ATO model order line as part of the Autocreate 
configuration process.

If your business does not process ATO models or ATO items, but does process 
standard items and PTO items, you can delete Item Attributes that relate only to 
ATO models or ATO items to improve performance. The following are item 
attributes associated only with ATO models and ATO items:

■ Lead Time Rollup Organization

■ Lead Time Rollup Config Item

■ Lead Time Date

■ Lead Time Category Structure

■ Lead Time Attribute Req ID

■ Lead Time Request ID

■ AFAS Line ID

ATO processes seeded in Oracle Order Management include the following:

■ Line Flow - ATO Item: Use this process instead Line Flow - Generic for ordering 
only ATO items. The process runs the typical entering and scheduling 
processes. This process also creates supply for an ATO Item. The process then 
continues with shipping, deferred fulfillment, fulfillment, invoice interface, and 
close.

■ Line Flow - ATO Model: Use this process instead of Line Flow - Generic for 
ordering only ATO models. The process runs entering, scheduling, creating 
configuration, shipping, fulfillment, invoice interface, and close.

■ Line Flow - Configuration: This process is for configured items. Assign this 
process to the order line type used for configurations as part of your 
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implementation process. The configured item is created from a model as a part 
of the Autocreate configuration process for ATO items. The flow runs 
calculation of manufacturing data, and creation of supply for configuration. It 
then continues with shipping, fulfillment, and close.

Oracle Release Management Processes
The following line level workflow process are commonly used with Oracle Release 
Management:

■ Line Flow - Generic with Authorize to Ship (RLM): Use this flow if you use 
Oracle Release Management and want to forecast in Oracle Order Management. 
Demand interfaced from Oracle Release Management as Not Authorized To 
Ship can be changed to Authorized to Ship using this workflow process.

■ Line Flow - Configuration with Authorize to Ship (RLM): Use this flow if you 
use Oracle Release Management and want to forecast in Oracle Order 
Management. Demand interfaced from Oracle Release Management as Not 
Authorized To Ship can be changed to Authorized to Ship using this workflow 
process. The Line Flow - Configuration with Authorize to Ship (RLM) workflow 
process is associated with Oracle Release Management. Line Flow - 
Configuration with Authorize to Ship (RLM) ensures that a line is eligible for 
shipping. This workflow is specific to Oracle Release Management users and 
must be assigned during the implementation process.

Inbound Processes
The following line level workflow processes are used for returns or inbound lines:

■ Line Flow - Return for Credit Only: This process is used only for incoming lines. 
The process runs an activity that issues credit without waiting for a receipt of 
goods or an approval. This flow could be used, for example, if you give credit 
for a product shipped on a CD, but you do not want the CD to be returned.

■ Line Flow - Return for Credit Only with Approval: This processes is used only 
for incoming lines that requires approval. This process could be used, for 
example, when a return must be approved by a manager or a customer service 
representative before credit is issued.

■ Line Flow - Return for Credit with Receipt: This process is used only for 
incoming order lines that require receipt of goods before credit can be issued. 
Once the returned items are received by Oracle Purchasing, the process 
continues through invoicing and credit is issued. This process is useful when 
the returned items are expensive; credit should not be issued until the items are 
received.
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■ Line Flow - Return for Credit with Receipt and Approval: This process is the 
most restrictive for incoming lines. The process requires both receipt of goods 
and an approval. This process is commonly used when items such as modems 
are returned. The modem is received then inspected to ensure that no 
mistreatment or neglect of the item occurred. Once inspected and approved, 
credit is issued.

Service Item Processes
The following process is used for service items:

■ Line Flow - Standard Service: Use this process for service items such as support. 
Once the line is fulfilled, invoice interfacing occurs.

Negotiation and Blanket Sales Agreement Processes
You can choose one of the following seeded header-level negotiation flows, which 
can be converted to a Sales Order in case of a Quote, or Active Blankets if it is a 
Blankets Sales agreement. The Sales Order negotiation can be converted to Sales 
Order in either the Entered or Booked status. The following are flows supporting 
the Negotiation phase for Sales orders and Blanket Sales agreements:

■ Negotiation Flow - Generic: Flow without approval. Prepare quote, get 
customer final acceptance, and converts the negotiation to an order.

■ Negotiation Flow - Generic with Approval: Flow with Approval. Prepare 
quote, get management approval, get customer final acceptance, and 
converts the negotiation to an order.

Assigning Workflows to Transaction Types
Oracle Order Management transaction types determine the workflow processes 
executed at header and line levels. Oracle Order Management enables you to define 
both header and line level transaction types.

Oracle Order Management does not provide seeded transaction types. You must 
create your own transaction types using the transaction types window in Oracle 
Order Management.

See
Oracle Order Management Implementation Guide. 
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Figure 2–1 Transaction Types Window

The Transaction Type determines the header level process used at the header level 
on an order. The combination of transaction type, line type, and item type 
determines the line workflow.

You can perform all standard processing including orders, returns, drop-ship 
orders, orders for configured items, and orders for assemble-to-order items using 
seeded workflows. You can also create your own workflows if you need additional 
processes, activities, or notifications.

Warning: Oracle Corporation provides support only for its 
seeded activities and processes. Oracle Corporation does not 
provide support for your custom activities and processes.
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For more information about extending existing workflow processes, refer to 
Chapter 3, Extending Oracle Order Management Seeded Workflows.

For information about creating your own workflow processes, refer to the Oracle 
Workflow User’s Guide.

Line Workflow Assignments
The Line Workflow Assignments window is available for Oracle Order 
Management order transaction types. Use this window to assign line flows to the 
line types used with an order type. The following image depicts the Line Workflow 
Assignments window.

Figure 2–2 Line Workflow Assignments

A line flow can be assigned to an order type, line type, and item type combination. 
Oracle Order Management enables you to define one assignment for a given 
combination. If the item type is left blank, then that assignment applies to all item 
types that do not have specific assignments. If you use a line type for ATO models, 
Oracle Order Management requires you to specify assignments for configured item 
types.
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Workflow Background Engine Processing
The Workflow Background Engine processes deferred activities. It also processes 
wait activities and timed-out activities when the wait/time-out period is reached. 
Schedule the Workflow Background Process concurrent program to resubmit 
periodically. When scheduling with the concurrent program, select Oracle Order 
Management item types (OM Order Header and OM Order Line) as the parameter. 
The system then selects only activities specific to Oracle Order Management.

To set schedules for the Workflow Background Engine, complete the following 
steps:

1. Define the Process Deferred parameter as Yes. Set all other parameters to No. 
Schedule this request to run most frequently (for example, every 10 -15 
minutes).

2. Define Process Time-out as Yes, and all other parameters as No. This can run 
less frequently (for example, once every 30 - 60 minutes).

3. Define Process Stuck set to Yes and all other parameters as No. This can run less 
often (for example, once per day).

The most common use of the background engine is to process deferred activities. To 
improve performance, process deferred activities frequently, and process time-out 
and stuck less frequently. For example, you probably have more deferred lines than 
timed out lines. In this case, you could progress deferred lines three times a day, 
and progress timed out lines only once a day.

Workflow Background Engine Performance Guidelines
The Workflow Background Engine also impacts overall system performance. By 
analyzing the frequency and type of processing you require, you can ensure that the 
WF background engine runs efficiently. To run the WF Background Engine, you 
must set the following parameters:

■ Deferred? If set to yes, the WF background engine will pick up all deferred 
lines.

Note: It is recommended to run the Workflow Background Engine 
at least three times a day. More frequent runs balance the load 
processing and allow lines to progress more frequently.
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■ Timeout? If set to yes, the WF background engine will pick up all timed-out 
lines.

Avoid running the Workflow Background Engine multiple times with both the 
Deferred? and Timeout? parameters set to yes. Instead, run it as required to check 
for one of the parameters. For example, you might want progress deferred lines four 
times a day, and progress timed out lines one time a day. However, the frequency 
depends on your business needs. You may need to run the WF Background Engine 
several times a day, but the process will be more efficient if you specify either 
Deferred or Timed Out lines, but not both.

Scheduling Workflows
A line that is not scheduled from the Sales Orders window can be scheduled using a 
workflow activity. Each order process activity can be represented as a workflow 
activity. The workflow activities are completed automatically based on your 
workflow process definition.

Schedule Workflow Activity
The standard schedule workflow activity performs the following functions:

■ Obtain a ship-from location for an order line.

■ Obtain the schedule date for an order line.

■ Obtain other scheduling attributes, including delivery lead time and shipping 
methods, for an order line.

■ Reserve order lines (when within the reservation time fence period).

For more information about the scheduling activities available in Oracle Order 
Management, refer to Chapter 6, Seeded Function Activity Definitions.

For more information about the subprocesses that use scheduling activities, refer to 
Chapter 5, Seeded Subprocess Definitions.

Note: The activity of the Workflow Background Engine affects all 
order processing: standard and HVOP order import, online 
processing, and Process Order API.

Note: If scheduling encounters an unexpected error (such as 
system or network error), add, update and delete will also fail.
Processing Orders Using Oracle Workflow 2-11



Scheduling Workflows
Hi Volume Order Processing (HVOP)
Order Management now provides High Volume Order processing (HVOP) as an 
alternative way to import newly created orders.   This method of order import 
achieves many performance gains.

If you are using 11i.9, the streamlined version of generic line flow is not seeded, but 
you can create your own streamlined version, eliminating subprocesses. If you 
remove the subprocesses, the system does not need to maintain status information 
for the subprocesses, and also for the Start / End activities inside the subprocesses. 
It also reduces DML contention against the wf_item_activity_statuses. You may 
even be able to remove additional activities based on your business requirements. 
For instance, if you source from stock and do not manufacture, you can delete the 
activity Branch on Source Type. This allows you to maintain the line flow for 
sourcing from stock. If you modify your flows, it’s critical that the modifications be 
done correctly.

With 11i10, Order Management seeds a generic line flow for performance called 
Line Flow—Generic, Performance. This seeded flow improves performance by 
reducing the number of subprocesses and status checks. It can be used for all items 
types. Because this flow is not modular, it should not be modified.

The streamlined seeded workflow Line Flow—Generic, Performance provides 
the same functionality as the Generic line flow. The benefit of the Generic line 
flow is that it simplifies extending or customizing workflow. This is because the 
traditional Line Flow - Generic workflow has subprocesses. If you copy the flow 
and insert a new activity at the top level—that is, into the main flow, the rest of 
the flow will contain references to the subprocesses defined by Order 
Management. When Order Management updates these subprocesses with a 
patch, the modified workflow automatically points to the updated subprocess 
since the modified flow only contains a reference to it. The Line Flow—Generic, 
Performance workflow has no subprocesses. There are no references to 
subprocesses, only copies of the lineflow. Therefore, when a patch is applied, 
you need to recopy and reapply any modifications you have made to the seeded 
flow.

Streamlining workflow improves the performance of both standard and HVOP 
order import, as well as online performance. It improves the performance of the 
Process Order API, and concurrent programs that process workflow activities.
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Oracle Order Management enables you to reprice an order line at any point in the 
order life cycle using Oracle Workflow. Oracle Order Management and Oracle 
Workflow also enable you to determine the following:

■ When repricing should occur

■ Which pricing event phases are executed when repricing

■ Whether to ignore the Calculate Price flag value for an order line

For more information about the pricing functionality in Oracle Order Management, 
refer to the Oracle Order Management User’s Guide.

Pricing Date
Set the Reprice activity Repricing Date attribute when you insert the activity into a 
workflow. You can set the pricing date to one of the following dates for your order 
line:

■ Actual shipment date

■ Schedule ship date

■ Fulfillment date

■ Promise date

■ Request date

■ System date

You can select the original pricing date on the order line if you set the Repricing 
Date attribute to Null.

Pricing Phases
Set the Repricing Event attribute to Pricing Event to control line-level pricing phases 
to be executed at repricing. The Repricing Event attribute is an Oracle Order 
Management lookup type to list all pricing events for which repricing can be 
executed. Current lookup codes for Repricing Event include the following:

Note: You must use the Reprice activity to access repricing 
functionality.
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■ Line

■ Price

■ Reprice Line

You can recalculate base price while keeping the discounts given during the order 
entry time by setting the Repricing Event attribute to Price.

If you add a new pricing event for use with Reprice, verify that you also define this 
event as a lookup type. If this is not defined as a lookup type, you cannot select the 
new pricing event when setting the Repricing Event attribute.

Calculate Price Flag
You can control whether the repricing line workflow activity honors the value of the 
calculate price flag by setting the Reprice attribute Honor Price Flag to one of the 
following:

■ Yes: Honors the value of the calculate price flag on the order.

■ No: Ignores the value of the calculate price flag.

Repricing and freight charge recalculation occurs regardless of the value of the 
calculate price flag.

Repricing at the Line Ship/Schedule Date
Place the Reprice activity after all shipping activities in a workflow to reprice an 
order line at shipment for workflows that processes only items and lines not in 
fulfillment sets.

Note: If you set the Repricing Event attribute to Null, the 
repricing event is Reprice Line. Reprice Line is a seeded pricing 
event. You can only associate line-level pricing phases with this 
event. For more information about pricing events, refer to the 
Oracle Advanced Pricing User’s Guide.

Note: If the Reprice activity fails it does not impact your shipping 
activities. Use either the shipment date (either actual shipment date 
or scheduled ship date) for the Repricing Date attribute.
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Repricing at shipment does not validate agreements and their effective dates. 
Repricing at shipment validates the price list associated with the agreement 
specified on the order.

Repricing at the Line Fulfillment Date
To reprice an order line at its fulfillment date, place the Reprice activity in your flow 
after the fulfillment activity then update your pricing events.

Complete the following steps to reprice at the line fulfillment date:

1. Navigate to the Event Phases window and add each desired phase.

For more information on defining Pricing Events, refer to the Oracle Advanced 
Pricing User’s Guide.

2. Place the Reprice activity after the fulfillment activity in your workflow.

3. Set the following workflow attributes:

■ Repricing Date: Fulfillment date

■ Repricing Event: Reprice Line or another defined event

Note: Placing the Reprice Line workflow activity after the 
fulfillment activity enables your workflow to process shippable 
items, non-shippable items, and non-shippable lines in a fulfillment 
set.
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Extending Oracle Order Management

Seeded Workflows

Topics covered in this chapter include the following:

■ Overview on page 3-2

■ Customizations on page 3-2

■ Extending Workflow on page 3-3
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Overview
This chapter provides guidelines to follow for extending the Oracle Order 
Management seeded workflow processes to meet your business needs. Oracle 
Corporation supports the extension of workflows. Extensions include using existing 
seeded subprocesses to build new workflow processes and modifying parameters of 
a subprocess without changing process logic (for example, changing the wait period 
of the Wait activity from month end to daily).

If the Oracle Order Management seeded workflows do not meet your business 
processing needs, you can create new flows by using any of the following methods:

■ Copy a seeded order or line flow, change its internal name, display name, and 
description in the Oracle Workflow Builder. Change the definition as desired. 
When you copy a flow, do not delete any of the seeded activities.

■ Use the seeded flows as examples to create new order or line flows using the 
seeded functional subprocesses and include your own custom activities in the 
Oracle Workflow Builder.

Customizations
A customization changes the logic of the core application. Oracle does not support 
customizations to seeded workflows. Examples of customizations include:

■ Adding a new custom header activity that checks whether the order exceeds a 
certain currency amount, and performing special logic based on the amount.

■ Using a third party invoicing module instead of Oracle Accounts Receivable for 
invoice interface; this creates a new activity to populate the custom tables.

■ Changing the basic logic of a seeded subprocess, such as Book - Order, Manual. 
Adding or deleting activities from a seeded subprocess alters seeded data. 
However, you can copy and rename Book - Order, Manual and then insert a 
notification function activity.

■ Modifying drop-ship logic.

Warning: Oracle provides support only for its seeded activities, 
processes, and the type of extensions described in this manual. 
Oracle does not provide support for your custom activities and 
processes.
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■ Modifying the integration of Oracle Order Management with another 
application such as Oracle Service.

Exceptions
The following exceptions are supported by Oracle:

■ You may change the item attribute OM WF Administrator to another 
responsibility (it defaults as SYSADMIN). The OM WF Administrator item 
attribute is available for both the seeded OM Order Header and OM Order Line 
item types.

■ You may tailor message bodies on seeded messages to meet your business 
needs.

■ You can set the default error process of RETRY_ONLY on any new functions, 
processes or flows that you define.

For more information about extending workflows or to learn how to create your 
own workflows, refer to the Oracle Workflow User’s Guide.

Extending Workflow
When extending existing workflows to meet your business needs, always copy the 
seeded process and rename both the internal and display names before modifying 

Warning: Customization refers to the modification of the logic 
of a process or subprocess, and is not supported by Oracle.

Note: Any patch containing the workflow definition file will 
override the message. If this occurs, copy the main flow and the 
message, then use the message in your custom flow.

Note: The RETRY_ONLY error process supports retrying only of 
the activity in an error state. RETRY_ONLY does not support 
aborting the flow or skipping the activity in an error state. Do not 
specify any other error process. Do not leave the error process field 
empty.
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the workflow. This process ensures that you do not modify seeded data. It also 
prevents patches containing the.wft files (which contain all the seeded flows and 
related information) from overriding your modifications.

For example, you should not directly change the Book - Order, Manual subprocess 
by adding or deleting activities from it. Copy and rename what you want to change 
before making modifications. Do not modify predefined data; this includes all 
function activities, subprocesses, processes, and item attributes.

Always modify a copy of a subprocess instead of function activities. For example, 
use the seeded Book - Order, Manual subprocess rather than the seeded Book 
function activity. The subprocess is designed to handle exceptions, and it may 
perform other functions as well. For example, the Create Supply Order - Line, 
Manual subprocess not only creates supply, but also determines whether an item is 
sourced internally or externally.

Once you have modified an order or line flow, assign it to an order or line type. For 
more information about assigning workflows to transaction types, refer to 
Assigning Workflows to Transaction Types.

Dependencies
Oracle Order Management requires that some workflow events occur before others. 
This creates certain dependencies that should not be violated. For example, 
shipping is dependent on booking and therefore cannot occur after booking.

The following list describes dependencies in Oracle Order Management:

■ Order lines wait for booking before continuing their flow. Order lines should 
not invoice until after booking occurs.

■ Order level booking is required and should not be removed.

■ Lines should not interface to Oracle Invoicing until after shipping occurs (if a 
shipping activity exists in the process).

■ Close - Order and Close - Line are mandatory steps in header and line 
processes, respectively.

Warning: If you modify any of Oracle’s seeded workflow data, 
your changes are not supported. Any changes to the seeded 
workflow data are overwritten when a patch containing the .wft 
file is applied.
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■ All order header processes are created as parent flows. Processes for lines on 
orders are created as child (detail) flows.

■ Wait for Flow and Continue Flow workflow utilities support the order (parent) - 
line (line or detail) coordination. The Book - Continue Line (Complete) function 
activity is part of the Book - Order, Manual subprocess. The Wait for Booking 
function activity is part of the Enter - Line subprocess. The line flow waits for 
the header level Book - Order, Manual subprocess to complete before the lines 
continue.

There are several ways to extend workflow processes without violating the Oracle 
Order Management dependencies. The following are several examples of extending 
workflow:

■ You can construct a flow using only seeded sub-processes from Order 
Management. If the necessary dependency requirements are met, this is 
considered extending, and is not a customization.

■ You can change the WAIT period of a seeded WAIT function activity.   For 
instance, by default the Header Close Order sub-process will wait until the end 
of the month before closing the order. You could change it to wait for a different 
period of time.

■ You could add a standard WF notification to a flow. For example, you might 
want to send a simple FYI notification before invoicing a line, or send a Yes/No 
approval notification before invoicing.

■ You could add a Time Out transition such that if there is no response to a 
notification, the Line or Header might proceed after a defined period of time.

Guidelines
When extending workflow processes to meet your business needs, stay within the 
following guidelines:

■ All order header processes should include the Close - Order subprocess. All line 
level processes should include the Close - Line subprocess.

Note: Oracle Order Management supports only standard WF 
notifications: either an FYI notification or a notification requiring a 
response. Notifications that call stored PL/SQL procedures are not 
supported.
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■ The order header process should contain either Book - Order, Manual or Book - 
Order, Deferred, and the line level process should include Enter - Line.

■ Do not design a line level process that conducts invoice interface before it 
shipping.

■ Include the functional subprocess that represents the business process you are 
needing. If a line must conduct invoice interface, select a subprocess which 
performs that particular function. For example, you must include the invoice 
interface supprocess instead of just including the invoicing activity.

■ Some workflow function activities must be configured. This is done by setting 
the function activity attributes. For example, with a notification activity you 
must set up a performer (recipient). If you use Utility - Set Notification 
Approver to enable you to send notification to the user/responsibility specified 
in the Notification Approver profile option, you must also specify the 
user/responsibility in the profile option.

■ Always specify RETRY_ONLY as the default error process for any workflow 
activity you define.

Examples of Extending Workflow
This section discusses possible extensions to the seeded Oracle Order Management 
workflows. The extensions listed do not violate Oracle Order Management 
dependencies, change core logic, or violate the rules for modifying a subprocess.

Process Parameters
Complete the following steps to modify the Close - Order subprocess to close orders 
more frequently than month-end.

1. Copy and rename the internal and displays names for the Close - Order 
subprocess.

Note: It is recommended that you include the Fulfill activity 
before invoice interface.   Please refer to the Fulfill activity in 
Chapter 6 for further details. 

Note: Always remember to copy the seeded process or subprocess 
and rename both the internal and displays name before making any 
modifications.
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2. Modify the Wait function activity in the copied and renamed Close - Order 
subprocess. If you want the orders to close twice a day, open the property sheet 
of the Wait activity, select the Node Attributes tab and set the Wait Mode to 
Relative Time, and set the Relative Time attribute to a value of .5.

3. Drag and drop this subprocess into your new header level process. Remember 
to modify the internal and display names of this new process.

4. Attach your new process to a Transaction Type.

Approvals
You can extend processes and subprocesses by adding approvals. Refer to the Oracle 
Workflow User’s Guide for more information about approvals.

One way to extend a workflow process using an approval is to add an approval to 
the header before booking. To create a process with this approval, complete the 
following steps:

1. Copy and rename the internal and displays names for the header level booking 
subprocess (Book - Order, Manual or Book - Order, Deferred).

2. Create the approval message and notification. For more information about 
creating messages and notifications, refer to the Oracle Workflow User’s Guide.

3. Insert the approval notification function activity into the subprocess so that the 
approval occurs before booking.

4. Save your new subprocess and drag and drop it into a header level flow process 
(one that has been copied and renamed for your extensions).

5. Select the performer of the notification.

6. Set up a Transaction Type in Oracle Order Management that uses your new 
header process flow.

For more details on creating and extending workflows refer to the Oracle Workflow 
User’s Guide.

Another way to extend a workflow process using an approval is to require approval 
for all standard line processes before a Ship activity can occur. To create a process 
with this approval, complete the following steps:

1. Copy and rename the internal and displays names for the line level subprocess 
(such as Line Flow - Generic).

2. Create the approval message and notification. For more information about 
creating messages and notifications, refer to the Oracle Workflow User’s Guide.
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3. Set the performer of the notification.

4. Insert the approval notification function activity into the subprocess so that the 
approval occurs before booking.

5. Assign your new line process to a Transaction Type in Oracle Order 
Management.

For more details on creating and extending workflows refer to the Oracle Workflow 
User’s Guide.

Deferred Booking
Another extension available at the order header level is to create a process with 
deferred booking. To create a process with deferred booking, complete the 
following steps:

1. Copy and rename the internal and displays names for the order level process 
you want to extend (such as Order Flow - Generic).

2. Remove the Book - Order, Manual subprocess.

3. Insert the Book - Order, Deferred subprocess in place Book - Order, Manual.

4. Save your new process and assign it to a Transaction Type in Oracle Order 
Management.

Time-out Transition for Notifications
The time-out transition option is another way to extend workflow to meet business 
requirements. In the case of quotes, for example, a yes/no approval function 
activity is inserted before Book - Order, Manual or Book - Order, Deferred. If 
approved the order continues to the booking subprocess. The order closes if either 
of the following conditions occur:

■ The approval is rejected.

■ There is no response within 30 days.

To set up such a process with a time-out transition, complete the following steps:

1. Copy and rename the internal and displays names for the line level subprocess 
(such as Line Flow - Generic).

2. Create an approval message and notification. For more information about 
creating messages and notifications, refer to the Oracle Workflow User’s Guide.
3-8 Using Oracle Workflow in Oracle Order Management



Extending Workflow
3. On the Node tab of your notification define a time-out. If you use the Relative 
Time time-out of 30 days, orders processed using this Transaction Type close 
after 30 days if the notification is not approved.

4. Set the performer of the notification.

5. Insert the approval notification function activity into the subprocess so that the 
approval occurs before booking.

6. Assign your new line process to a Transaction Type in Oracle Order 
Management.
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Seeded Workflow Definitions

Topics covered in this chapter include the following:

■ CTO Change Order Process on page 4-2

■ OM Change Order Process on page 4-4

■ OM Order Header Processes on page 4-5

■ OM Order Line Processes on page 4-11

■ OM Negotiation Header Processes on page 4-56

■ OM Blanket Header Processes on page 4-60
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CTO Change Order Process

Notification for Change Order
The Change Order process is an Oracle Configure to Order workflow process that 
initiates when you change any of the following attributes on an order:

■ Scheduled ship date

■ Request date/scheduled arrival date

■ Order line quantity

■ Configuration

This process is also initiated if you cancel an order.

When you submit a change to a sales order, the Change Order Process sends a 
notification of the change to the order. For configured and ATO items, notification is 
sent to the planner of the top model/item in the shipping organization. For 
purchase to order ATO items, a notification is sent to the buyer on the requisition. 
Only one message is sent for all changes accepted in an order line. If the planner 
code value is null or not a valid workflow user then the notification is sent to the 
system administrator.

For single-level, single-organization configurations and ATO items a notification is 
sent only if a reservation or flow schedule exists for the configuration. If there are 
configuration changes, a notification is sent even if no reservation exists.

For multi level, or multi organization configurations and ATO items a notification of 
the changes is always sent, regardless if a reservation exists for the top level 
configuration or ATO Item.

These changes can cause data inconsistency between Oracle Order Management 
and Oracle Work in Process if action is not taken by the planner to update 
associated Oracle Work in Process jobs or flow schedules. A notification of the 
changes is sent to the buyer, if a reservation to a requisition or purchase order exists 
for the ATO item.

The Change Order Process is contained in the seeded data file CTO Change Order 
and is associated with the CTO Change Order item type.
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Summary of the Change Order Process
To view the properties of the Change Order Process process, select the process in the 
navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that Change Order 
Process has an error item type of WFERROR. This item type is associated with the 
RETRY_ONLY error process. The purpose of this error handling process is to alert 
an administrator when an error occurs in a process and prompt the administrator to 
retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Change Order Process, you see that 
the process consists of 3 unique activities, which comprise the 3 nodes that appear 
in the workflow diagram. The following diagram depicts the Change Order Process 
process. Each node of this process is numbered for referencing.

Figure 4–1 Change Order Process Workflow

The Change Order Process workflow begins at node 1 with the Start activity.

The workflow then proceeds to the Change Order Notification subprocess in node 
2. After the notification is sent, the process continues on to the End subprocess in 
node 3.

Change Order Process Activities
The following table provides descriptions of each function activity in Change Order 
Process.

For more information about individual function activities, refer to Chapter 6, 
Seeded Function Activity Definitions.
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OM Change Order Process

Change Order Process
When you change an order, you can select Actions, then Notify from the Sales Order 
form, which initiates the Change Order Process. This process sends notification that 
the order has been changed. This process can also be initiated from an error 
message by selecting the Notify option.

Change Order Process is contained in the Seeded Data File oexwford.wft and is 
associated with the OM Change Order item type.

Summary of the Change Order Process
To view the properties of the Change Order process, select the process in the 
navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that Change Order 
Process has an error item type of WFERROR. This item type is associated with the 
RETRY_ONLY error process. The purpose of this error handling process is to alert 
an administrator when an error occurs in a process and prompt the administrator to 
retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Change Order Process, you see that 
the process consists of 3 unique activities, which comprise the 3 nodes that appear 
in the workflow diagram. The following diagram depicts the Change Order Process 
process. Each node of this process is numbered for referencing.

Table 4–1 Change Order Process Activities

Activity Function Result Type Required

Start WF_STANDARD.NOOP None Yes

End WF_STANDARD.NOOP None Yes
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Figure 4–2 Change Order Workflow

The Change Order Process workflow begins at node 1 with the Start activity.

The workflow then proceeds to the Change Order Notification subprocess in node 
2. After the notification is sent, the process continues on to the End subprocess in 
node 3.

Change Order Process Activities
The following table provides descriptions of each activity in Change Order Process. 
For more information about individual function activities, see Seeded Function 
Activity Definitions.

OM Order Header Processes
The following section discusses the three workflows associated with the OM Order 
Header item type:

■ Order Flow - Generic

■ Order Flow - Generic with Header Level Invoice Interface

■ Order Flow - Return with Approval

Table 4–2 Change Order Process Activities

Activity Function Result Type Required

Start WF_STANDARD.NOOP None Yes

End WF_STANDARD.NOOP None Yes
Seeded Workflow Definitions 4-5



OM Order Header Processes
For more information regarding the OM Order Header item type, refer to 
Chapter 1, Introduction.

Order Flow - Generic
The Order Flow - Generic workflow process is the most often used workflow in 
Oracle Order Management. The Order Flow - Generic process contains subprocesses 
to verify that an order is booked and closed properly.

Order Flow - Generic is initiated if it is assigned to the transaction type for the 
order. Transaction types determine which processes are attached to an order. For 
more information on defining transaction types, refer to the Oracle Order 
Management Implementation Guide.

Order Flow - Generic is associated with the following OM Order Header 
subprocesses:

■ Book - Order, Manual

■ Close - Order

Order Flow - Generic is contained in the Seeded Data File oexwford.wft and is 
associated with the OM Order Header item type.

Summary of the Order Flow - Generic Process
To view the properties of the Order Flow - Generic process, select the process in the 
navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the Order Flow - 
Generic process has an error item type of WFERROR. This item type is associated 
with the RETRY_ONLY error process. The purpose of this error handling process is 
to alert an administrator when an error occurs in a process and prompt the 
administrator to retry the process in error. This error process is initiated only when 
an unexpected error with Oracle Workflow is encountered in the process.

When you display the Process window for the Order Flow - Generic, you see that 
the process consists of 2 unique activities and 2 subprocesses, which comprise the 4 
nodes that appear in the workflow diagram. The following diagram depicts the 
Order Flow - Generic process. Each node of this process is numbered for 
referencing.
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Figure 4–3 Order Flow - Generic Workflow

The Order Flow - Generic workflow begins at node 1 with the Enter activity. The 
workflow then proceeds to the Book - Order, Manual subprocess in node 2.

Once the order is booked, the process continues on to the Close - Order subprocess 
in node 3 and wait for all lines under this order to close. Once all lines are closed, 
the order will close. After the order is closed, the process ends.

Order Flow - Generic Activities
The following table provides descriptions of each activity in the Order Flow - 
Generic process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Order Flow - Generic with Header Level Invoice Interface
Order Flow - Generic with Header Level Invoice Interface can only be used along 
with Line Flow - Generic with Header Level Invoice Interface.

The Order Flow - Generic with Header Level Invoice Interface is a workflow 
process that is initiated when you enter a sales order in Oracle Order Management. 
When you submit a sales order that requires an invoice, the Order Flow - Generic 
with Header Level Invoice Interface first ensures that the order is booked before 
generating the invoice. When all lines in the order are complete, the process 

Table 4–3 Order Flow - Generic Activities

Activity Function Result Type Required

Enter WF_STANDARD.NOOP None Yes

End WF_STANDARD.NOOP None Yes
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interfaces with Oracle Receivables to generate an invoice for the order. Upon 
completion of the invoice interface, the process closes the order.

The Order Flow - Generic with Header Level Invoice Interface workflow process 
can only end once the order is successfully closed.

Order Flow - Generic with Header Level Invoice Interface is contained in the 
Seeded Data File oexwford.wft and is associated with the OM Order Header item 
type.

Summary of the Order Flow - Generic with Header Level Invoice Interface Process
To view the properties of the Order Flow - Generic with Header Level Invoice 
Interface process, select the process in the navigator tree and then select Properties 
from the Edit menu. This process is runnable, which indicates that it can be 
assigned to a transaction type.

The Details property page of the process activity indicates that the Order Flow - 
Generic with Header Level Invoice Interface process has an error item type of 
WFERROR. This item type is associated with the RETRY_ONLY error process. The 
purpose of this error handling process is to alert an administrator when an error 
occurs in a process and prompt the administrator to retry the process in error. This 
error process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

When you display the Process window for the Order Flow - Generic with Header 
Level Invoice Interface, you see that the process consists of 2 unique activities and 3 
subprocesses, which comprise the 5 nodes that appear in the workflow diagram. 
The following diagram depicts the Order Flow - Generic with Header Level Invoice 
Interface process. Each node of this subprocess is numbered for referencing.

Note: This flow interfaces to Receivables for invoice creation 
when all lines in the order has been fulfilled. 
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Figure 4–4 Order Flow - Generic with Header Level Invoice Workflow

The Order Flow - Generic workflow begins at node 1 with the Enter activity.

The workflow then proceeds to the Book - Order, Manual subprocess in node 2. 
Once the order is booked, the process continues on to the Header Level Invoice 
Interface - Order subprocess in node 3. This subprocess initiates the interface with 
Oracle Receivables to generate an invoice for the order. After an invoice is 
generated, the process moves to the Close - Order process in node 4. The process 
ends in node 5 after the order is successfully closed.

Order Flow - Generic with Header Level Invoice Interface Activities
The following table provides descriptions of each activity in the Order Flow - 
Generic with Header Level Invoice Interface process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Order Flow - Return with Approval
Order Flow - Return with Approval should be used with either Line Flow - Return 
for Credit Only with Approval or Line Flow - Return for Credit with Receipt and 
Approval. 

Table 4–4 Order Flow - Generic with Header Level Invoice Activities

Activity Function Result Type Required

Enter WF_STANDARD.NOOP None Yes

End WF_STANDARD.NOOP None Yes
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The Order Flow - Return with Approval workflow process is initiated when you 
submit a return on a sales order in Oracle Order Management. Returns must be 
booked and closed using the same processes as a sales order.

When you submit a return in Oracle Order Management, the process first books the 
return and then sends a notification to verify that the return is authorized. When the 
return is approved, the corresponding return lines can proceed. When all the return 
lines have been closed, this header flow will close and end. The approving manager 
can also decline authorization for the return.

The Order Flow - Return with Approval process ends after the return order is 
closed. The process can end with a result of rejected if:

■ The approving manager does not authorize the return.

■ The order is not eligible for return.

The Order Flow - Return with Approval workflow process is associated with the 
following OM Order Header subprocesses:

■ Book - Order, Manual

■ Approve Return - Order

■ Close - Order

Order Flow - Return with Approval is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Header item type.

Summary of the Order Flow - Return with Approval Process
To view the properties of the Order Flow - Return with Approval process, select the 
process in the navigator tree and then select Properties from the Edit menu. This 
process is runnable, which indicates that it can be assigned to a transaction type. 
The Details property page of the process activity indicates that the Order Flow - 
Return with approval process has an error item type of WFERROR. This item type 
is associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process and 
prompt the administrator to retry the process in error. This error process is initiated 
only when an unexpected error with Oracle Workflow is encountered in the process. 
When you display the Process window for the Order Flow - Return with Approval, 
you see that the process consists of 2 unique activities and 3 subprocesses, which 
comprise the 5 nodes that appear in the workflow diagram. The following diagram 
depicts the Order Flow - Return with Approval process. Each node of this 
subprocess is numbered for referencing.
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Figure 4–5 Order Flow - Return with Approval Workflow

The Order Flow - Generic workflow begins at node 1 with the Enter activity. The 
workflow then proceeds to the Book - Order, Manual subprocess in node 2.

Once the order is booked, the process continues on to the Approve Return - Order 
subprocess in node 3. This subprocess sends notification to verify that the return is 
authorized. After the authorization status is determined, the workflow process 
resumes and moves to the Close - Order process in node 4. Once all the lines in the 
Return have been closed the Return will be closed. After the order is successfully 
closed, the process ends.

Order Flow - Return with Approval Activities
The following table provides descriptions of each activity in the Order Flow - 
Return with Approval process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

OM Order Line Processes
The following section discusses the workflow processes associated with the OM 
Order Line item type:

■ Line Flow - ATO Item

Table 4–5 Order Flow - Return with Approval Activities

Activity Function Result Type Required

Enter WF_STANDARD.NOOP None Yes

End WF_STANDARD.NOOP None Yes
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■ Line Flow - ATO Model

■ Line Flow - Configuration

■ Line Flow - Configuration with Authorize to Ship (RLM)

■ Line Flow - Generic

■ Line Flow - Generic, Performance

■ Line Flow - Generic with Authorize to Ship (RLM)

■ Line Flow - Generic with Header Level Invoice Interface

■ Line Flow - Generic, With Export Compliance

■ Line Flow - Generic, Bill Only

■ Line Flow - Generic, Bill Only with Inventory Interface

■ Line Flow - Generic, Ship Only

■ Line Flow - Generic, with Repricing at Fulfillment

■ Line Flow - Return for Credit Only

■ Line Flow - Return for Credit Only with Approval

■ Line Flow - Return for Credit with Receipt

■ Line Flow - Return for Credit with Receipt and Approval

■ Line Flow - Standard Service

For more information regarding the OM Order Line item type, refer to Chapter 1, 
Introduction.

Line Flow - ATO Item
The Line Flow - ATO Item workflow process supports ATO item lines only, and can 
be assigned to ATO Item lines instead of the Line Flow-Generic.

The Line Flow - ATO Item workflow process is initiated when an item on a sales 
order line is entered as an Assemble-to-Order (ATO) item. ATO items are associated 
with Oracle Configure to Order. To learn more about implementing Oracle 
Configure to Order, refer to the Oracle Configure to Order Implementation Manual. 
When you enter an order line in Oracle Order Management, the process runs 
through several subprocess that schedule the line, create the supply for the 
assemble to order item, prepare for shipping, interface with Oracle Receivables for 
invoicing, and closing the line.
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The Line Flow - ATO Item process can only end after the line is closed. To initiate 
the Line Flow - ATO Item process, you must enter an order in Oracle Order 
Management. The following subprocess are contained in the Line Flow - ATO Item 
workflow process:

■ Enter - Line

■ Schedule - Line

■ Create Supply Order - Line, Manual

■ Ship - Line, Manual

■ Invoice Interface - Line

■ Close - Line

The Line Flow - ATO Item process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

Summary of the Line Flow - ATO Item Process
To view the properties of the Line Flow - ATO Item process, select the process in the 
navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the Line Flow - ATO 
Item process has an error item type of WFERROR. This item type is associated with 
the RETRY_ONLY error process. The purpose of this error handling process is to 
alert an administrator when an error occurs in a process and prompt the 
administrator to retry the process in error. This error process is initiated only when 
an unexpected error with Oracle Workflow is encountered in the process.

When you display the Process window for the Line Flow - ATO Item, you see that 
the process consists of 3 unique activities and 6 subprocesses, which comprise the 9 
nodes that appear in the workflow diagram. The following diagram depicts the 
Line Flow - ATO Item process. Each node of this subprocess is numbered for 
referencing.
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Figure 4–6 Line Flow - ATO Item Workflow

The Line Flow - ATO Item workflow begins at node 1 with the Enter - Line 
subprocess. This subprocess ensures that the order is booked before proceeding 
with the rest of the line flow.

After the order is booked the workflow process proceeds to the Schedule - Line 
subprocess in node 2. When scheduling for the line is complete the Create Supply 
Order - Line, Manual subprocess is initiated. The Ship - Line, Manual subprocess is 
initiated after supply is created for the line. The Fulfill - Deferred activity in node 5 
moves line fulfillment to the background engine. In node 7 the workflow interfaces 
with Oracle Receivables to create an invoice for the line. After the invoice interface 
is complete, the line is closed and the subprocess ends.
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Line Flow - ATO Item Activities
The following table provides descriptions of each activity in the Line Flow - ATO 
Item process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Line Flow - ATO Model
The Line Flow - ATO Model workflow process supports ATO model lines only, and 
can be assigned to ATO Model lines instead of the Line Flow - Generic.

The Line Flow - ATO Model workflow process is initiated when an item on a sales 
order line is entered as an Assemble-to-Order (ATO) model. ATO is associated with 
Oracle Configure to Order. For more information about implementing Oracle 
Configure to Order, refer to the Oracle Configure to Order Implementation Manual.

The Line Flow - ATO Model process can only end after the line is closed. To initiate 
the Line Flow - ATO Model process, you must enter an order in Oracle Order 
Management. The following subprocess are contained in the Line Flow - ATO 
Model workflow process:

■ Enter - Line

■ Schedule - Line

■ Create Configuration - Line, Manual

■ Invoice Interface - Line, Deferred

■ Close - Line

The Line Flow - ATO Model process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

Table 4–6 Line Flow - ATO Item Activities

Activity Function Result Type Required

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes
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Summary of the Line Flow - ATO Model Process
To view the properties of the Line Flow - ATO Model process, select the process in 
the navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the Line Flow - ATO 
Model process has an error item type of WFERROR. This item type is associated 
with the RETRY_ONLY error process. The purpose of this error handling process is 
to alert an administrator when an error occurs in a process and prompt the 
administrator to retry the process in error. This error process is initiated only when 
an unexpected error with Oracle Workflow is encountered in the process.

When you display the Process window for the Line Flow - ATO Model, you see that 
the process consists of 3 unique activities and 5 subprocesses, which comprise the 8 
nodes that appear in the workflow diagram. The following diagram depicts the 
Line Flow - ATO Item process. Each node of this subprocess is numbered for 
referencing.

Figure 4–7 Line Flow - ATO Model Workflow

The Line Flow - ATO Model workflow begins at node 1 with the Enter - Line 
subprocess. This subprocess ensures that the order is booked before proceeding 
with the rest of the line flow.
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After the order is booked the workflow process proceeds to the Schedule - Line 
subprocess in node 2. When scheduling for the line is complete the Create 
Configuration - Line, Manual subprocess is initiated. The Fulfill - Deferred activity 
in node 4 moves line fulfillment to the background engine. In node 6, Invoice 
Interface - Line, Deferred, the workflow interfaces with Oracle Receivables to create 
an invoice for the line. After the invoice interface is complete, the line is closed 
(Close - Line) and the subprocess ends (End).

Line Flow - ATO Model Activities
The following table provides descriptions of each activity in the Line Flow - ATO 
Model process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Line Flow - Configuration
The Line Flow - Configuration workflow process is associated with Oracle 
Configure to Order. This workflow works only with ATO configuration items and 
must be assigned specifically to configuration lines during the implementation 
process. To learn more about implementing Oracle Configure to Order, refer to the 
Oracle Configure to Order Implementation Manual.

To initiate the Line Flow - Configuration process, you must move an ATO model 
line through Create Configuration - Eligible activity by progressing the order line or 
by running the Autocreate Config batch program. This creates the configuration 
item, links it to the order, and starts the Line Flow - Configuration process.

The following subprocess are contained in the Line Flow - Configuration workflow 
process:

■ Enter - Line

■ Create Manufacturing Configuration Data - Line, Manual

Table 4–7 Line Flow - ATO Model Activities

Activity Function Result Type Required

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes
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■ Create Supply Order - Line, Manual

■ Ship - Line, Manual

■ Close - Line

The Line Flow - Configuration process can only end after the line is closed. The Line 
Flow - Configuration process is contained in the Seeded Data File oexwford.wft and 
is associated with the OM Order Line item type.

Summary of the Line Flow - Configuration Process
To view the properties of the Line Flow - Configuration process, select the process 
in the navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the Line Flow - 
Configuration process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error handling 
process is to alert an administrator when an error occurs in a process and prompt 
the administrator to retry the process in error. This error process is initiated only 
when an unexpected error with Oracle Workflow is encountered in the process. 
When you display the Process window for the Line Flow - Configuration, you see 
that the process consists of 4 unique activities and 4 subprocesses, which comprise 
the 8 nodes that appear in the workflow diagram. The following diagram depicts 
the Line Flow - Configuration process. Each node of this subprocess is numbered 
for referencing.
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Figure 4–8 Line Flow - Configuration Workflow

The Line Flow - Configuration workflow begins at node 1 with the Start activity. In 
node 2, the process runs the Create Manufacturing Configuration Data - Line, 
Manual subprocess, then the Create Supply Order - Line, Manual subprocess in

node 3. Once these subprocess are completed, the Ship - Line, Manual subprocess is 
initiated. In node 5, the Fulfill - Deferred activity moves fulfillment to the 
background engine. The process initiates the Close - Line subprocess in node 7. 
After the line is successfully closed, the process ends.

Line Flow - Configuration Activities
The following table provides descriptions of each activity in the Line Flow - 
Configuration process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Table 4–8 Line Flow - Configuration Activities

Activity Function Result Type Required

Start WF_STANDARD.NOOP None Yes
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Line Flow - Configuration with Authorize to Ship (RLM)

The Line Flow - Configuration with Authorize to Ship (RLM) workflow process is 
associated with Oracle Release Management users. Line Flow - Configuration with 
Authorize to Ship (RLM) ensures that a line is eligible for shipping.

This workflow is specific to Oracle Release Management users and must be 
assigned during the implementation process. To learn more about implementing 
Oracle Release Management, refer to the Oracle Release Management Implementation 
Manual.

To initiate the Line Flow - Configuration with Authorize to Ship (RLM) process, you 
must enter an order in Oracle Order Management. If the items on the line require 
authorization before shipping, this process initiates. The following subprocess are 
contained in the Line Flow - Configuration with Authorize to Ship (RLM) workflow 
process:

■ Create Manufacturing Configuration Data - Line, Manual

■ Create Supply Order - Line, Manual

■ Authorized to Ship - Line

■ Ship - Line, Manual

■ Close - Line

The Line Flow - Configuration with Authorize to Ship (RLM) process can only end 
after the line is closed.

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes

Note: This process is not currently used in Oracle Order 
Management is listed for reference purposes only. Do not use this 
process when assigning processes to transaction types. Oracle does 
not provide support for this workflow process.

Table 4–8 Line Flow - Configuration Activities

Activity Function Result Type Required
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The Line Flow - Configuration with Authorize to Ship (RLM) process is contained 
in the Seeded Data File oexwford.wft and is associated with the OM Order Line 
item type.

Summary of the Line Flow - Configuration with Authorize to Ship (RLM) Process
To view the properties of the Line Flow - Configuration with Authorize to Ship 
(RLM) process, select the process in the navigator tree and then select Properties 
from the Edit menu. This process is runnable, which indicates that it can be 
assigned to a transaction type.

The Details property page of the process activity indicates that the Line Flow - 
Configuration with Authorize to Ship (RLM) process has an error item type of 
WFERROR. This item type is associated with the RETRY_ONLY error process. The 
purpose of this error handling process is to alert an administrator when an error 
occurs in a process and prompt the administrator to retry the process in error. This 
error process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

When you display the Process window for the Line Flow - Configuration with 
Authorize to Ship (RLM), you see that the process consists of 5 unique activities and 
5 subprocesses, which comprise the 10 nodes that appear in the workflow diagram. 
The following diagram depicts the Line Flow - Configuration with Authorize to 
Ship (RLM) process. Each node of this subprocess is numbered for referencing.
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Figure 4–9 Line Flow - Configuration with Authorize to Ship (RLM) Workflow

The Line Flow - Configuration with Authorize to Ship (RLM) workflow begins at 
node 1 with the Start activity.

In node 2, the process runs the Configuration - Check Status activity. Once status is 
verified the process moves through the Create Manufacturing Configuration Data - 
Line, Manual subprocess in node 3 and the Create Supply Order - Line, Manual 
subprocess in node 4. Once these subprocess are completed, the Authorized to Ship 
- Line subprocess is initiated in node 5, then Ship - Line, Manual subprocess in node 
6. In node 7, the Fulfill - Deferred activity moves fulfillment to the background 
engine. The process initiates the Close - Line subprocess in node 9. After the line is 
successfully closed, the process ends.

Line Flow - Configuration with Authorize to Ship (RLM) Activities
The following table provides descriptions of each activity in the Line Flow - 
Configuration with Authorize to Ship (RLM) process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.
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Line Flow - Generic
The Line Flow - Generic process is a workflow process that is initiated when you 
save a sales order line in Oracle Order Management. The Line - Flow Generic 
process contains several subprocesses to ensure that an order line is properly 
entered, scheduled, created, invoiced, fulfilled, shipped, and closed. If you use 
several different line flows in your business, the Line Flow - Generic workflow can 
act as a default; it initiates when no other flow is determined necessary for a line. 
When you save an order line in Oracle Order Management, the process verifies that 
the order is booked before proceeding. Once booking is verified, the process 
continues with scheduling, supply creation, invoicing, fulfillment, shipping and 
closing. Several of these actions are performed in the following workflow 
subprocesses contained in Line Flow - Generic:

■ Enter - Line

■ Schedule - Line

■ Create Supply Order - Line, Manual

■ Ship - Line, Manual

■ Invoice Interface - Line

■ Close - Line

Line Flow - Generic can only end once the line is successfully closed.

The Line Flow - Generic process is contained in the Seeded Data File oexwford.wft 
and is associated with the OM Order Line item type.

Table 4–9 Line Flow - Configuration with Authorize to Ship (RLM) Activities

Activity Function Result Type Required

Start WF_STANDARD.NOOP None Yes

Configuration - Check 
Status 

CTO_WORKFLOW.CHECK_
RESERVATION_STATUS_WF

Config Data 
Results

Yes

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes
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Summary of the Line Flow - Generic Process
To view the properties of the Line Flow - Generic process, select the process in the 
navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the Line Flow - 
Generic process has an error item type of WFERROR. This item type is associated 
with the RETRY_ONLY error process. The purpose of this error handling process is 
to alert an administrator when an error occurs in a process and prompt the 
administrator to retry the process in error. This error process is initiated only when 
an unexpected error with Oracle Workflow is encountered in the process.

When you display the Process window for the Line Flow - Generic, you see that the 
process consists of 3 unique activities and 6 subprocesses, which comprise the 9 
nodes that appear in the workflow diagram. The following diagram depicts the 
Line Flow - Generic process. Each node of this subprocess is numbered for 
referencing.

Figure 4–10 Line Flow - Generic Workflow

The Line Flow - Generic workflow begins at node 1 with the Enter - Line 
subprocess. This subprocess verifies that the order is booked before proceeding with 
the remainder of the workflow.
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In node 2, the process attempts to schedule the line for the order using the Schedule 
- Line subprocess. The Create Supply - Line subprocess is initiated in node 3. After 
supply is created for the line, the Ship - Line, Manual subprocess in node 4 initiates. 
In node 5, the Fulfill - Deferred activity moves fulfillment to the background engine. 
Node 7 is the Invoice Interface - Line subprocess that generates invoicing 
information for the line. The process initiates the Close - Line subprocess at node 8. 
After the line is successfully closed, the process ends.

Line Flow - Generic Activities
The following table provides descriptions of each activity in the Line Flow - Generic 
process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Line Flow - Generic, Performance
Line Flow Generic, Performance is a more recent line flow optimized for high 
volume users who have performance concerns. It is functionally the same as 
Line Flow-Generic, but performance is improved by placing the subprocesses at 
the top level/main process.

If your performance is satisfactory and you are currently using Line Flow – 
Generic, you will probably want to continue to use the initially seeded generic 
flow. The traditional Line Flow – Generic has everything decomposed into 
subprocesses, which could make it easier to extend the flow. For example, you 
could add an activity to the top level/main flow without modifying the 
subprocesses seeded by Order Management. Then you could update a 
subprocess via patching, without the need to add your changes. If you are 
modifying the seeded flow, it may be beneficial to use Line Flow – Generic 
instead of Line Flow-Generic, Performance.

Table 4–10 Line Flow - Generic Activities

Activity Function Result Type Required

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes
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It is possible to extend or even customize Line Flow-Generic, Performance, but 
then you will have to make your changes to a copy of the line flow any time it is 
updated via a patch. 

Line Flow - Generic, Performance can only end once the line is successfully 
closed.

The Line Flow - Generic, Performance process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

Summary of the Line Flow - Generic, Performance Process
To view the properties of the Line Flow - Generic, Performance process, select 
the process in the navigator tree and then select Properties from the Edit menu. 
This process is runnable, which indicates that it can be assigned to a transaction 
type.

The Details property page of the process activity indicates that the Line Flow - 
Generic, Performance process has an error item type of OMERROR. This item 
type is associated with the R_ERROR_RETRY error process. The purpose of this 
error handling process is to alert an administrator when an error occurs in a 
process and prompt the administrator to retry the process in error. This error 
process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

When you display the Process window for the Line Flow - Generic, 
Performance, you see that the process consists of 7 unique activities and 2 
subprocesses that appear in the workflow diagram. The following diagram 
depicts the Line Flow - Generic, Performance process.
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Figure 4–11 Line Flow - Generic, Performance Workflow 1

The Line Flow - Generic, Performance workflow begins with the Wait for Booking 
subprocess. This function verifies that the order is booked before proceeding to the 
next step in the workflow.

The process then attempts to schedule the order line using the Schedule activity. If 
the order line is manually changed to incomplete or on hold, the Schedule - Eligible 
function will be used, otherwise the Schedule activity moves the workflow forward 
as complete. The Branch on Source Type function uses the lookup (has a result type 
of) Source Type. The source types include: ATO Item, Build, Dropship, and Ship 
(default). If Build is the source type, then the subprocess Create Configuration - 
Line, Manual is executed, then Ship. If ATO Item is the source type, then Create 
Supply Order - Line, Manual is executed, then Ship. If Dropship is the source type, 
then the Purchase Release - Line, Deferred activity is executed, after which the 
Purchase Release activity is executed. If the order line is manually changed to 
incomplete or on hold, the Purchase Release - Eligible function will be used, 
otherwise the Purchase Release activity moves the workflow forward to Ship. Next, 
the Fulfill - Deferred activity moves the workflow forward to the Fulfill activity. 
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Figure 4–12 Line Flow - Generic, Performance Workflow (Continued)

The Fulfill activity then processes the workflow onto the Invoice Interface function. 
If the order line is manually changed to incomplete or on hold, the Invoice Interface 
- Eligible activity will be used, otherwise, the Invoice Interface function moves the 
workflow to either Wait for Required for Revenue or Delivery (if Partial) or Close (if 
Not Eligible or Complete). If the order line is manually changed to incomplete or on 
hold, the Wait function is used to specify a day of the week, specific date, and so on 
before closing the line. When the order line is complete or not eligible, the workflow 
moves to Close - Continue Header where the workflow ends.

Line Flow - Generic, Performance Activities
The following table provides descriptions of each activity in the Line Flow - 
Generic, Performance process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Table 4–11 Line Flow - Generic, Performance Activities

Activity Function Result Type Required

Schedule OE_OEOL_SCH.SCHEDULE_
LINE

On Hold, 
Incomplete, 
Not Eligible, 
Complete

Yes

Schedule - Eligible OE_STANDARD_
WF.STANDARD_BLOCK

None Yes

Purchase Release - Deferred WF_STANDARD.DEFER None Yes
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The following workflow subprocesses are contained in Line Flow - Generic, 
Performance:

■ Create Configuration - Line, Manual

■ Create Supply Order - Line, Manual

Line Flow - Generic with Authorize to Ship (RLM)
The Line Flow - Generic with Authorize to Ship (RLM) process is a workflow 
process that is initiated when you save a sales order line in Oracle Order 
Management. The Line - Flow Generic with Authorize to Ship (RLM) process is 
specific to Oracle Release Management users, and enables you to authorize 
order lines for shipping.

Line Flow - Generic with Authorize to Ship (RLM) contains all of the subprocess 
and activities contained in Line Flow - Generic, as well as the Authorize to Ship 
(RLM) subprocess.

To initiate the Line Flow - Generic with Authorize to Ship (RLM) process, enter an 
order line in Oracle Order Management. The following subprocess are contained in 
the Line Flow - Configuration with Authorize to Ship (RLM) workflow process:

■ Enter - Line

■ Schedule - Line

■ Create Supply Order - Line, Manual

■ Authorized to Ship - Line

■ Ship - Line, Manual

Purchase Release OE_OEOL_SCH.RELEASE_TO_
PURCHASING

On Hold, 
Incomplete, 
Not Eligible, 
Complete

Yes

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

Inventory Interface - 
Eligible

OE_STANDARD_
WF.STANDARD_BLOCK

None Yes

Table 4–11 Line Flow - Generic, Performance Activities

Activity Function Result Type Required
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■ Invoice Interface - Line

■ Close - Line

The Line Flow - Generic with Authorize to Ship (RLM) process can only end after 
the line is successfully closed.

Because this workflow is specific to Oracle Release Management users, it must be 
assigned during the implementation process. To learn more about implementing 
Oracle Release Management, refer to the Oracle Release Management Implementation 
Manual.

The Line Flow - Generic with Authorize to Ship (RLM) process is contained in 
the Seeded Data File oexwford.wft and is associated with the OM Order Line item 
type.

Summary of the Line Flow - Generic with Authorize to Ship (RLM) Process
To view the properties of the Line Flow - Generic with Authorize to Ship (RLM) 
process, select the process in the navigator tree and then select Properties from the 
Edit menu. This process is runnable, which indicates that it can be assigned to a 
transaction type.

The Details property page of the process activity indicates that the Line Flow - 
Generic with Authorize to Ship (RLM) process has an error item type of WFERROR. 
This item type is associated with the RETRY_ONLY error process. The purpose of 
this error handling process is to alert an administrator when an error occurs in a 
process and prompt the administrator to retry the process in error. This error 
process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

When you display the Process window for the Line Flow - Generic with Authorize 
to Ship (RLM), you see that the process consists of 3 unique activities and 7 
subprocesses, which comprise the 10 nodes that appear in the workflow diagram. 
The following diagram depicts the Line Flow - Generic with Authorize to Ship 
(RLM) process. Each node of this subprocess is numbered for referencing.
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Figure 4–13 Line Flow - Generic with Authorize to Ship (RLM) Workflow

The Line Flow - Generic with Authorize to Ship (RLM) workflow begins at node 1 
with the Enter - Line subprocess. This subprocess verifies that the order is booked 
before proceeding with the remainder of the workflow.

In node 2, the process attempts to schedule the line for the order using the Schedule 
- Line subprocess. The Create Supply - Line subprocess is initiated in node 3. The 
Oracle Release Management user Authorized to Ship - Line subprocess at node 4 
verifies that the line is approved for shipping. After approval is determined, the 
Ship - Line, Manual subprocess at node 5 initiates. In node 6, the Fulfill - Deferred 
activity moves fulfillment to the background engine. Node 8 is the Invoice Interface 
- Line subprocess that generates invoicing information for the line. The process 
initiates the Close - Line subprocess at node 9. After the line is successfully closed, 
the process ends.

Line Flow - Generic with Authorize to Ship (RLM) Activities
The following table provides descriptions of each activity in the Line Flow - Generic 
with Authorize to Ship (RLM) process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.
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Line Flow - Generic with Header Level Invoice Interface
The Line Flow - Generic with Header Level Invoice Interface process is a workflow 
process that is initiated when you save a sales order line in Oracle Order 
Management. The Line - Flow Generic with Header Level Invoice Interface process 
interfaces with Oracle Receivables to generate invoicing information for an order 
line. The process works with the seeded header flow to support header level 
invoicing.

The Line Flow - Generic with Header Level Invoice Interface workflow contains 
several subprocesses to ensure that an order line is properly entered, scheduled, 
created, invoiced, fulfilled, shipped, and closed. Line Flow - Generic with Header 
Level Invoice Interface contains all of the subprocess and activities contained in 
Line Flow - Generic, but replaces the Invoice Interface - Line subprocess with the 
Header Level Invoice Interface - Line, Deferred subprocess.

When you save an order line in Oracle Order Management, the Line Flow - Generic 
with Header Level Invoice Interface process verifies that the order is booked before 
proceeding. Once booking is verified, the process continues with scheduling, 
supply creation, invoicing, fulfillment, shipping and closing. Several of these 
activities are performed in the following workflow subprocesses contained in Line 
Flow - Generic with Header Level Invoice Interface:

■ Enter - Line

■ Schedule - Line

■ Create Supply Order - Line, Manual

■ Ship - Line, Manual

■ Header Level Invoice Interface - Line, Deferred

■ Close - Line

Line Flow - Generic with Header Level Invoice Interface can only end once the line 
is successfully closed.

Table 4–12 Line Flow - Generic with Authorize to Ship (RLM) Activities

Activity Function Result Type Required

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes
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The Line Flow - Generic with Header Level Invoice Interface process is contained in 
the Seeded Data File oexwford.wft and is associated with the OM Order Line item 
type.

Summary of the Line Flow - Generic with Header Level Invoice Interface Process 
To view the properties of the Line Flow - Generic with Header Level Invoice 
Interface process, select the process in the navigator tree and then select Properties 
from the Edit menu. This process is runnable, which indicates that it can be 
assigned to a transaction type.

The Details property page of the process activity indicates that the Line Flow - 
Generic with Header Level Invoice Interface process has an error item type of 
WFERROR. This item type is associated with the RETRY_ONLY error process. The 
purpose of this error handling process is to alert an administrator when an error 
occurs in a process and prompt the administrator to retry the process in error. This 
error process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

When you display the Process window for the Line Flow - Generic with Header 
Level Invoice Interface, you see that the process consists of 1 unique activity and 6 
subprocesses, which comprise the 7 nodes that appear in the workflow diagram. 
The following diagram depicts the Line Flow - Generic with Header Level Invoice 
Interface process. Each node of this subprocess is numbered for referencing.

Figure 4–14 Line Flow - Generic with Header Level Invoice Interface Workflow
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The Line Flow - Generic workflow begins at node 1 with the Enter - Line 
subprocess. This subprocess verifies that the order is booked before proceeding with 
the remainder of the workflow.

In node 2, the process attempts to schedule the line for the order using the Schedule 
- Line subprocess. The Create Supply - Line subprocess is initiated in node 3. After 
supply is created for the line, the Ship - Line, Manual subprocess in node 4 initiates. 
In node 5, the Header Level Invoice Interface - Line, Deferred activity moves header 
level invoice interfacing to the background engine. This enables the workflow to 
proceed. Node 6 is the Close - Line subprocess, followed by the End activity at node 
7.

Line Flow - Generic with Header Level Invoice Interface Activities
The following table provides a description of the activity in the Line Flow - Generic 
with Header Level Invoice Interface process.

For more information about Oracle Order Management workflow activities, refer to 
Chapter 6, Seeded Function Activity Definitions.

Line Flow - Generic, With Export Compliance
The Line Flow - Generic, With Export Compliance process is a workflow process 
that is initiated when you save a sales order line in Oracle Order Management that 
requires exportation. The Line Flow - Generic, With Export Compliance process 
contains a subprocess that performs Denied Party screening according to United 
States Bureau of Export Administration’s Denied Party listing.

When an order line is submitted that must comply with the United States Bureau of 
Export Administration’s Denied Party listing, the Line Flow - Generic, With Export 
Compliance workflow process initiates. The Line - Flow Generic, With Export 
Compliance process contains several subprocesses to ensure that the order line is 
properly entered, scheduled, created, invoiced, fulfilled, shipped, and closed. Line 
Flow - Generic, With Export Compliance contains all of the subprocess and 
activities contained in Line Flow - Generic, as well as the Export Compliance 
Screening - Line subprocess.

When you save an order line in Oracle Order Management, the Line Flow - Generic, 
With Export Compliance process verifies that the order is booked before 

Table 4–13 Line Flow - Generic with Header Level Invoice Interface Activities

Activity Function Result Type Required

End WF_STANDARD.NOOP None Yes
4-34 Using Oracle Workflow in Oracle Order Management



OM Order Line Processes
proceeding. Once booking is verified, the process continues with scheduling, 
supply creation, invoicing, fulfillment, shipping and closing. Several of these 
activities are performed in the following workflow subprocesses contained in Line 
Flow - Generic, With Export Compliance:

■ Enter - Line

■ Schedule - Line

■ Export Compliance Screening - Line

■ Create Supply Order - Line, Manual

■ Ship - Line, Manual

■ Invoice Interface - Line

■ Close - Line

Line Flow - Generic, With Export Compliance can only end once the line is 
successfully closed.

The Line Flow - Generic, With Export Compliance process is contained in the 
Seeded Data File oexwford.wft and is associated with the OM Order Line item type.

Summary of the Line Flow - Generic, With Export Compliance Process
To view the properties of the Line Flow - Generic, With Export Compliance process, 
select the process in the navigator tree and then select Properties from the Edit 
menu. This process is runnable, which indicates that it can be assigned to a 
transaction type.

The Details property page of the process activity indicates that the Line Flow - 
Generic, With Export Compliance process has an error item type of WFERROR. This 
item type is associated with the RETRY_ONLY error process. The purpose of this 
error handling process is to alert an administrator when an error occurs in a process 
and prompt the administrator to retry the process in error. This error process is 
initiated only when an unexpected error with Oracle Workflow is encountered in 
the process.

When you display the Process window for the Line Flow - Generic, With Export 
Compliance, you see that the process consists of 3 unique activities and 7 
subprocesses, which comprise the 10 nodes that appear in the workflow diagram. 
The following diagram depicts the Line Flow - Generic, With Export Compliance 
process. Each node of this subprocess is numbered for referencing.
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Figure 4–15 Line Flow - Generic with Export Compliance Workflow

The Line Flow - Generic With Export Compliance workflow begins at node 1 with 
the Enter - Line subprocess. This subprocess verifies that the order is booked before 
proceeding with the remainder of the workflow.

In node 2, the process attempts to schedule the line for the order using the Schedule 
- Line subprocess. To comply with the United States Bureau of Export 
Administration’s Denied Party listing, the Export Compliance Screening - Line 
subprocess at node 3 initiates. If the line passes this screening process, then the 
process approves the line for exporting and continues.

The Create Supply - Line subprocess is initiated in node 4. After supply is created 
for the line, the Ship - Line, Manual subprocess at node 5 initiates. At node 6, the 
Fulfill - Deferred activity moves fulfillment to the background engine. Node 8 is the 
Invoice Interface - Line subprocess that generates invoicing information for the line. 
The process initiates the Close - Line subprocess at node 9. After the line is 
successfully closed, the process ends at node 10.

Line Flow - Generic With Export Compliance Activities
The following table provides descriptions of each activity in the Line Flow - Generic 
With Export Compliance process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.
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Line Flow - Generic, Bill Only
The Line Flow - Generic, Bill Only process is a workflow process is used for order 
lines that do not require shipping. The Line Flow - Generic, Bill Only process is used 
in a situation when only a bill for the order must be generated. The process contains 
several subprocesses to ensure that the order line is properly entered, invoiced, 
fulfilled, and closed.

When you save an order line in Oracle Order Management, the Line Flow - Generic, 
Bill Only process verifies that the order is booked before proceeding. Once booking 
is verified, the process continues with invoicing, fulfillment, and closing. Several of 
these actions are performed in the following workflow subprocesses contained in 
Line Flow - Generic, Bill Only:

■ Enter - Line

■ Invoice Interface - Line, Deferred

■ Close - Line

Line Flow - Generic, Bill Only ends once the line is successfully closed. The only 
process is contained in the Seeded Data File oexwford.wft and is associated with the 
OM Order Line item type.

Summary of the Line Flow - Generic, Bill Only Process
To view the properties of the Line Flow - Generic, Bill Only process, select the 
process in the navigator tree and then select Properties from the Edit menu. This 
process is runnable, which indicates that it can be assigned to a transaction type. 
The Details property page of the process activity indicates that the Line Flow - 
Generic, Bill Only process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error handling 
process is to alert an administrator when an error occurs in a process and prompt 
the administrator to retry the process in error. This error process is initiated only 
when an unexpected error with Oracle Workflow is encountered in the process. 

Table 4–14 Line Flow - Generic with Export Compliance Activities

Activity Function Result Type Required

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes
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When you display the Process window for the Line Flow - Generic, Bill Only, you 
see that the process consists of 2 unique activities and 3 subprocesses, which 
comprise the 5 nodes that appear in the workflow diagram. The following diagram 
depicts the Line Flow - Generic, Bill Only process. Each node of this process is 
numbered for referencing.

Figure 4–16 Line Flow - Generic, Bill Only Workflow

The Line Flow - Generic, Bill Only workflow begins at node 1 with the Enter - Line 
subprocess. This subprocess verifies that the order is booked before proceeding with 
the remainder of the workflow.

The process attempts to fulfill the order at node 2. At node 3, the Invoice Interface - 
Line, Deferred subprocess is initiated. This subprocess moves the invoice interface 
to the background engine. The process initiates the Close - Line subprocess at node 
4. After the line is successfully closed, the process ends at node 5.

Line Flow - Generic, Bill Only Activities
The following table provides descriptions of each activity in the Line Flow - 
Generic, Bill Only process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Table 4–15 Line Flow - Generic, Bill Only Activities

Activity Function Result Type Required

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes
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Line Flow - Generic, Bill Only with Inventory Interface
The Line Flow - Generic, Bill Only with Inventory Interface process is a workflow 
process that is initiated when you save a sales order line in Oracle Order 
Management. The Line Flow - Generic, Bill Only with Inventory Interface process is 
used in a situation when only a bill for the order must be generated. The process 
contains several subprocesses to ensure that the order line is properly entered, 
invoiced, fulfilled, and closed.

When you save an order line in Oracle Order Management, the Line Flow - Generic, 
Bill Only with Inventory Interface process verifies that the order is booked before 
proceeding. Once booking is verified, the process continues with invoicing, 
fulfillment, and closing. Several of these actions are performed in the following 
workflow subprocesses contained in Line Flow - Generic, Bill Only with Inventory 
Interface:

■ Enter - Line

■ Invoice Interface - Line, Deferred

■ Close - Line

Line Flow - Generic, Bill Only with Inventory Interface ends after the line is 
successfully closed.

The Line Flow - Generic, Bill Only with Inventory Interface process is contained in 
the Seeded Data File oexwford.wft and is associated with the OM Order Line item 
type.

Summary of the Line Flow - Generic, Bill Only with Inventory Interface Process 
To view the properties of the Line Flow - Generic, Bill Only with Inventory Interface 
process, select the process in the navigator tree and then select Properties from the 
Edit menu. This process is runnable, which indicates that it can be assigned to a 
transaction type.

The Details property page of the process activity indicates that the Line Flow - 
Generic, Bill Only with Inventory Interface process has an error item type of 
WFERROR. This item type is associated with the RETRY_ONLY error process. The 
purpose of this error handling process is to alert an administrator when an error 
occurs in a process and prompt the administrator to retry the process in error. This 
error process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process. 

When you display the Process window for the Line Flow - Generic, Bill Only with 
Inventory Interface, you see that the process consists of 2 unique activities and 4 
Seeded Workflow Definitions 4-39



OM Order Line Processes
subprocesses, which comprise the 6 nodes that appear in the workflow diagram. 
The following diagram depicts the Line Flow - Generic, Bill Only with Inventory 
Interface process. Each node of this process is numbered for referencing.

Figure 4–17 Line Flow - Generic, Bill Only with Inventory Interface Workflow

The Line Flow - Generic, Bill Only with Inventory Interface workflow begins at 
node 1 with the Enter - Line subprocess. This subprocess verifies that the order is 
booked before proceeding with the remainder of the workflow.

At node 2 the Inventory Interface Non-Ship - Line, Deferred subprocess is initiated. 
After completion of that subprocess, the Line Flow - Generic, Bill Only with 
Inventory Interface process attempts to fulfill the order at node 3. At node 4, the 
Invoice Interface - Line, Deferred subprocess is initiated. This subprocess moves the 
invoice interface to the background engine. The process initiates the Close - Line 
subprocess at node 5. After the line is successfully closed, the process ends at node 
6.

Line Flow - Generic, Bill Only with Inventory Interface Activities
The following table provides descriptions of each activity in the Line Flow - 
Generic, Bill Only with Inventory Interface process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions

Table 4–16 Line Flow - Generic, Bill Only with Inventory Interface Activities

Activity Function Result Type Required

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes
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Line Flow - Generic, Ship Only
The Line Flow - Generic, Ship Only process is a workflow process that is initiated 
when you save a sales order line in Oracle Order Management that does not require 
invoicing. An order line can require this when the rest of the order lines have 
already been shipped with an invoice for the order. Line Flow - Generic, Ship Only 
is associated with order lines that only require shipping.

The Line - Flow Generic, Ship Only process contains several subprocesses to ensure 
that an order line is properly entered, scheduled, created, fulfilled, shipped, and 
closed.

When you save an order line in Oracle Order Management, the Line Flow - Generic, 
Ship Only process verifies that the order is booked before proceeding. Once booking 
is verified, the process continues with scheduling, supply creation, fulfillment, 
shipping, and closing. Several of these actions are performed in the following 
workflow subprocesses contained in Line Flow - Generic, Ship Only:

■ Enter - Line

■ Schedule - Line

■ Create Supply Order - Line, Manual

■ Ship - Line, Manual

■ Close - Line

Line Flow - Generic, Ship Only ends after the line is successfully closed. 

The Line Flow - Generic, Ship Only process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

End WF_STANDARD.NOOP None Yes

Note: The Line Flow - Generic, Ship Only process is identical to 
the Line Flow - Generic process except that it does not include the 
Invoice Interface - Line activity.

Table 4–16 Line Flow - Generic, Bill Only with Inventory Interface Activities

Activity Function Result Type Required
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Summary of the Line Flow - Generic, Ship Only Process
To view the properties of the Line Flow - Generic, Ship Only process, select the 
process in the navigator tree and then select Properties from the Edit menu. This 
process is runnable, which indicates that it can be assigned to a transaction type. 
The Details property page of the process activity indicates that the Line Flow - 
Generic, Ship Only process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error handling 
process is to alert an administrator when an error occurs in a process and prompt 
the administrator to retry the process in error. This error process is initiated only 
when an unexpected error with Oracle Workflow is encountered in the process. 
When you display the Process window for the Line Flow - Generic, Ship Only, you 
see that the process consists of 3 unique activities and 5 subprocesses, which 
comprise the 8 nodes that appear in the workflow diagram. The following diagram 
depicts the Line Flow - Generic, Ship Only process. Each node of this subprocess is 
numbered for referencing.

Figure 4–18 Line Flow - Generic, Ship Only Workflow

The Line Flow - Generic, Ship Only workflow begins at node 1 with the Enter - Line 
subprocess. This subprocess verifies that the order is booked before proceeding with 
the remainder of the workflow.

In node 2, the process attempts to schedule the line for the order using the Schedule 
- Line subprocess. The Create Supply - Line subprocess is initiated in node 3. After 
supply is created for the line, the Ship - Line, Manual subprocess in node 4 initiates. 
In node 5, the Fulfill - Deferred activity moves fulfillment to the background engine.

The process initiates the Close - Line subprocess at node 7. After the line is 
successfully closed, the process ends at node 8.
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Line Flow - Generic, Ship Only Activities
The following table provides descriptions of each activity in the Line Flow - 
Generic, Ship Only process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Line Flow - Generic, with Repricing at Fulfillment
The Line Flow - Generic, with Repricing at Fulfillment process is a workflow 
process initiated when you save a sales order line in Oracle Order Management that 
requires repricing after the order line is fulfilled. The Line - Flow Generic with 
Repricing at Fulfillment process contains several subprocesses to ensure that an 
order line is properly entered, scheduled, created, invoiced, fulfilled, repriced, 
shipped, and closed.

Line Flow - Generic, with Repricing at Fulfillment contains all of the subprocess 
and activities contained in the Line Flow - Generic workflow process, as well as 
the Reprice - Line subprocess.

When you save an order line in Oracle Order Management, the Line Flow - Generic, 
with Repricing at Fulfillment process verifies that the order is booked before 
proceeding. Once booking is verified, the process continues with scheduling, 
supply creation, invoicing, fulfillment, repricing, shipping, and closing. Several of 
these activities are performed in the following workflow subprocesses contained in 
Line Flow - Generic, with Repricing at Fulfillment:

■ Enter - Line

■ Schedule - Line

■ Create Supply Order - Line, Manual

■ Ship - Line, Manual

■ Reprice - Line

Table 4–17 Line Flow - Generic, Ship Only Activities

Activity Function Result Type Required

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes
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■ Invoice Interface - Line

■ Close - Line

Line Flow - Generic, with Repricing at Fulfillment ends after the line is successfully 
closed.

The Line Flow - Generic, with Repricing at Fulfillment process is contained in 
the Seeded Data File oexwford.wft and is associated with the OM Order Line item 
type.

Summary of the Line Flow - Generic, with Repricing at Fulfillment Process
To view the properties of the Line Flow - Generic, with Repricing at Fulfillment 
process, select the process in the navigator tree and then select Properties from the 
Edit menu. This process is runnable, which indicates that it can be assigned to a 
transaction type.

The Details property page of the process activity indicates that the Line Flow - 
Generic, with Repricing at Fulfillment process has an error item type of WFERROR. 
This item type is associated with the RETRY_ONLY error process. The purpose of 
this error handling process is to alert an administrator when an error occurs in a 
process and prompt the administrator to retry the process in error. This error 
process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

When you display the Process window for the Line Flow - Generic, with Repricing 
at Fulfillment, you see that the process consists of 3 unique activities and 7 
subprocesses, which comprise the 10 nodes that appear in the workflow diagram. 
The following diagram depicts the Line Flow - Generic, with Repricing at 
Fulfillment process. Each node of this subprocess is numbered for referencing.
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Figure 4–19 Line Flow - Generic, with Repricing at Fulfillment Workflow

The Line Flow - Generic, with Repricing at Fulfillment workflow begins at node 1 
with the Enter - Line subprocess. This subprocess verifies that the order is booked 
before proceeding with the remainder of the workflow.

In node 2, the process attempts to schedule the line for the order using the Schedule 
- Line subprocess. The Create Supply - Line subprocess is initiated in node 3. After 
supply is created for the line, the Ship - Line, Manual subprocess in node 4 initiates. 
In node 5, the Fulfill - Deferred activity moves fulfillment to the background engine. 
At node 7, the Reprice - Line is initiated. After the line is repriced, the process 
proceed to the Invoice Interface - Line subprocess at node 8. The process initiates 
the Close - Line subprocess at node 9. Once the line is successfully closed, the 
process ends at node 10.

Line Flow - Generic, with Repricing at Fulfillment Activities
The following table provides descriptions of each activity in the Line Flow - 
Generic, with Repricing at Fulfillment process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.
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Line Flow - Return for Credit Only
The Line Flow - Return for Credit Only process is a workflow process is used for 
return orders submitted in Oracle Order Management that do not require receipt or 
approval. This is an order line process. When your customer returns partial quantity 
of an order, Oracle Order Management splits the return line so that customers can 
be issued credit for what was returned.

When you save a return order line in Oracle Order Management, the Line Flow - 
Return for Credit Only process verifies that the return is booked before proceeding. 
Once booking is verified, the process continues with invoicing and closing. These 
activities are performed in the following workflow subprocesses contained in Line 
Flow - Return for Credit Only:

■ Enter - Line

■ Invoice Interface - Line, Deferred

■ Close - Line

Line Flow - Return for Credit Only ends after the line is successfully closed.

The Line Flow - Return for Credit Only process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

Summary of the Line Flow - Return for Credit Only Process
To view the properties of the Line Flow - Return for Credit Only process, select the 
process in the navigator tree and then select Properties from the Edit menu. This 
process is runnable, which indicates that it can be assigned to a transaction type. 
The Details property page of the process activity indicates that the Line Flow - 
Return for Credit Only process has an error item type of WFERROR. This item type 
is associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process and 
prompt the administrator to retry the process in error. This error process is initiated 
only when an unexpected error with Oracle Workflow is encountered in the process.

Table 4–18 Line Flow - Generic, with Repricing at Fulfillment Activities

Activity Function Result Type Required

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes
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When you display the Process window for the Line Flow - Return for Credit Only, 
you see that the process consists of 1 unique activity and 3 subprocesses, which 
comprise the 4 nodes that appear in the workflow diagram. The following diagram 
depicts the Line Flow - Return for Credit Only process. Each node of this subprocess 
is numbered for referencing.

Figure 4–20 Line Flow - Return for Credit Only Workflow

The Line Flow - Return for Credit Only workflow begins at node 1 with the Enter - 
Line subprocess. This subprocess verifies that the order is booked before proceeding 
with the remainder of the workflow.

At node 2 the process uses the Invoice Interface - Line, Deferred subprocess to 
generate the credit invoice. The process initiates the Close - Line subprocess at node 
3. After the line is successfully closed, the process ends at node 4.

Line Flow - Return for Credit Only Activities
The following table provides a description for the End activity in the Line Flow - 
Return for Credit Only process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Table 4–19 Line Flow - Return for Credit Only Activities

Activity Function Result Type Required

End WF_STANDARD.NOOP None Yes
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Line Flow - Return for Credit Only with Approval
The Line Flow - Return for Credit Only with Approval process is a workflow 
process is used for return orders submitted in Oracle Order Management that 
requires approval. This is an order line process. When your customer returns partial 
quantity of an order, Oracle Order Management splits the return line so that 
customers can be issued credit for what was returned.

The Line Flow - Return for Credit Only with Approval process contains several 
subprocesses to ensure that the return is properly entered, approved, invoiced, and 
closed.

Line Flow - Return for Credit Only with Approval contains all of the subprocess 
and activities contained in the Return for Credit Only workflow process, as well as 
the Wait for Approval block activity.

When you save a return order line in Oracle Order Management, the Line Flow - 
Return for Credit Only with Approval process verifies that the return is booked 
before proceeding. The process then verifies that the return is approved before 
proceeding with the return. Once booking and approval are verified, the process 
continues with invoicing and closing. These activities are performed in the 
following workflow subprocesses contained in Line Flow - Return for Credit Only 
with Approval:

■ Enter - Line

■ Invoice Interface - Line, Deferred

■ Close - Line

Line Flow - Return for Credit Only with Approval ends after the line is successfully 
closed.

The Line Flow - Return for Credit Only with Approval process is contained in 
the Seeded Data File oexwford.wft and is associated with the OM Order Line item 
type.

Note: The Line Flow - Return for Credit Only with Approval 
process is identical to the Line Flow - Return for Credit Only 
process except that it includes the Wait for Approval activity.
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Summary of the Line Flow - Return for Credit Only with Approval Process
To view the properties of the Line Flow - Return for Credit Only with Approval 
process, select the process in the navigator tree and then select Properties from the 
Edit menu. This process is runnable, which indicates that it can be assigned to a 
transaction type.

The Details property page of the process activity indicates that the Line Flow - 
Return for Credit Only with Approval process has an error item type of WFERROR. 
This item type is associated with the RETRY_ONLY error process. The purpose of 
this error handling process is to alert an administrator when an error occurs in a 
process and prompt the administrator to retry the process in error. This error 
process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

When you display the Process window for the Line Flow - Return for Credit Only 
with Approval, you see that the process consists of 2 unique activity and 3 
subprocesses, which comprise the 5 nodes that appear in the workflow diagram. 
The following diagram depicts the Line Flow - Return for Credit Only with 
Approval process. Each node of this process is numbered for referencing.

Figure 4–21  Line Flow - Return for Credit Only with Approval Workflow

The Line Flow - Return for Credit Only with Approval workflow begins at node 1 
with the Enter - Line subprocess. This subprocess verifies that the order is booked 
before proceeding with the remainder of the workflow.

At node 2 the process encounters a block activity that requires the return order line 
to obtain approval before proceeding with the workflow. Once approval is obtained, 
the workflow proceeds to the Invoice Interface - Line, Deferred subprocess at node 3 
to generate the credit invoice. The process initiates the Close - Line subprocess at 
node 4. After the line is successfully closed, the process ends at node 5.
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Line Flow - Return for Credit Only with Approval Activities
The following table provides a description for the activities in the Line Flow - 
Return for Credit Only with Approval process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Line Flow - Return for Credit with Receipt
The Line Flow - Return for Credit with Receipt process is a workflow process used 
for returns that require inspection before credit is given. This is an order line 
process. When your customer returns partial quantity of an order, Oracle Order 
Management splits the return line so that customers can be issued credit for what 
was returned.

The Line Flow - Return for Credit with Receipt process contains several 
subprocesses to ensure that the return is properly entered, approved, inspected, 
fulfilled, invoiced, and closed.

Line Flow - Return for Credit with Approval contains all of the subprocess and 
activities contained in the Return for Credit workflow process, as well as the Return 
Receiving - Line subprocess and two fulfillment activities.

When you save a return order line in Oracle Order Management, the Line Flow - 
Return for Credit with Receipt process verifies that the return is booked before 
proceeding. Once booking is verified, the process continues with receiving, 
invoicing and closing. These activities are performed in the following workflow 
subprocesses contained in Line Flow - Return for Credit with Receipt:

■ Enter - Line

■ Return Receiving - Line

■ Invoice Interface - Line, Deferred

■ Close - Line

Line Flow - Return for Credit with Receipt ends after the line is successfully 
closed.

Table 4–20 Line Flow - Return for Credit Only with Approval Activities

Activity Function Result Type Required

Wait for Approval WF_STANDARD.WAITFORFLOW None Yes

End WF_STANDARD.NOOP None Yes
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The Line Flow - Return for Credit with Receipt process is contained in the Seeded 
Data File oexwford.wft and is associated with the OM Order Line item type.

Summary of the Line Flow - Return for Credit with Receipt Process
To view the properties of the Line Flow - Return for Credit with Receipt process, 
select the process in the navigator tree and then select Properties from the Edit 
menu. This process is runnable, which indicates that it can be assigned to a 
transaction type.

The Details property page of the process activity indicates that the Line Flow - 
Return for Credit with Receipt process has an error item type of WFERROR. This 
item type is associated with the RETRY_ONLY error process. The purpose of this 
error handling process is to alert an administrator when an error occurs in a process 
and prompt the administrator to retry the process in error. This error process is 
initiated only when an unexpected error with Oracle Workflow is encountered in 
the process.

When you display the Process window for the Line Flow - Return for Credit with 
Receipt, you see that the process consists of 3 unique activity and 4 subprocesses, 
which comprise the 7 nodes that appear in the workflow diagram. The following 
diagram depicts the Line Flow - Return for Credit with Receipt process. Each node 
of this process is numbered for referencing.

Figure 4–22 Line Flow - Return for Credit with Receipt Workflow

The Line Flow - Return for Credit with Receipt workflow begins at node 1 with 
the Enter - Line subprocess. This subprocess verifies that the order is booked before 
proceeding with the remainder of the workflow.

At node 2 the Return Receiving - Line subprocess waits for inspection of the 
returned items before proceeding to the order fulfillment activities in nodes 3 and 4. 
The workflow proceeds to the Invoice Interface - Line, Deferred subprocess at node 
Seeded Workflow Definitions 4-51



OM Order Line Processes
5 to generate the credit invoice. The Close - Line subprocess initiates at node 6. After 
the line is successfully closed, the process ends at node 7.

Line Flow - Return for Credit with Receipt Activities
The following table provides a description for the activities in the Line Flow - 
Return for Credit with Receipt process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Line Flow - Return for Credit with Receipt and Approval
The Line Flow - Return for Credit with Receipt and Approval process is a workflow 
process used for returns that require inspection and approval before credit is given. 
This is an order line process. When your customer returns partial quantity of an 
order, Oracle Order Management splits the return line so that customers can be 
issued credit for what was returned.

The Line Flow - Return for Credit with Receipt process contains several 
subprocesses to ensure that the return is properly entered, approved, inspected, 
fulfilled, invoiced, and closed.

When you save a return order line in Oracle Order Management, the Line Flow - 
Return for Credit with Receipt and Approval process verifies that the return is 
booked before proceeding. Once booking is verified, the process continues with 
receiving, invoicing and closing. These activities are performed in the following 

Table 4–21 Line Flow - Return for Credit with Receipt Activities

Activity Function Result Type Required

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes

Note: The Line Flow - Return for Credit with Receipt and 
Approval process is identical to the Line Flow - Return for Credit 
with Receipt process except that it includes the Wait for Approval 
activity.
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workflow subprocesses contained in Line Flow - Return for Credit with Receipt and 
Approval:

■ Enter - Line

■ Return Receiving - Line

■ Invoice Interface - Line, Deferred

■ Close - Line

Line Flow - Return for Credit with Receipt and Approval ends after the line is 
successfully closed.

The Line Flow - Return for Credit with Receipt and Approval process is contained 
in the Seeded Data File oexwford.wft and is associated with the OM Order Line 
item type.

Summary of the Line Flow - Return for Credit with Receipt and Approval Process 
To view the properties of the Line Flow - Return for Credit with Receipt and 
Approval process, select the process in the navigator tree and then select Properties 
from the Edit menu. This process is runnable, which indicates that it can be 
assigned to a transaction type.

The Details property page of the process activity indicates that the Line Flow - 
Return for Credit with Receipt and Approval process has an error item type of 
WFERROR. This item type is associated with the RETRY_ONLY error process. The 
purpose of this error handling process is to alert an administrator when an error 
occurs in a process and prompt the administrator to retry the process in error. This 
error process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

When you display the Process window for the Line Flow - Return for Credit with 
Receipt and Approval, you see that the process consists of 4 unique activities and 4 
subprocesses, which comprise the 8 nodes that appear in the workflow diagram. 
The following diagram depicts the Line Flow - Return for Credit with Receipt and 
Approval process. Each node of this process is numbered for referencing.
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Figure 4–23 Line Flow - Return for Credit with Receipt and Approval Workflow

The Line Flow - Return for Credit with Receipt and Approval workflow begins at 
node 1 with the Enter - Line subprocess. This subprocess verifies that the order is 
booked before proceeding with the remainder of the workflow.

At node 2 the process encounters a block activity that requires the return order line 
to obtain approval before proceeding with the workflow. From this activity the 
process must be manually progressed before the workflow can proceed to node 3. 
At node 3, the Return Receiving - Line subprocess waits for inspection of the 
returned items before proceeding to the order fulfillment activities in nodes 4 and 5. 
The workflow proceeds to the Invoice Interface - Line, Deferred subprocess at node

6 to generate the credit invoice. The Close - Line subprocess initiates at node 6. After 
the line is successfully closed, the process to the End activity at node 8.

Line Flow - Return for Credit with Receipt and Approval Activities
The following table provides a description for the activities in the Line Flow - 
Return for Credit with Receipt and Approval process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Table 4–22 Line Flow - Return for Credit with Receipt and Approval Activities

Activity Function Result Type Required

Wait for Approval WF_STANDARD.WAITFORFLOW None Yes

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes
4-54 Using Oracle Workflow in Oracle Order Management



OM Order Line Processes
Line Flow - Standard Service
The Line Flow - Standard Service workflow process is initiated when a sales order 
with service lines is submitted in Oracle Order Management. This type of line flow 
is used for service items that are purchased with other merchandise, such as a 
warranty.

The process contains several subprocesses to verify that the return is properly 
entered, fulfilled, invoiced, and closed.

When you save a return order line in Oracle Order Management, the Line Flow - 
Standard Service process verifies that the return is booked before proceeding. Once 
booking is verified, the process continues with invoicing and closing. These 
activities are performed in the following workflow subprocesses contained in Line 
Flow - Standard Service:

■ Enter - Line

■ Invoice Interface - Line

■ Close - Line

Line Flow - Standard Service ends after the line is successfully closed.

The Line Flow - Standard Service process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

Summary of the Line Flow - Standard Service Process
To view the properties of the Line Flow - Standard Service process, select the 
process in the navigator tree and then select Properties from the Edit menu. This 
process is runnable, which indicates that it can be assigned to a transaction type. 
The Details property page of the process activity indicates that the Line Flow - 
Standard Service process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error handling 
process is to alert an administrator when an error occurs in a process and prompt 
the administrator to retry the process in error. This error process is initiated only 
when an unexpected error with Oracle Workflow is encountered in the process. 
When you display the Process window for the Line Flow - Standard Service, you 
see that the process consists of 3 unique activities and 3 subprocesses, which 
comprise the 6 nodes that appear in the workflow diagram. The following diagram 
depicts the Line Flow - Standard Service process. Each node of this process is 
numbered for referencing.
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Figure 4–24 Line Flow - Standard Service Workflow

The Line Flow - Standard Service workflow begins at node 1 with the Enter - Line 
subprocess. This subprocess verifies that the order is booked before proceeding with 
the remainder of the workflow.

At node 2 the process uses the Fulfill - Deferred to move the process to the 
background engine. After the Fulfill activity at node 3 complete, the line enters the 
Invoice Interface - Line subprocess at node 4 to process an invoice. The process 
initiates the Close - Line subprocess at node 5. After the line is successfully closed, 
the process proceeds to the End activity at node 6.

Line Flow - Standard Service Activities
The following table provides a description for the activities in the Line Flow - 
Standard Service process.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

 

OM Negotiation Header Processes
The following section discusses the workflows associated with the OM Negotiation 
Header item type:

Table 4–23 Line Flow - Standard Service Activities

Activity Function Result Type Required

Fulfill - Deferred WF_STANDARD.DEFER None Yes

Fulfill OE_FULFILL_WF.START_
FULFILLMENT

None Yes

End WF_STANDARD.NOOP None Yes
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Negotiation Flow - Generic
The Negotiation Flow - Generic process can be assigned to both Sales Orders 
and Blanket Sales Agreements. A Sales Order that starts with the negotiation 
phase is considered a Quote until it transitions to the Fulfillment phase where it 
becomes a firm order, or Sales Order in Oracle Order Management. Blanket 
Sales Agreements maintain their same name during both the Negotiation and 
Fulfillment phases.

Negotiation Flow - Generic is initiated if it is assigned to the transaction type. 
Transaction types determine which processes are attached to a Sales Order and 
Blanket Sales Agreements. For more information on defining transaction types, 
refer to the Oracle Order Management Implementation Guide.

Negotiation Flow - Generic is associated with the following OM Negotiation 
Header subprocesses:

■ Offer Expiration - Negotiation Process

■ Submit Draft - Negotiation

■ Customer Acceptance - Negotiation Process

■ Complete - Negotiation

Negotiation Flow - Generic is contained in the Seeded Data File oexwford.wft 
and is associated with the OM Negotiation Header item type.

Summary of the Negotiation Flow - Generic Process
To view the properties of the Negotiation Flow - Generic process, select the 
process in the navigator tree and then select Properties from the Edit menu. This 
process is runnable, which indicates that it can be assigned to a transaction type. 
The Details property page of the process activity indicates that the Negotiation 
Flow - Generic process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process 
and prompt the administrator to retry the process in error. This error process is 
initiated only when an unexpected error with Oracle Workflow is encountered 
in the process.

The Process window displays the activities and subprocesses of the Negotiation 
Flow - Generic process, which comprise the nodes that appear in the workflow 
diagram. The following diagram depicts the Negotiation Flow - Generic process.
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Figure 4–25 Negotiation Flow - Generic Workflow

Negotiation Flow - Generic Activities
The following table provides descriptions of each activity in the Negotiation 
Flow - Generic Process.

For more information about individual function activities, see Seeded Function 
Activity Definitions.

Negotiation Flow - Generic with Approval
The Negotiation Flow - Generic with Approval process can be assigned to both 
Sales Orders and Blanket Sales Agreements. A Sales Order that starts with the 
negotiation phase is considered a Quote until it transitions to the Fulfillment 
phase where it becomes a firm order, or Sales Order in Oracle Order 
Management. Blanket Sales Agreements maintain their same name during both 
the Negotiation and Fulfillment phases.

Table 4–24 Negotiation Flow - Generic Activities

Activity Function Result Type Required

Start WF_STANDARD.NOOP None Yes

Negotiation Lost OE_NEGOTIATE_
WF.Update_Status_Lost

Null Yes

End WF_STANDARD.NOOP None Yes
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Negotiation Flow - Generic with Approval is initiated if it is assigned to the 
transaction type. Transaction types determine which processes are attached to a 
Sales Order and Blanket Sales Agreements. For more information on defining 
transaction types, refer to the Oracle Order Management Implementation Guide.

Negotiation Flow - Generic with Approval is associated with the following OM 
Negotiation Header subprocesses:

■ Submit Draft - Negotiation

■ Complete - Negotiation

■ Internal Approval - Negotiation

■ Customer Acceptance - Negotiation

■ Offer Expiration - Negotiation

Negotiation Flow - Generic with Approval is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Negotiation Header item type.

Summary of the Negotiation Flow with Approval Process
To view the properties of the Negotiation Flow - Generic with Approval process, 
select the process in the navigator tree and then select Properties from the Edit 
menu. This process is runnable, which indicates that it can be assigned to a 
transaction type. The Details property page of the process activity indicates that 
the Negotiation Flow - Generic with Approval process has an error item type of 
WFERROR. This item type is associated with the RETRY_ONLY error process. 
The purpose of this error handling process is to alert an administrator when an 
error occurs in a process and prompt the administrator to retry the process in 
error. This error process is initiated only when an unexpected error with Oracle 
Workflow is encountered in the process.

The Process window displays the activities and subprocesses of the Negotiation 
Flow - Generic with Approval process, which comprise the nodes that appear in 
the workflow diagram. The following diagram depicts the Negotiation Flow - 
Generic with Approval process.
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Figure 4–26 Negotiation Flow - Generic with Approval Workflow

Negotiation Flow - Generic with Approval Activities
The following table provides descriptions of each activity in the Negotiation 
Flow - Generic with Approval Process.

For more information about individual function activities, see Seeded Function 
Activity Definitions.

OM Blanket Header Processes
The following section discusses the workflows associated with the OM Blanket 
Header item type.

Table 4–25 Negotiation Flow - Generic with Approval Activities

Activity Function Result Type Required

Start WF_STANDARD.NOOP None Yes

Negotiation Lost OE_NEGOTIATE_
WF.Update_Status_Lost

Null Yes

End WF_STANDARD.NOOP None Yes
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Blanket Flow - Generic
The Blanket Flow - Generic workflow process is used for the Fulfillment phase 
of Blanket Sales Agreements in Oracle Order Management.

Blanket Flow - Generic is initiated if it is assigned to the transaction type for the 
Blanket Sales Agreement. Transaction types determine which processes are 
attached to a Blanket Sales Agreement. For more information on defining 
transaction types, refer to the Oracle Order Management Implementation Guide.

Blanket Flow - Generic is associated with the following OM Blanket Header 
subprocesses:

■ Enter—Blanket

■ Execute Blanket

■ Terminate—Blanket

■ Close - Blanket

Blanket Flow - Generic is contained in the Seeded Data File oexford.wft and is 
associated with the OM Blanket Header item type.

For Blanket Sales Agreements, the Fulfillment flow will start either after the 
Negotiation Flow has completed or, in the case where the Blanket Sales 
Agreement does not have a Negotiation Flow, it will start when you save the 
Blanket Sales Agreement.

Summary of the Blanket Flow - Generic Process
To view the properties of the Blanket Flow - Generic process, select the process 
in the navigator tree and then select Properties from the Edit menu. This process 
is runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the Blanket Flow 
- Generic process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process 
and prompt the administrator to retry the process in error. This error process is 
initiated only when an unexpected error with Oracle Workflow is encountered 
in the process.

The Process window displays the activities and subprocesses of the Blanket 
Flow - Generic process, which comprise the nodes that appear in the workflow 
diagram. The following diagram depicts the Blanket Flow - Generic process.
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Figure 4–27 Blanket Flow - Generic
4-62 Using Oracle Workflow in Oracle Order Management



Seeded Subprocess Defin
5

Seeded Subprocess Definitions

Topics covered in this chapter include the following:

■ OM Order Header Subprocesses on page 5-2

■ OM Order Line Subprocesses on page 5-13

■ Create Supply - Line on page 5-30

■ Negotiation Subprocesses on page 5-79

■ Blanket Sales Agreement Subprocesses on page 5-90
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OM Order Header Subprocesses

Approve Return - Order
The Approve Return - Order subprocess runs a sequence of activities that approve 
the return of a sales order. Approve Return - Order is a non-runnable flow and is 
initiated as a subprocess of the following order flow:

■ Order Flow - Return with Approval

Approve Return - Order subprocess initiates as part of the Order Flow - Return 
with Approval process. When sales order return is submitted, this subprocess 
sends a notification to verify authorization for that order return. This subprocess 
can end with the following results:

■ Complete

■ Incomplete

If the return is not authorized, the process ends with an incomplete result and 
returns to the order flow. If the return is authorized, the subprocess ends and 
returns to the order flow.

Approve Return - Order is contained in the Seeded Data File oexwford.wft and 
is associated with the OM Order Header item type.

Summary of the Approve Return - Order Subprocess
To view the properties of the Approve Return - Order subprocess, select the process 
in the navigator tree and then select Properties from the Edit menu. This process is 
not runnable, which means that it cannot be assigned to a transaction type; it is a 
subprocess of a runnable flow.

The Details property page of the process activity indicates that Approve Return - 
Order has an error item type of WFERROR. This item type is associated with the 
RETRY_ONLY error process. The purpose of this error handling process is to alert 
an administrator when an error occurs in a process and prompt the administrator to 
retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Approve Return - Order, you see that 
the process consists of 7 unique activities, which comprise the 7 activity nodes that 
appear in the workflow diagram. The following diagram depicts the Approve 
Return - Order subprocess. Each node of this subprocess is numbered for 
referencing.
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Figure 5–1 Approve Return - Order Workflow

The Approve Return - Order process begins when the following order flow is 
initiated:

■ Order Flow - Return with Approval

The workflow begins at node 1 with the Start activity.

The Utility - Set Notification Approver activity in node 2 determines to whom 
notification is sent. Once this is determined, the process sends the Approve 
Return Order notification in node 3. If the return is authorized the notification 
returns a pass result and process is approved at the Approve - Continue Line 
activity in node 4. The process then ends with a complete result and returns to 
the order flow.

If the return is not authorized the notification returns a failing result and the process 
proceeds to the Approvals block activity. The process then waits until the return 
is canceled before proceeding to the End (Incomplete) activity in node 7.

Approve Return - Order Activities
The tables in this section provide descriptions of each activity in the Approve 
Return - Order subprocess.

For more information about individual function activities, refer to Chapter 6, 
Seeded Function Activity Definitions.
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The following table displays the different function activities in the Approve Return - 
Order subprocess.

Book - Order, Deferred
Book - Order, Deferred enables you to move booking to the background engine. 
This can be used when you must enter many orders and cannot wait for each 
individual order to book before moving on. Book - Order, Deferred moves the 
booking process to the background engine.

When you use the Book - Order, Deferred subprocess, you do not need to 
specifically request for an order to book. The order will book when the Workflow 
Background Process concurrent program processes the activity.

The Book - Order, Deferred process ends only after an order is booked. After the 
order is booked, the subprocess ends and returns to the line flow.

Book - Order, Deferred is contained in the Seeded Data File oexwford.wft and is 
associated with the OM Order Header item type.

For more information on the Workflow Background Engine, refer to Chapter 2, 
Processing Orders Using Oracle Workflow.

Summary of the Book - Order, Deferred Subprocess
To view the properties of the Book - Order, Deferred subprocess, select the process 
in the navigator tree and then select Properties from the Edit menu. This process is 

Table 5–1 Approve Return - Order Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Utility - Set 
Notification 
Approver (node 2)

OE_ORDER_WF_UTIL.SET_
NOTIFICATION_APPROVER

None Yes

Approve - Continue 
Line (node 4)

WF_STANDARD.CONTINUEFLOW None Yes

End (Complete) (node 
5)

WF_STANDARD.NOOP None Yes

Approval Failed (node 6) WF_STANDARD.BLOCK None Yes

End (Incomplete) 
(node 7))

WF_STANDARD.NOOP None Yes
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not runnable, which means that it cannot be assigned to a transaction type; it is a 
subprocess of a runnable flow.

The Details property page of the process activity indicates that Book - Order, 
Deferred has an error item type of WFERROR. This item type is associated with the 
RETRY_ONLY error process. The purpose of this error handling process is to alert 
an administrator when an error occurs in a process and prompt the administrator to 
retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Book - Order, Deferred process, you 
see that the process consists of 4 unique activities, which comprise the 4 activity 
nodes that appear in the workflow diagram. The following diagram depicts the 
Book - Order, Deferred subprocess. Each node of this subprocess is numbered for 
referencing.

Figure 5–2 Book - Order Deferred Subprocess Workflow

The Book - Order, Deferred workflow begins at node 1 with the Book - Deferred 
activity.

At the Book activity in node 2 is a seeded lookup activity that can complete with 
a result of Incomplete, On Hold, Not Eligible, or Complete. A Complete or Not 
Eligible result leads to the Book - Continue Line (Complete) activity in node 3. 
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An On Hold or Incomplete result leads to Book - Eligible activity in node 4. After 
the eligibility is determined, the process moves back to the Book activity in node 
2. This process can only end after the order is booked.

Book - Order, Deferred Activities
The following table provides descriptions of each activity in the Book - Order, 
Deferred subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Table 5–2 Book - Order Deferred Subprocess Activities

Book - Order, Manual
Book - Order, Manual is a subprocess that enables you to book an order manually 
by using the Book - Eligible activity. Book - Order, Manual is a non-runnable flow 
that is initiated as a subprocess of the following line flows:

■ Order Flow - Generic

■ Order Flow - Generic with Header Level Invoice Interface

■ Order Flow - Return with Approval

The Book - Order, Manual process ends only after the order is booked. After the 
order is booked, the subprocess ends and returns to the line flow.

Book - Order, Manual is contained in the Seeded Data File oexwford.wft and is 
associated with the OM Order Header item type.

Activity Function Result Type Required

Book - Deferred (node 
1)

WF_STANDARD.DEFER None Yes

Book (node 2) OE_BOOK_WF.BOOK_ORDER OM Subprocess 
results, handles 
holds

Yes

Book - Continue Line 
(Complete) (node 3)

WF_
STANDARD.CONTINUEFLOW

None Yes

Book - Eligible (node 5) OE_STANDARD_
WF.STANDARD_BLOCK

None Yes
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Summary of the Book - Order, Manual Subprocess
To view the properties of the Book - Order Manual subprocess, select the process in 
the navigator tree and then select Properties from the Edit menu. This process is not 
runnable, which means that it cannot be assigned to a transaction type; it is a 
subprocess of a runnable flow.

The Details property page of the process activity indicates that Book - Order, 
Manual has an error item type of WFERROR. This item type is associated with the 
RETRY_ONLY error process. The purpose of this error handling process is to alert 
an administrator when an error occurs in a process and prompt the administrator to 
retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Book - Order, Manual process, you 
see that the process consists of 4 unique activities, which comprise the 4 activity 
nodes that appear in the workflow diagram. The following diagram depicts the 
Book - Order, Manual subprocess. Each node of this subprocess is numbered for 
referencing.

Figure 5–3 Book - Order Manual Subprocess Workflow

The Book - Order, Manual subprocess begins when the following line flows are 
initiated:

■ Order Flow - Generic

■ Order Flow - Generic with Header Level Invoice Interface

■ Order Flow - Return with Approval

The workflow begins at node 1 with the Start activity.
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At the Book - Eligible activity in node 2, the process waits for you to manually 
verify that the order is eligible for booking. When eligibility is determined, the 
process proceeds to the Book activity at node 3. After booking is complete, the 
processes ends and returns to its parent line flow.

Book - Order, Manual Activities
The following table provides descriptions of each activity in the Book - Order, 
Manual subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Close - Order
The Close - Order subprocess closes an order in Oracle Order Management. Close - 
Order is a non-runnable flow that is initiated as a subprocess of the following order 
flows:

■ Order Flow - Generic

■ Order Flow - Generic with Header Level Invoice Interface

■  Order Flow - Return with Approval

The Close - Order process can end with a result of not eligible or complete. After the 
order closes or is determined not eligible, the subprocess ends and returns to the 
order flow.

Close - Order is contained in the Seeded Data File oexwford.wft and is 
associated with the OM Order Header item type.

Table 5–3 Book - Order Manual Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.DEFER None Yes

Book - Eligible (node 
2)

OE_STANDARD_
WF.STANDARD_BLOCK

None Yes

Book (node 3) OE_BOOK_WF.BOOK_
ORDER

OM Subprocess Results, 
Handles Holds

Yes

Book - Continue Line 
(Complete) (node 4)

WF_STANDARD. 
CONTINUEFLOW

None Yes
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Summary of the Close - Order Subprocess
To view the properties of the Close - Order subprocess, select the process in the 
navigator tree and then select Properties from the Edit menu. This process is not 
runnable, which means that it cannot be assigned to a transaction type; it is a 
subprocess of a runnable flow.

The Details property page of the process activity indicates that Close - Order has an 
error item type of WFERROR. This item type is associated with the RETRY_ONLY 
error process. The purpose of this error handling process is to alert an administrator 
when an error occurs in a process and prompt the administrator to retry the process 
in error. This error process is initiated only when an unexpected error with Oracle 
Workflow is encountered in the process.

When you display the Process window for the Close - Order process, you see that 
the process consists of 6 unique activities, which comprise the 6 activity nodes that 
appear in the workflow diagram. The following diagram depicts the Close - Order 
subprocess. Each node of this subprocess is numbered for referencing.

Figure 5–4 Close - Order Subprocess Workflow
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The Close - Order process begins when the following order flows are initiated:

■ Order Flow - Generic

■ Order Flow - Generic with Header Level Invoice Interface

■ Order Flow - Return with Approval

The workflow begins at node 1 with the Wait activity.

At the Close - Wait for Line activity in node 2, the process determines whether 
the all of the order lines in the order are closed before proceeding with the Close 
activity at node 3. Once the order is successfully closed, the subprocess moves to 
the End (Complete) activity at node 4.

If the Close activity returns an On Hold or Incomplete result, the process moves 
to another Wait activity at node 6. If the Close activity returns not eligible result, 
the process moves to the End (Incomplete) activity at node 5.

Close - Order Activities
The following table provides descriptions of each activity in the Close - Order 
subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Header Level Invoice Interface - Order
The Header Level Invoice Interface - Order subprocess conducts a series of activities 
that interface with Oracle Receivable to determine invoicing information for an 

Table 5–4 Close - Order Subprocess Activities

Activity Function Result Type Required

Wait (node 1) WF_STANDARD.WAIT None Yes

Close - Wait for Line (node 
2)

WF_
STANDARD.WAITFORFLOW

None Yes

Close (node 3) WF_STANDARD.NOOP None Yes

End (Complete) (node 4) WF_STANDARD.NOOP None Yes

End (Not Eligible) (node 5) WF_STANDARD.NOOP None Yes

Wait (node 6) WF_STANDARD.WAIT None Yes
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order. Header Level Invoice Interface - Order is a non-runnable flow that is initiated 
as a subprocess of the following order flow:

■ Order Flow - Generic with Header Level Invoice Interface

Header Level Invoice Interface - Order can be used only with Order Flow - 
Generic with Header Level Invoice Interface.

The Header Level Invoice Interface - Order process ends only after header level 
invoice information for an order is determined. After this information is received, 
the subprocess ends and returns to the line flow.

Header Level Invoice Interface - Order is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Header item type.

Summary of the Header Level Invoice Interface - Order Subprocess
To view the properties of the Header Level Invoice Interface - Order subprocess, 
select the process in the navigator tree and then select Properties from the Edit 
menu. This process is not runnable, which means that it cannot be assigned to a 
transaction type; it is a subprocess of a runnable flow.

The Details property page of the process activity indicates that Header Level 
Invoice Interface - Order has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error handling 
process is to alert an administrator when an error occurs in a process and prompt 
the administrator to retry the process in error. This error process is initiated only 
when an unexpected error with Oracle Workflow is encountered in the process. 
When you display the Process window for the Header Level Invoice Interface - 
Order process, you see that the process consists of 5 unique activities, which 
comprise the 5 activity nodes that appear in the workflow diagram. The following 
diagram depicts the Header Level Invoice Interface - Order subprocess. Each node 
of this subprocess is numbered for referencing.
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Figure 5–5 Header Level Invoice Interface - Order Subprocess Workflow

The Header Level Invoice Interface - Order process begins as a subprocess of the 
following process:

■ Order Flow - Generic with Header Level Invoice Interface

The workflow begins at node 1 with the Start activity.

At the Fulfill - Wait for Line activity in node 2, the process waits for all of the 
order lines to fulfill before proceeding with the order flow. The process then 
moves to the Invoice Interface - Header Level activity at node 3. After Oracle 
Order Management interfaces with Oracle Receivables for the order the process 
moves to Invoice Interface - Continue Line and returns to its parent order flow.

Header Level Invoice Interface - Order Activities
The following table provides descriptions of each activity in the Header Level 
Invoice Interface subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Table 5–5 Header Level Invoice Interface - Order Subprocess Activities

Activity Function Result Type Required

Start (Node 1) WF_STANDARD.NOOP None Yes
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OM Order Line Subprocesses

Authorized to Ship - Line
The Authorized to Ship is a subprocess specific to Oracle Release Management 
users. Authorize to Ship - Line verifies that a line is eligible for shipping. 
Authorized to Ship - Line is a non-runnable flow that is initiated as a subprocess of 
the following process:

■ Line Flow - Generic with Authorize to Ship (RLM)

This subprocess verifies that an item is approved for shipping. If the item is not 
authorized for shipping, a hold is placed on the item. This subprocess will hold a 
line until it is authorized to ship.

The Authorize to Ship - Line process ends only when authorization to ship is 
granted. After the line is authorized, the subprocess ends and returns to the line 
flow.

Authorize to Ship - Line is contained in the Seeded Data File oexwford.wft and 
is associated with the OM Order Line item type.

Summary of the Authorized to Ship - Line Subprocess
To view the properties of the Authorize to Ship - Line subprocess, select the process 
in the navigator tree and then select Properties from the Edit menu. This process is 
not runnable, which means that it cannot be assigned to a transaction type; it is a 
subprocess of a runnable flow.

Fulfill - Wait for Line 
(Node 2)

OE_RLM_WF.CHECK_
AUTHORIZE_TO_SHIP

Yes/No Yes

Invoice Interface - 
Header Level (Node 3)

WF_STANDARD.NOOP None Yes

Invoice Interface - 
Continue Line (Node 
4)

WF_STANDARD.BLOCK None No

Header Invoice 
Interface - Eligible 
(Node 4)

WF_STANDARD.BLOCK None No

Table 5–5 Header Level Invoice Interface - Order Subprocess Activities

Activity Function Result Type Required
Seeded Subprocess Definitions 5-13



OM Order Line Subprocesses
The Details property page of the process activity indicates that Authorize to Ship - 
Line has an error item type of WFERROR. This item type is associated with the 
RETRY_ONLY error process. The purpose of this error handling process is to alert 
an administrator when an error occurs in a process and prompt the administrator to 
retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Authorize to Ship - Line process, you 
see that the process consists of 4 unique activities, which comprise the 4 activity 
nodes that appear in the workflow diagram. The following diagram depicts the 
Authorized to Ship - Line subprocess. Each node of this subprocess is numbered for 
referencing.

Figure 5–6 Authorized to Ship - Line Subprocess Workflow

The Authorize to Ship - Line process begins when either of the following line flows 
are initiated:

■ Line Flow - Configuration with Authorize to Ship (RLM)

■ Line Flow - Generic with Authorize to Ship (RLM)

The workflow begins at node 1 with the Start activity.

At the Authorize to Ship - Check Status activity in node 2, the process attempts 
to verify whether the order line is authorized to ship. If the order line is 
authorized to ship (a Yes result), then the subprocess completes and returns to 
the line flow. If the order line is not authorized to ship, then the process waits 
until authorization is granted before proceeding.
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Authorized to Ship - Line Activities
The following table provides descriptions of each activity in the Authorize to Ship - 
Line subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Buy ATO Item Flow
Buy ATO Item Flow is a subprocess of the Create ATO Supply workflow. Order 
lines follow this subprocess when the ATO item on the line has the Buy planning 
attribute on the organization item master, or when the buy type sourcing rules are 
assigned to it in the shipping warehouse. For these lines, the Buy ATO Item Flow 
transfers a record to the requisition interface tables for this order line. Once the data 
is placed in the requisition interface tables, this workflow subprocess ends and 
returns to its parent flow.

Buy ATO Item Flow is contained in the Seeded Data File oexwford.wft and is 
associated with the OM Order Line item type.

Summary of the Buy ATO Item Flow Subprocess
To view the properties of the Buy ATO Item Flow subprocess, select the process in 
the navigator tree and then select Properties from the Edit menu. This process is 
runnable, which means that it can be assigned to a transaction type.

The Details property page of the process activity indicates that Buy ATO Item Flow 
has an error item type of WFERROR. This item type is associated with the RETRY_ 
ONLY error process. The purpose of this error handling process is to alert an 
administrator when an error occurs in a process and prompt the administrator to 

Table 5–6 Authorize to Ship Line Subprocess Activities

Activity Function Result Type Required

Start (Node 1) WF_STANDARD.NOOP None Yes

Authorize to Ship - 
Check Status (Node 2)

OE_RLM_WF.CHECK_
AUTHORIZE_TO_SHIP

Yes/No Yes

End (Node 3) WF_STANDARD.NOOP None Yes

Authorize to Ship - Wait 
for Authorization (Node 
4)

WF_STANDARD.BLOCK None No
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retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Buy ATO Item Flow process, you see 
that the process consists of 4 unique activities, which comprise the 4 activity nodes 
that appear in the workflow diagram. The following diagram depicts the Buy ATO 
Item Flow subprocess. Each node of this subprocess is numbered for referencing.

Figure 5–7 Buy ATO Item Flow Subprocess Workflow

The Buy ATO Item Flow begins at node 1 with the Start activity.

At node 2, the AutoCreate PO Req activity transfers its record to the requisition 
interface tables for the order line. Upon successful completion of this activity, 
the process moves to the End (Complete) activity at node 3.

Buy ATO Item Flow Activities
The following table provides descriptions of each activity in the Buy ATO Item Flow 
subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.
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Calculate Lead Time - Line
The Calculate Lead Time subprocess is specific to Oracle Configure to Order users. 
This process is a non-runnable flow initiated as a subprocess of the following line 
flow:

■ Create Manufacturing Configuration Data - Line, Manual

The Calculate Lead Time subprocess is initiated after Create Configuration - 
Line, Manual completes. Calculate Lead Time is initiated to determine the actual 
lead time of the configuration item in the organization in which it will be 
manufactured. The process updates the lead time attributes on the item master 
for the configuration item that organization.

If the configuration item has routing associated with it, the Calculate Lead Time 
subprocess ends when calculation is complete. If the configuration item does not 
have routing, this process ends without performing the calculation

Calculate Lead Time - Line is contained in the Seeded Data File oexwford.wft 
and is associated with the OM Order Line item type.

Summary of the Calculate Lead Time - Line Subprocess
To view the properties of the Calculate Lead Time - Line subprocess, select the 
process in the navigator tree, then select Properties from the Edit menu. This 
process is not runnable, which means that it cannot be assigned to a transaction 
type; it is a subprocess of a runnable flow.

The Details property page of the process activity indicates that Calculate Lead Time

- Line has an error item type of WFERROR. This item type is associated with the 
RETRY_ONLY error process. The purpose of this error handling process is to alert 

Table 5–7 Buy ATO Item Subprocess Activities

Activity Function Result Type Required

Start (Node 1) WF_STANDARD.NOOP None Yes

AutoCreate PO Req 
(Node 2)

CTO_WORKFLOW_API_PK.AUTO_
CREATE_PUR_REQ

Config 
Process 
Results

Yes

End (Complete) (Node 
3)

WF_STANDARD.NOOP None Yes

End (Incomplete) (Node 
4)

WF_STANDARD.NOOP None Yes
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an administrator when an error occurs in a process and prompt the administrator to 
retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Calculate Lead Time - Line 
subprocess, you see that the process consists of 4 unique activities which comprise 
the nodes in the workflow diagram. 

The following image depicts the workflow diagram for the Calculate Lead Time - 
Line subprocess. Each node of this subprocess is numbered for referencing. The 
numbers themselves are not part of the process diagram.

Figure 5–8 Calculate Lead Time - Line Subprocess Workflow

Calculate Lead Time - Line begins as a subprocess of the following line flow:

■ Create Manufacturing Configuration Data - Line, Manual

The workflow begins at node 1 with the Start activity.

At the Calculate Lead Time - Setup Parameters activity in node 2, the process 
sets the line number as the parameter of the concurrent program for lead time 
calculation and then moves to the Calculate Lead Time activity in node 3, where 
lead time is calculated. The process then moves to the End activity at node 4, and 
returns to its parent line flow. If at the Calculate Lead Time - Setup Parameters 
activity no routing is found, lead time is not calculated and the process proceeds 
directly to the End activity at node 4.
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Calculate Lead Time - Line Process Activities
The following table provides descriptions of each activity in the Calculate Lead 
Time - Line subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Close - Line
The Close - Line process closes a line in a line flow and is mandatory for all line 
level processes. Close - Line is a non-runnable subprocess initiated at the end of the 
following line flows:

■ Line Flow - ATO Item

■ Line Flow - ATO Model

■ Line Flow - Configuration

■ Line Flow - Configuration with Authorize to Ship (RLM)

■ Line Flow - Generic

■ Line Flow - Generic with Authorize to Ship (RLM)

■ Line Flow - Generic with Header Level Invoice Interface

■ Line Flow - Generic, With Export Compliance

■ Line Flow - Generic, Bill Only

■ Line Flow - Generic, Bill Only with Inventory Interface

■ Line Flow - Generic, Ship Only

■ Line Flow - Generic, with Repricing at Fulfillment

Table 5–8 Calculate Lead Time - Line Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Calculate Lead Time - Setup 
Parameters (node 2)

CTO_WORKFLOW.SET_
PARAMETER_LEAD_TIME_
WF_ML

Lead Time 
Result

Yes

Calculate Lead Time (node 
3)

CTO_WORKFLOW.SUBMIT_
AND_CONTINUE_WF

None No

End (node 4) WF_STANDARD.NOOP None Yes
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■ Line Flow - Return for Credit Only

■ Line Flow - Return for Credit Only with Approval

■ Line Flow - Return for Credit with Receipt

■ Line Flow - Return for Credit with Receipt and Approval

■ Line Flow - Standard Service

Each time an order line is saved, a workflow process is initiated. After the workflow 
runs through its functions, activities and subprocesses, it concludes with the Close - 
Line subprocess.

An order line is eligible to close when it completes all of the line-level activities 
within the workflow process. Order lines can close independent of each other. Once 
an order line is closed, no changes can be made to any fields except the descriptive 
flexfield, for which you can define processing constraints.

The Close - Line subprocess is contained in the Seeded Data File oexwford.wft 
and is associated with the OM Order Line item type.

Summary of the Close - Line Subprocess
To view the properties of the Close - Line subprocess, select the process in the 
navigator tree, then select Properties from the Edit menu. This process is not 
runnable, which means that it cannot be assigned to a transaction type; it is a 
subprocess of a runnable flow.

The Details property page of the process activity indicates that Close - Line has an 
error item type of WFERROR. This item type is associated with the RETRY_ONLY 
error process. The purpose of this error handling process is to alert an administrator 
when an error occurs in a process and prompt the administrator to retry the process 
in error. This error process is initiated only when an unexpected error with Oracle 
Workflow is encountered in the process.

When you display the Process window for the Close - Line process, you see that the 
process consists of 4 unique activities which comprise the activity nodes that appear 
in the workflow diagram. 

The following image depicts the workflow diagram for the Close - Line subprocess. 
Each node of this subprocess is numbered for referencing. The numbers themselves 
are not part of the process diagram.
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Figure 5–9 Close - Line Subprocess Workflow

The Close - Line workflow begins at the end of runnable line flow. The workflow 
ends only when the order line is determined complete or not eligible.

The workflow begins at node 1 with the Start activity.

In the Close activity at node 2, the process attempts to close the line. This activity 
has four possible results:

■ Complete

■ Not Eligible

■ Incomplete

■ On Hold

If, after attempting to close, a result of Incomplete or On Hold is returned, the 
process conducts the Wait activity at node 4, which waits until the line is 
complete or the hold is released. The Wait activity has a default waiting time of 1 
day. If the line is determined complete or not eligible, the line closes and 
proceeds to the Close - Continue Header activity at node 3, which signifies to the 
header level parent flow that the line is closed. The subprocess then ends and 
returns to its parent flow.

Close - Line Process Activities
The following table provides descriptions of each activity in the Close - Line 
subprocess.
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For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Create ATO Supply
Create ATO Supply is a workflow subprocess that automates the creation of 
assemble-to-order supply for an order line. This process is a subprocess of the 
following workflow:

■ Create Supply Order - Line, Manual

The Create ATO Supply subprocess determines the need for supply creation by 
branching according to supply type. The supply type is determined using the 
source type of the order line, the planning Make or Buy type, and the sourcing rules 
of the item. This subprocess evaluates the supply type to determine which branch to 
follow.

Create ATO Supply contains the following subprocesses:

■ Purchase Release - Line, Deferred - ATO

■ Create Work Order - Line

■ Buy ATO Item Flow

Create ATO Supply can end with an incomplete or complete result.

Create ATO Supply is contained in the Seeded Data File oexwford.wft and is 
associated with the OM Order Line item type.

Summary of the Create ATO Supply Process
To view the properties of the Create ATO Supply process, select the process in the 
navigator tree and then select Properties from the Edit menu. This process is not 
runnable, which means that it cannot be assigned to a transaction type; it is a 
subprocess of a runnable flow.

Table 5–9 Close - Line Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Close (node 2) OE_CLOSE_WF.CLOSE_LINE OM subprocess Results, 
handles Holds

Yes

End (node 3) WF_STANDARD.NOOP None Yes

Wait (node 4) WF_STANDARD.WAIT None Yes
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The Details property page of the process activity indicates that the Create ATO 
Supply process has an error item type of WFERROR. This item type is associated 
with the RETRY_ONLY error process. The purpose of this error handling process is 
to alert an administrator when an error occurs in a process and prompt the 
administrator to retry the process in error. This error process is initiated only when 
an unexpected error with Oracle Workflow is encountered in the process.

When you display the Process window for the Create ATO Supply, you see that the 
process consists of 5 unique activities and 3 subprocesses, which comprise the 8 
nodes that appear in the workflow diagram. The following diagram depicts the 
Create ATO Supply process. Each node of this process is numbered for referencing.
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Figure 5–10 Create ATO Supply Subprocess Workflow

The workflow begins at node 1 with the Start activity.

In the Check Supply Type activity at node 2, the process determines the supply 
type for the order line. This activity has five possible results:

■ Drop Ship

■ Buy

■ Work Order

■ Flow Schedule

■ Incomplete
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If the supply type is Drop Ship, the process initiates the Purchase Release - Line, 
Deferred - ATO subprocess at node 5. Once this completes, the process resumes 
and proceeds to the End (Complete) activity at node 4.

If the supply type is Buy, the process initiates the Buy ATO Item Flow 
subprocess at node 6. Once this completes, the process resumes and proceeds to 
the End (Complete) activity at node 4, or, if Buy ATO Item Flow returns an 
incomplete result, the process proceeds to the End (Incomplete) activity at node 
8.

If the supply type is Work Order, the process initiates the Create Work Order - 
Line process at node 3. Once this completes, the process proceeds the End 
(Complete) activity at node 4. If the Create Work Order - Line returns an 
incomplete result, the process proceeds to the End (Incomplete) activity at node 
8.

If the supply type is Flow Schedule, the process initiates the Create Flow 
Schedule activity at node 7. The process then moves to the End (Complete) 
activity at node 4, or, if Create Flow Schedule returns an incomplete result, the 
process proceeds to the End (Incomplete) activity at node 8.

If the Check Supply Type activity has an error or is unable to determine a supply 
type, the process moves directly to the End (Incomplete) activity at node 8.

Create Configuration - Line, Manual
Create Configuration - Line, Manual is a workflow process that creates 
configuration for a line flow. This process is initiated as a subprocess of the 
following workflows:

■ Line Flow - ATO Model line flow

■ Create Supply - Line subprocess

Create Configuration - Line, Manual is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

This process can only end after configuration for the line is complete.

Summary of the Create Configuration - Line, Manual Process
To view the properties of the Create Configuration - Line, Manual process, select the 
process in the navigator tree, then select Properties from the Edit menu. This 
process is not runnable, which means that it cannot be assigned to a transaction 
type; it is a subprocess of a runnable flow.
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The Details property page of the process activity indicates that the Create 
Configuration - Line, Manual process has an error item type of WFERROR. This 
item type is associated with the RETRY_ONLY error process. The purpose of this 
error handling process is to alert an administrator when an error occurs in a process 
and prompt the administrator to retry the process in error. This error process is 
initiated only when an unexpected error with Oracle Workflow is encountered in 
the process.

When you display the Process window for the Create Configuration - Line, Manual 
process, you see that the process consists of 5 unique activities which comprise the 5 
activity nodes that appear in the workflow diagram. 

The following image depicts the workflow diagram for the Create Configuration - 
Line, Manual subprocess. Each node of this subprocess is numbered for referencing. 
The numbers themselves are not part of the process diagram.

Figure 5–11 Create Configuration - Line Manual Subprocess Workflow

If you use Line Flow - Generic to process ATO Models, this subprocess begins 
when the Create Supply - Line subprocess is initiated. If you use Line Flow - 
ATO Model this subprocess begins after the Schedule - Line subprocess 
completes.

The Create Configuration - Line, Manual subprocess begins at node 1 with the 
Start activity.
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At the Create Configuration - Eligible activity in node 2, you must manually 
progress the order. Once this authorization is granted, the process proceeds to 
the Create Configuration activity at node 3. This activity has three possible 
results:

■ Complete

■ Incomplete

■ On Hold

If the result of this activity is Incomplete or On Hold, the process returns to the 
Create Configuration - Eligible activity at node 2. If the result returned from the 
Create Configuration activity is complete, the process proceeds to the Wait for 
CTO activity at node 4. This activity has two possible results:

■ Complete

■ De-Link

If the result of this activity is De-Link, the process returns to the Create 
Configuration - Eligible activity at node 2. If the result of the Wait for CTO 
activity is Complete, then the process continues to End at node 5.

Create Configuration - Line, Manual Process Activities
The following table provides descriptions of each activity in the Create 
Configuration - Line, Manual subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Table 5–10 Create Configuration - Line Manual Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Create Configuration - 
Eligible (node 2)

OE_STANDARD_
WF.STANDARD_BLOCK

None Yes

Create Configuration 
(node 3)

CTO_WORKFLOW.CREATE_
CONFIG_ITEM_WF

Config Incomplete Yes

Wait for CTO (node 4) WF_STANDARD.BLOCK Config Item Results Yes

End (node 5) WF_STANDARD.NOOP None Yes
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Create Manufacturing Configuration Data - Line, Manual
Create Manufacturing Configuration Data - Line, Manual is a workflow subprocess 
that creates the manufacturing configuration data for an order line. Create 
Manufacturing Configuration Data - Line, Manual is a non-runnable flow that is 
initiated as a subprocess of the following line flows:

■ Line Flow - Configuration

■ Line Flow - Configuration with Authorize to Ship (RLM)

Create Manufacturing Configuration Data - Line, Manual contains the following 
subprocess:

■ Calculate Lead Time - Line

Every time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is Line Flow - Configuration or Line Flow - Configuration with 
Authorize to Ship (RLM), the Create Manufacturing Configuration Data - Line, 
Manual process is initiated as a subprocess of the line flow.

The Create Manufacturing Configuration Data - Line, Manual is contained in the 
Seeded Data File oexwford.wft and is associated with the OM Order Line item 
type.

Summary of Create Manufacturing Configuration Data - Line, Manual Process
To view the properties of the Create Manufacturing Configuration Data - Line, 
Manual process, select the process in the navigator tree, then select Properties from 
the Edit menu. This process is not runnable, which indicates that it cannot be 
assigned to a transaction type; it is a subprocess of a line flow.

The Details property page of the process activity indicates that the Create 
Manufacturing Configuration Data - Line, Manual process has an error item type of 
WFERROR. This item type is associated with the RETRY_ONLY error process. The 
purpose of this error handling process is to alert an administrator when an error 
occurs in a process and prompt the administrator to retry the process in error. This 
error process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

The Process window for the Create Manufacturing Configuration Data - Line, 
Manual process shows that the process consists of 5 unique activities and 1 
subprocess which comprise the 6 activity nodes that appear in the workflow 
diagram. 
5-28 Using Oracle Workflow in Oracle Order Management



OM Order Line Subprocesses
The following image depicts the workflow diagram for the Create Manufacturing 
Configuration Data - Line, Manual subprocess. Each node of this subprocess is 
numbered for referencing. The numbers themselves are not part of the process 
diagram.

Figure 5–12 Create Manufacturing Configuration Data - Line Manual Subprocess Workflow

The Create Manufacturing Configuration Data - Line, Manual begins after Line 
Flow - Configuration or Line Flow - Configuration with Authorize to Ship 
(RLM) is selected as the appropriate line flow for the order line. The Create 
Manufacturing Configuration Data - Line, Manual process is initiated as a 
subprocess of the selected line flow.

The workflow begins at node 1 with the Start activity.

In the Wait for Create Configuration activity at node 2 the process waits for the 
configuration data to complete. This activity can proceed down the default path, 
or, if the configuration data is already created, the subprocess can proceed to the 
End activity at node 5. Configuration data might already be created if the user 
created the configuration item using the Autocreate Config batch program, 
rather than progressing the workflow process.

If the process proceeds down the default path, it comes to node 3, Calculate Cost 
Rollup. Once this activity completes, the process proceeds to node 4: the 
Calculate Lead Time - Line subprocess. After successfully completing the 
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calculate purchase price subprocess, the process moves to Calculate Purchase 
Price activity at node 5.

After Calculate Purchase Price finishes, the process proceeds to the End activity 
at node 6.

Create Manufacturing Configuration Data - Line, Manual Process Activities 
The following table provides descriptions of each activity in the Create 
Manufacturing Configuration Data - Line, Manual subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Create Supply - Line
The Create Supply - Line subprocess creates supply for an order line. It is a 
non-runnable flow initiated as a subprocess of the following line flows:

■ Line Flow - Generic

■ Line Flow - Generic with Authorize to Ship (RLM)

■ Line Flow - Generic with Header Level Invoice Interface

■ Line Flow - Generic, With Export Compliance

■ Line Flow - Generic, Ship Only

■ Line Flow - Generic, with Repricing at Fulfillment

Table 5–11 Create Manufacturing Configuration Data - Line Manual Subprocess 
Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Wait for Create 
Configuration (node 2)

WF_STANDARD.BLOCK Config Data Results Yes

Calculate Cost Rollup 
(node 3)

CTO_
WORKFLOW.CALCULATE_
COST_ROLLUP_WF_ML

None Yes

Calculate Purchase 
Price (node 3)

CTO_
WORKFLOW.PURCHASE_
PRICE_CALC_WF

None Yes

End (node 5) WF_STANDARD.NOOP None Yes
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■ Line Flow - Standard Service

Create Supply - Line contains the following subprocesses:

■ Create Supply Order - Line, Manual

■ Create Configuration - Line, Manual

■ Purchase Release - Line, Deferred

Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is one of the previously mentioned flows, the Create Supply - Line process 
will initiate as a subprocess of the line flow.

The first activity in this process is the Branch on Source Type activity. This 
activity evaluates the line source type and item attributes to determine the line 
type: drop ship, ATO Model, ATO Item, or standard item. If it is a dropship, 
ATO Model, or ATO Item, supply for the items must be created.

The Create Supply - Line process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

Summary of the Create Supply - Line Process
To view the properties of the Create Supply - Line subprocess, select the process in 
the navigator tree, then select Properties from the Edit menu. This process is not 
runnable, which indicates that it cannot be assigned to a transaction type; it is a 
subprocess or a line flow.

The Details property page of the process activity indicates that the Create Supply - 
Line process has an error item type of WFERROR. This item type is associated with 
the RETRY_ONLY error process. The purpose of this error handling process is to 
alert an administrator when an error occurs in a process and prompt the 
administrator to retry the process in error. This error process is initiated only when 
an unexpected error with Oracle Workflow is encountered in the process.

The Process window for the Create Supply - Line process shows that the process 
consists of 5 unique activities. One activity is reused to comprise the 8 activity 
nodes that appear in the workflow diagram. 

The following image depicts the workflow diagram for the Create Supply - Line 
subprocess. Each node of this subprocess is numbered for referencing. The numbers 
themselves are not part of the process diagram.
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Figure 5–13 Create Supply - Line Subprocess Workflow

The Create Supply - Line workflow begins when on of the following lines flows is 
selected as the appropriate flow for the order line:

■ Line Flow - Generic

■ Line Flow - Generic with Authorize to Ship (RLM)

■ Line Flow - Generic with Header Level Invoice Interface

■ Line Flow - Generic, With Export Compliance
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■ Line Flow - Generic, Ship Only

■ Line Flow - Generic, with Repricing at Fulfillment

■ Line Flow - Standard Service

The workflow begins at node 1 with the Branch on Source Type activity. This 
activity has five possible results:

■ Default

■ ATO Item

■ Stock

■ Build

■ Dropship

When ATO Item is selected, the process leads to the Create Supply Order - Line, 
Manual subprocess in node 3. Once this subprocess is completed, the process 
proceeds to the End activity at node 4.

All internal standard items and non-shippable lines such as classes, ATO options, 
and service lines follow the stock flow. This flow indicates that Oracle Order 
Management must not create supply for the item (planning will provide supply for 
the item). The item is eligible for shipping on its schedule date. Non-shippable lines 
are fulfilled after their dependencies are fulfilled.

An ATO model has the Build result type, which leads to the Create 
Configuration - Line, Manual subprocess in node 6. Once this process completes, 
the subprocess moves to the End activity in node 5.

All standard (non-ATO) items which have a source type code of External continue 
through the dropship workflow activity process. Oracle Order Management’s 
Purchase Release subprocess is used for these order lines.

If the source type is not ATO Item, Stock, Build, or Dropship the process proceeds to 
the End activity at node 2, and the order line flow continues.

Create Supply - Line Process Activities
The following table provides descriptions of each activity in the Create Supply 
Order - Line, Manual subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.
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Create Supply Order - Line, Manual
Create Supply Order - Line, Manual is a workflow subprocess that creates supply 
for ATO items and configurations. It first verifies that there is a reservation already 
on the sales order line. If there is, the subprocess ends. If there is no reservation, the 
subprocess encounters the Create Supply Order - Eligible block activity and 
waits until the user progresses the order line to the Create ATO Supply 
subprocess, or creates and reserves supply manually.

Create Supply Order - Line, Manual is initiated as a subprocess of the following 
workflow subprocess:

■ Create Supply - Line

Create Supply Order - Line, Manual is initiated as a subprocess of the following 
runnable flows:

■ Line Flow - ATO Item

■ Line Flow - Configuration

■ Line Flow - Configuration with Authorize to Ship (RLM)

The Create Supply Order - Line, Manual subprocess contains the following 
subprocess:

■ Create ATO Supply

Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is one of the previously mentioned flows, the Create Supply Order - Line, 
Manual process is initiated as a subprocess of the line flow.

The Create Supply Order - Line, Manual process is contained in the Seeded Data 
File oexwford.wft and is associated with the OM Order Line item type.

Table 5–12 Create Supply Order - Line Manual Subprocess Activities

Activity Function Result Type Required

Branch on Source Type 
(node 1)

OE_OEOL_SCH.BRANCH_
ON_SOURCE_TYPE

Source Type Yes

End (nodes 2, 4, 5, 8) WF_STANDARD.NOOP None Yes
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Summary of the Create Supply Order - Line, Manual Process
To view the properties of the Create Supply Order - Line, Manual process, select the 
process in the navigator tree, then select Properties from the Edit menu. This 
process is not runnable, which indicates that it cannot be assigned to a transaction 
type; it is a subprocess or a line flow.

The Details property page of the process activity indicates that the Create Supply 
Order - Line, Manual process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error handling 
process is to alert an administrator when an error occurs in a process and prompt 
the administrator to retry the process in error. This error process is initiated only 
when an unexpected error with Oracle Workflow is encountered in the process.

The Process window for the Create Supply Order - Line, Manual process shows that 
the process consists of 4 unique activities and 1 subprocess, comprising the 5 
activity nodes that appear in the workflow diagram. 

The following image depicts the workflow diagram for the Create Supply Order - 
Line, Manual subprocess. Each node of this subprocess is numbered for referencing. 
The numbers themselves are not part of the process diagram.

Figure 5–14 Create Supply Order - Line Manual Subprocess Workflow

The Create Supply Order - Line, Manual process begins when its parent line flow or 
the Create Supply - Line subprocess initiates it as part of its flow. The workflow 
begins at node 1 with the Start activity.

At node 2, the Check Reservation activity determines whether there is quantity 
reserved to this line. If there is, the process proceeds directly to the End activity 
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at node 5. If there is no reservation to the line, the process proceeds to the Create 
Supply Order - Eligible activity at node 3.

The Create Supply Order - Eligible activity at node 3 waits until the user progresses 
the order line to the Create ATO Supply subprocess at node 4. After Create ATO 
Supply completes, the line flow proceeds to the End activity at node 5, and 
returns to its parent line flow.

Create Supply Order - Line, Manual Process Activities
The following table provides descriptions of each activity in the Create Supply 
Order - Line, Manual subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Create Work Order - Line
The Create Work Order - Line subprocess is a workflow process that is initiated as a 
subprocess of the Create ATO Supply subprocess. Create Work Order - Line is 
associated with assemble to order items.

The process can end with a complete or incomplete result. It ends with an 
incomplete result if the following occurs:

■ There is an error during parameter setup.

■ The order line is on hold.

Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is one of the previously mentioned flows, the Create Work Order - Line 
process is initiated as a subprocess of the line flow.

Table 5–13 Create Supply Order - Line Manual Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Check Reservation 
(node 2)

CTO_WORKFLOW.RSV_
BEFORE_BOOKING_WF

Reserved Status Yes

Create Supply Order - 
Eligible (node 3)

OE_STANDARD_
WF.STANDARD_BLOCK

Reserved Status No

End (node 5) WF_STANDARD.NOOP None Yes
5-36 Using Oracle Workflow in Oracle Order Management



OM Order Line Subprocesses
The Create Work Order - Line process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

Summary of the Create Work Order - Line Process
To view the properties of the Create Work Order - Line subprocess, select the 
process in the navigator tree, then select Properties from the Edit menu. The Create 
Work Order - Line process has a result type of Config Process Results, indicating 
that when the process completes, it has a result of either complete (work order 
created) or incomplete (work order not completed). This process is not runnable, 
which indicates that it cannot be assigned to a transaction type; it is a subprocess or 
a line flow.

The Details property page of the process activity indicates that the Create Work 
Order - Line process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error handling 
process is to alert an administrator when an error occurs in a process and prompt 
the administrator to retry the process in error. This error process is initiated only 
when an unexpected error with Oracle Workflow is encountered in the process.

The Process window for the Create Work Order - Line process shows that the 
process consists of 6 unique activities, comprising the 6 activity nodes that appear in 
the workflow diagram. 

The following image depicts the workflow diagram for the Create Work Order - 
Line subprocess. Each node of this subprocess is numbered for referencing. The 
numbers themselves are not part of the process diagram.
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Figure 5–15 Create Work Order - Lone Subprocess Workflow

The Create Work Order - Line workflow begins at node 1 with the Start activity. 
At node 2, the Create Work Order - Set Up Parameters activity prepares to 
launch AutoCreate FAS by setting up the line number as the parameter for the 
program. When the Create Work Order - Set Up Parameters activity completes 
with a result of incomplete or on hold, the process moves directly to the End 
(Incomplete) activity at node 6. If the process ends as incomplete, the parent 
process moves back to Create Supply Order - Eligible.

When the activity completes with a result of complete, it proceeds to the 
AutoCreate FAS activity at node 3. This activity initiates a concurrent program 
to create a work in process job for the order line, and then waits until the 
concurrent program completes before continuing. When it completes, the 
activity verifies the result. If the result is Normal, the process proceeds to the End 
(Complete) activity at node 4.

If the result is not Normal, the process moves to the Retry AutoCreate FAS 
notification activity. A notification is then sent to the Order Management Workflow 
administrator with the following message: Failed AutoCreate FAS. From this 
notification, the AutoCreate FAS activity can be retried (leading back to node 2), 
or aborted, which leads to the End (Complete) at node 4.
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Create Work Order - Line Process Activities
The following table provides descriptions of each activity in the Create Work Order 
- Line subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Enter - Line
The Enter - Line subprocess verifies that lines on an order are booked before 
proceeding with the line flow. Enter - Line is associated with the following line 
flows:

■ Line Flow - ATO Item

■ Line Flow - ATO Model

■ Line Flow - Generic

■ Line Flow - Generic with Authorize to Ship (RLM)

■ Line Flow - Generic with Header Level Invoice Interface

■ Line Flow - Generic, With Export Compliance

■ Line Flow - Generic, Bill Only

■ Line Flow - Generic, Bill Only with Inventory Interface

■ Line Flow - Generic, Ship Only

■ Line Flow - Generic, with Repricing at Fulfillment

Table 5–14 Create Work Order - Line Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Create Work Order - Set 
Up Parameters (node 2)

CTO_WORKFLOW.SET_
PARAMETER_WORK_
ORDER_WF

Config Incomplete Yes

AutoCreate FAS (node 
3)

CTO_WORKFLOW.SUBMIT_
CONC_PROG_WF

Concurrent Program 
Status

Yes

End (Complete) (node 
4)

WF_STANDARD.NOOP None Yes

End (Incomplete) (node 
6)

WF_STANDARD.NOOP None Yes
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■ Line Flow - Return for Credit Only

■ Line Flow - Return for Credit Only with Approval

■ Line Flow - Return for Credit with Receipt

■ Line Flow - Return for Credit with Receipt and Approval

■ Line Flow - Standard Service

Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is one of the previously mentioned flows, the Enter - Line process is 
initiated as a subprocess of the line flow.

The Enter - Line process is contained in the Seeded Data File oexwford.wft and 
is associated with the OM Order Line item type.

Summary of the Enter - Line Process
To view the properties of the Enter - Line Process, select the process in the navigator 
tree, then select Properties from the Edit menu. This process is not runnable, which 
indicates that it cannot be assigned to a transaction type; it is a subprocess or a line 
flow.

The Details property page of the process activity indicates that the Enter - Line 
process has an error item type of WFERROR. This item type is associated with the 
RETRY_ONLY error process. The purpose of this error handling process is to alert 
an administrator when an error occurs in a process and prompt the administrator to 
retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

The Process window for the Enter - Line process shows that the process consists of 2 
unique activities, comprising the 2 activity nodes that appear in the workflow 
diagram. 

The following image depicts the workflow diagram for the Enter - Line subprocess. 
Each node of this subprocess is numbered for referencing. The numbers themselves 
are not part of the process diagram.
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Figure 5–16 Enter - Line Subprocess Workflow

The workflow begins at node 1 with the Wait for Booking activity. This activity 
is a standard block activity that requires an order flow to be booked before 
proceeding. After the order is booked the process proceeds to the End activity in 
node 2.

Enter - Line Process Activities
The following table provides descriptions of each activity in the Enter - Line 
subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Export Compliance Screening - Line
The Export Compliance Screening - Line subprocess performs Denied Party 
screening according to United States Bureau of Export Administration’s Denied 
Party listing. This process is a subprocess of the following line flow:

■ Line Flow - Generic, With Export Compliance

Table 5–15 Enter - Line Subprocess Activities

Activity Function Result Type Required

Wait for Booking (node 1) WF_STANDARD.WAITFORFLOW None Yes

End (node 2) WF_STANDARD.NOOP None Yes
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When an order line is submitted that must comply with the United States Bureau of 
Export Administration’s Denied Party listing, this subprocess initiates. If the line 
passes this screening process, then the process approves the line for exporting and 
continues. If it does not meet export requirements, the process initiates a hold until 
the requirements are met.

The process can end with the following results:

■ Complete

■ On hold

■ Override

Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is one of the previously mentioned flows, the Export Compliance Screening 
- Line process is initiated as a subprocess of the line flow.

The Export Compliance Screening - Line process is contained in the Seeded Data 
File oexwford.wft and is associated with the OM Order Line item type.

Summary of the Export Compliance Screening - Line Process
To view the properties of the Export Compliance Screening - Line process, select the 
process in the navigator tree, then choose Properties from the Edit menu. The 
Export Compliance Screening - Line process is a subprocess. This process is not 
runnable, which indicates that it cannot be assigned to a transaction type; it is a 
subprocess or a line flow.

The Details property page of the process activity indicates that the Export 
Compliance Screening - Line process has an error item type of WFERROR. This item 
type is associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process and 
prompt the administrator to retry the process in error. This error process is initiated 
only when an unexpected error with Oracle Workflow is encountered in the process. 
The Process window for the Export Compliance Screening - Line process shows that 
the process consists of 5 unique activities, comprising the 7 activity nodes that 
appear in the workflow diagram. 

The following image depicts the workflow diagram for the Export Compliance 
Screening - Line subprocess. Each node of this subprocess is numbered for 
referencing. The numbers themselves are not part of the process diagram.
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Figure 5–17 Export Compliance Screening - Line Subprocess Workflow

The Export Compliance Screening - Line process is initiated as a subprocess of 
the Line Flow - Generic, With Export Compliance line flow. The workflow 
begins at node 1 with the Start activity.

At node 2, the Export Compliance Screening activity attempts to verify whether 
the line meets export requirements. This activity has four possible results:

■ Incomplete

■ Override

■ Complete

■ Hold Applied

A Complete or Override result moves the process to the End activities at nodes 3 
and 7, respectively.

An Incomplete result leads to the Export Compliance Screening - Eligible 
activity at node 4. This activity blocks the process from proceeding until it can 
produce a result of Complete, Override or On Hold.
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An On Hold result leads to the Export Compliance Hold Applied notification 
activity at node 5. This activity sends notification indicating that an export 
compliance hold is applied to the line. Upon completion of this activity, the process 
proceeds to the End activity at node 6.

Export Compliance Screening - Line Process Activities
The following table provides descriptions of each activity in the Export Compliance 
Screening - Line subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Header Level Invoice Interface - Line, Deferred
Header Level Invoice Interface - Line, Deferred is a workflow process that interfaces 
with Oracle Receivables to generate an invoice for order lines. The Header Level 
Invoice Interface - Line, Deferred subprocess works with the seeded header flow to 
support header level invoicing. Header Level Invoice Interface - Line, Deferred is 
initiated as a subprocess of the following line level process:

■ Line Flow - Generic with Header Level Invoice Interface

Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is Line Flow - Generic with Header Level Invoice Interface, the Header 
Level Invoice Interface - Line, Deferred process is initiated as a subprocess of the 
line flow.

Table 5–16 Export Compliance Screening - Line Subprocess Workflow

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Export Compliance 
Screening (node 2)

OE_EXPORT_COMPLIANCE_
WF.ECS_REQUEST

OM Export 
Compliance 
Results

Yes

End (nodes 3, 6, 7) WF_STANDARD.NOOP None Yes

Export Compliance 
Screening - Eligible (node 
4)

OE_STANDARD_WF.STANDARD_
BLOCK

None No
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The Header Level Invoice Interface - Line, Deferred process is contained in the 
Seeded Data File oexwford.wft and is associated with the OM Order Line item 
type.

Summary of the Header Level Invoice Interface - Line, Deferred Process
To view the properties of the Header Level Invoice Interface - Line, Deferred 
process, select the process in the navigator tree, then select Properties from the Edit 
menu. The Header Level Invoice Interface - Line, Deferred process is a subprocess. 
This process is not runnable, which indicates that it cannot be assigned to a 
transaction type; it is a subprocess or a line flow.

The Details property page of the process activity indicates that the Header Level 
Invoice Interface - Line process has an error item type of WFERROR. This item type 
is associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process and 
prompt the administrator to retry the process in error. This error process is initiated 
only when an unexpected error with Oracle Workflow is encountered in the process. 
The Process window for the Header Level Invoice Interface - Line, Deferred process 
shows that the process consists of 6 unique activities, comprising the 6 activity 
nodes that appear in the workflow diagram.

The following image depicts the workflow diagram for the Header Level Invoice 
Interface - Line, Deferred subprocess. Each node of this subprocess is numbered for 
referencing. The numbers themselves are not part of the process diagram.

Figure 5–18 Header Level Invoice Interface - Line Deferred Subprocess Workflow

The Header Level Invoice Interface is initiated as a subprocess of the Line Flow - 
Generic with Header Level Invoice Interface line flow. The workflow begins at 
node 1 with the Start activity.
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At node 2, the Fulfill - Deferred activity defers the line flow to the background 
engine. Once the background engine restarts the process, the process proceeds to 
the Fulfill activity at node 3. At node 4, the Fulfill - Continue Header Flow 
continues the process to the Wait for Invoice Interface block activity in node 5. 
After completion of node 5, the process continues to the End activity at node 5.

Header Level Invoice Interface - Line, Deferred Process Activities
The following table provides descriptions of each activity in the Header Level 
Invoice Interface subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.
\

Inventory Interface Non-Ship - Line
Inventory Interface Non-Ship - Line is a workflow process that interfaces with 
Oracle Inventory to relieve reservations and demand for non-shippable order lines. 
It is initiated as a subprocess of the following line flow:

■ Line Flow - Generic, Bill Only with Inventory Interface

Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is one of the previously mentioned flows, the Inventory Interface Non-Ship 
- Line process is initiated as a subprocess of the line flow.

The Inventory Interface Non-Ship - Line process is contained in the Seeded Data 
File oexwford.wft and is associated with the OM Order Line item type.

Table 5–17 Header Level Invoice Interface Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Fulfill - Deferred (node 2) WF_STANDARD.DEFER None Yes

Fulfill (node 3) OE_FULFILL_WF.START_
FULFILLMENT

None Yes

Fulfill - Continue Header 
Flow (node 4)

WF_
STANDARD.CONTINUEFLOW

None Yes

Wait for Invoice Interface 
(node 5)

WF_STANDARD.WAITFORFLOW None Yes

End (node 6) WF_STANDARD.NOOP None Yes
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Summary of the Inventory Interface Non-Ship - Line Process
To view the properties of the Inventory Interface Non-Ship - Line process, select the 
process in the navigator tree, then select Properties from the Edit menu. The 
Inventory Interface Non-Ship - Line process is a subprocess. This process is not 
runnable, which indicates that it cannot be assigned to a transaction type; it is a 
subprocess or a line flow.

The Details property page of the process activity indicates that the Inventory 
Interface Non-Ship - Line process has an error item type of WFERROR. This item 
type is associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process and 
prompt the administrator to retry the process in error. This error process is initiated 
only when an unexpected error with Oracle Workflow is encountered in the process. 
The Process window for the Inventory Interface Non-Ship - Line process shows that 
the process consists of 4 unique activities, comprising the 5 activity nodes that 
appear in the workflow diagram. 

The following image depicts the workflow diagram for the Inventory Interface 
Non-Ship - Line subprocess. Each node of this subprocess is numbered for 
referencing. The numbers themselves are not part of the process diagram.
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Figure 5–19 Inventory Interface Non-Ship - Line Subprocess Workflow

The Inventory Interface Non-Ship - Line process is initiated as a subprocess of 
the Line Flow - Generic, Bill Only with Inventory Interface line flow. The 
workflow begins at node 1 with the Start activity.

At node 2, the Inventory Interface activity can complete with three possible 
results:

■ On Hold

■ Incomplete

■ Complete

■ Not Eligible

A Complete or Not Eligible result moves the process directly to an End activity. 
An On Hold or Incomplete result leads the process to the Inventory Interface - 
Eligible block activity at node 4. This activity holds the process until the line is 
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manually progressed. The process then returns to the Inventory Interface 
activity at node 2.

Inventory Interface Non-Ship - Line Process Activities
The following table provides descriptions of each activity in the Inventory Interface 
Non-Ship - Line subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Inventory Interface Non-Ship - Line, Deferred
Inventory Interface Non-Ship - Line, Deferred is a workflow process that interfaces 
with Oracle Inventory to relieve reservations and demand for non-shippable order 
lines. Inventory Interface Non-Ship - Line, Deferred is a workflow process that is 
initiated as a subprocess of the following line flow:

■ Line Flow - Generic, Bill Only with Inventory Interface

Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is one of the previously mentioned flows, the Inventory Interface Non-Ship 
- Line, Deferred process is initiated as a subprocess of the line flow.

Table 5–18 Inventory Interface Non-Ship - Line Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Invoice Interface 
(node 2)

OE_INV_IFACE_
WF.INVENTORY_INTERFACE

OM Subprocess Results, 
Handles Holds

Yes

Inventory 
Interface - Eligible 
(node 4)

OE_STANDARD_
WF.STANDARD_BLOCK

None No

End (nodes 3, 5) WF_STANDARD.NOOP None Yes

Note: The Inventory Interface Non-Ship - Line, Deferred process 
is identical to the Inventory Interface Non-Ship - Line process 
except that it contains an extra activity for deferment.
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The C process is contained in the Seeded Data File oexwford.wft and is 
associated with the OM Order Line item type.

Summary of the Inventory Interface Non-Ship - Line, Deferred Process
To view the properties of the Inventory Interface Non-Ship - Line, Deferred process, 
select the process in the navigator tree, then select Properties from the Edit menu. 
The Inventory Interface Non-Ship - Line, Deferred process is a subprocess. This 
process is not runnable, which indicates that it cannot be assigned to a transaction 
type; it is a subprocess or a line flow.

The Details property page of the process activity indicates that the Inventory 
Interface Non-Ship - Line process has an error item type of WFERROR. This item 
type is associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process and 
prompt the administrator to retry the process in error. This error process is initiated 
only when an unexpected error with Oracle Workflow is encountered in the process. 
The Process window for the Inventory Interface Non-Ship - Line, Deferred process 
shows that the process consists of 5 unique activities, comprising the 6 activity 
nodes that appear in the workflow diagram. 

The following image depicts the workflow diagram for the Inventory Interface 
Non-Ship - Line, Deferred subprocess. Each node of this subprocess is numbered for 
referencing. The numbers themselves are not part of the process diagram.
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Figure 5–20 Inventory Interface Non-Ship - Line Deferred Subprocess Workflow

The Inventory Interface Non-Ship - Line, Deferred process is initiated as a 
subprocess of the Line Flow - Generic, Bill Only with Inventory Interface line 
flow. The workflow begins at node 1 with the Start activity.

At node 2, the Inventory Interface - Deferred activity defers inventory interface. 
After this activity completes, the process continues to the Inventory Interface 
activity at node 3. From this activity the process is identical to the Inventory 
Interface Non-Ship - Line subprocess.

At node 3, the Inventory Interface activity initiates a PL/SQL that has three 
possible results:

■ On Hold

■ Incomplete

■ Complete

■ Not Eligible

A Complete or Not Eligible result moves the process directly to the End activity 
at node 4 or node 6, respectively.
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An On Hold or Incomplete result leads the process to the Inventory Interface - 
Eligible block activity at node 5. This activity holds the process until the line is 
manually progressed. The process then returns to the Inventory Interface 
activity at node 3.

Inventory Interface Non-Ship - Line, Deferred Process Activities
The following table provides descriptions of each activity in the Inventory Interface 
Non-Ship - Line, Deferred subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Invoice Interface - Line
Invoice Interface - Line is a workflow subprocess used to interface with Oracle 
Receivables to obtain an invoice for an order line. Invoice Interface - Line is initiated 
as a subprocess of the following line flows:

■ Line Flow - ATO Item

■ Line Flow - Generic

■ Line Flow - Generic with Authorize to Ship (RLM)

■ Line Flow - Generic, With Export Compliance

■ Line Flow - Generic, with Repricing at Fulfillment

■ Line Flow - Standard Service

Table 5–19 Inventory Interface Non-Ship - Line Deferred Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Inventory 
Interface - 
Deferred (node 2)

WF_STANDARD.DEFER None Yes

Inventory 
Interface (node 3)

OE_INV_IFACE_
WF.INVENTORY_INTERFACE

OM Subprocess Results, 
Handles Holds

Yes

Inventory 
Interface - Eligible 
(node 5)

OE_STANDARD_
WF.STANDARD_BLOCK

None No

End (nodes 4, 6) WF_STANDARD.NOOP None Yes
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Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is one of the previously mentioned flows, the Invoice Interface - Line 
process is initiated as a subprocess of the line flow.

The Invoice Interface - Line process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

Summary of the Invoice Interface - Line Process
To view the properties of the Invoice Interface - Line process, select the process in 
the navigator tree, then select Properties from the Edit menu. The Invoice Interface - 
Line process is a subprocess. This process is not runnable, which indicates that it 
cannot be assigned to a transaction type; it is a subprocess or a line flow.

The Details property page of the process activity indicates that the Invoice Interface 
- Line process has an error item type of WFERROR. This item type is associated 
with the RETRY_ONLY error process. The purpose of this error handling process is 
to alert an administrator when an error occurs in a process and prompt the 
administrator to retry the process in error. This error process is initiated only when 
an unexpected error with Oracle Workflow is encountered in the process.

The Process window for the Invoice Interface - Line process shows that the process 
consists of 6 unique activities, comprising the 6 activity nodes that appear in the 
workflow diagram. 

The following image depicts the workflow diagram for the Invoice Interface - Line 
subprocess. Each node of this subprocess is numbered for referencing. The numbers 
themselves are not part of the process diagram.
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Figure 5–21 Interface - Line Subprocess Workflow

The Invoice Interface - Line process begins at node 1 with the Start activity. In 
the Invoice Interface activity at node 2 the process interfaces with Oracle 
Receivables to generate invoicing information for the order line. When this 
activity ends with a Complete result, the process moves to the End (Complete) 
activity at node 6 and returns to its parent flow. If the Invoice Interface activity 
returns a Not Eligible result, the process moves to the End (Not Eligible) activity 
at node 3 and returns to its parent flow.

If the Invoice Interface activity returns a result of On Hold or Incomplete, the 
process moves to the Invoice Interface - Eligible activity node 4, where is waits 
until the process is manually progressed.

If the Invoice Interface activity returns a result of Partial, the process moves to 
the Wait for Required for Revenue or Delivery where it waits the necessary 
revenue or delivery information. Once this information is received, the process 
proceeds to the End (Complete) activity at node 6 and returns to its parent flow.
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Invoice Interface - Line Process Activities
The following table provides descriptions of each activity in the Invoice Interface - 
Line subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Invoice Interface - Line, Deferred
Invoice Interface - Line, Deferred is a workflow subprocess used to interface with 
Oracle Receivables to obtain an invoice for an order line. Invoice Interface - Line is 
initiated as a subprocess of the following line flows:

■ Line Flow - ATO Model

■ Line Flow - Generic, Bill Only

■ Line Flow - Generic, Bill Only with Inventory Interface

■ Line Flow - Return for Credit Only

■ Line Flow - Return for Credit Only with Approval

■ Line Flow - Return for Credit with Receipt

■ Line Flow - Return for Credit with Receipt and Approval

Table 5–20 Invoice Interface - Line Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Invoice Interface 
(node 2)

OE_INVOICE_
WF.INVOICE_INTERFACE

OM Subprocess 
Results, Handles 
Holds

Yes

End (Not Eligible) 
(node 6)

WF_STANDARD.NOOP None Yes

Wait for Required for 
Revenue or Delivery 
(node 5)

WF_STANDARD.BLOCK None Yes

Invoice Interface - 
Eligible (node 4)

OE_STANDARD_
WF.STANDARD_BLOCK

None No

End (Complete) 
(node 6)

WF_STANDARD.NOOP None Yes
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Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is one of the previously mentioned flows, the Invoice Interface - Line, 
Deferred process is initiated as a subprocess of that line flow.

The Invoice Interface - Line, Deferred process is contained in the Seeded Data 
File oexwford.wft and is associated with the OM Order Line item type.

Summary of the Invoice Interface - Line, Deferred Process
To view the properties of the Invoice Interface - Line, Deferred process, select the 
process in the navigator tree, then select Properties from the Edit menu. The Invoice 
Interface - Line, Deferred process is a subprocess. This process is not runnable, 
which indicates that it cannot be assigned to a transaction type; it is a subprocess or 
a line flow.

The Details property page of the process activity indicates that the Invoice Interface 
- Line, Deferred process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error handling 
process is to alert an administrator when an error occurs in a process and prompt 
the administrator to retry the process in error. This error process is initiated only 
when an unexpected error with Oracle Workflow is encountered in the process.

The Process window for the Invoice Interface - Line, Deferred process shows that 
the process consists of 7 unique activities, comprising the 7 activity nodes that 
appear in the workflow diagram. 

The following image depicts the workflow diagram for the Invoice Interface - Line, 
Deferred subprocess. Each node of this subprocess is numbered for referencing. The 
numbers themselves are not part of the process diagram.

Note: The Invoice Interface - Line, Deferred process is identical to 
the Invoice Interface - Line process except that it contains an 
extra activity for deferment.
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Figure 5–22 Interface - Line Deferred Subprocess Workflow

The Invoice Interface - Line process begins at node 1 with the Start activity. In 
the Invoice Interface - Deferred activity at node 2 defers the process to the 
background engine. Once the background engine is run, the process resumes. In 
the Invoice Interface activity at node 3 the process interfaces with Oracle 
Receivables to generate invoicing information for the order line. When this 
activity ends with a Complete result, the process moves to the End (Complete) 
activity at node 6 and returns to its parent flow. If the Invoice Interface activity 
returns a Not Eligible result, the process moves to the End (Not Eligible) activity 
at node 4 and returns to its parent flow.

If the Invoice Interface activity returns a result of On Hold or Incomplete, the 
process moves to the Invoice Interface - Eligible activity node 7, where is waits 
until the process is manually progressed.

If the Invoice Interface activity returns a result of Partial, the process moves to 
the Wait for Required for Revenue or Delivery where it waits until the revenue 
or delivery information is received. Once this information is received, the 
process proceeds to the End (Complete) activity at node 6 and returns to its parent 
flow.
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Invoice Interface - Line, Deferred Process Activities
The following table provides descriptions of each activity in the Invoice Interface - 
Line, Deferred subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Purchase Release - Line, Deferred
The Purchase Release - Line, Deferred subprocess interfaces to Oracle Purchasing 
for externally sourced lines. It is initiated as a subprocess of the following 
subprocess:

■ Create Supply - Line

Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the assigned line flow for the 
line contains Create Supply - Line subprocess, the Purchase Release - Line, 
Deferred process is initiated as a subprocess of that subprocess.

The Purchase Release - Line, Deferred process is contained in the Seeded Data 
File oexwford.wft and is associated with the OM Order Line item type.

Table 5–21 Invoice Interface - Line Deferred Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Invoice Interface - 
Deferred (node 2)

WF_STANDARD.DEFER None Yes

Invoice Interface 
(node 3)

OE_INVOICE_
WF.INVOICE_INTERFACE

OM Subprocess 
Results, Handles 
Holds

Yes

End (Not Eligible) 
(node 4)

WF_STANDARD.NOOP None Yes

Wait for Required for 
Revenue or Delivery 
(node 5)

WF_STANDARD.BLOCK None Yes

End (Complete) 
(node 6)

WF_STANDARD.NOOP None Yes

Invoice Interface - 
Eligible (node 7)

OE_STANDARD_
WF.STANDARD_BLOCK

None Yes
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Summary of the Purchase Release - Line, Deferred Process
To view the properties of the Purchase Release - Line, Deferred process, select the 
process in the navigator tree, then select Properties from the Edit menu. The 
Purchase Release - Line, Deferred process is a subprocess. This process is not 
runnable, which indicates that it cannot be assigned to a transaction type; it is a 
subprocess or a line flow.

The Details property page of the process activity indicates that the Purchase Release 
- Line, Deferred process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error handling 
process is to alert an administrator when an error occurs in a process and prompt 
the administrator to retry the process in error. This error process is initiated only 
when an unexpected error with Oracle Workflow is encountered in the process.

The Process window for the Purchase Release - Line, Deferred process shows that 
the process consists of 5 unique activities, comprising the 6 activity nodes that 
appear in the workflow diagram. 

The following image depicts the workflow diagram for the Purchase Release - Line, 
Deferred subprocess. Each node of this subprocess is numbered for referencing. The 
numbers themselves are not part of the process diagram.

Figure 5–23 Purchase Release - Line Deferred Subprocess Workflow
Seeded Subprocess Definitions 5-59



OM Order Line Subprocesses
The Purchase Release - Line, Deferred subprocess begins at node 1 with the Start 
activity.

The Purchase Release - Deferred activity at node 2 moves processing to the 
background engine. In the Purchase Release activity at node 3, the process 
releases a record to the Oracle Purchasing requisition import tables. If the 
Purchase Release activity returns an On Hold or Incomplete result, the process 
moves into the Purchase Release - Eligible activity at node 5. This activity 
enables you to manually progress the order.

If the Purchase Release activity returns a Complete or Not Eligible result, the 
process proceeds to an End activity and returns to its parent process.

Purchase Release - Line, Deferred Process Activities
The following table provides descriptions of each activity in the Purchase Release - 
Line, Deferred subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Purchase Release - Line, Deferred - ATO
The Purchase Release - Line, Deferred - ATO subprocess interfaces to Oracle 
Purchasing for externally sourced lines. It is initiated as a subprocess of the 
following subprocess:

■ Create ATO Supply

Table 5–22 Purchase Release - Line Deferred Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Purchase Release - 
Deferred (node 2)

WF_STANDARD.DEFER None Yes

Purchase Release 
(node 3)

OE_OEOL_SCH.RELEASE_TO_
PURCHASING

OM Subprocess Results, 
Handles Holds

Yes

Purchase Release - 
Eligible (node 5)

OE_STANDARD_
WF.STANDARD_BLOCK

None No

End (nodes 4, 6) WF_STANDARD.NOOP None Yes
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Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the assigned line flow for the 
line contains Create ATO Supply subprocess, the Purchase Release - Line, 
Deferred - ATO process is initiated as a subprocess of that subprocess.

The Purchase Release - Line, Deferred ATO process is contained in the Seeded 
Data File oexwford.wft and is associated with the OM Order Line item type.

Summary of the Purchase Release - Line, Deferred ATO Process
To view the properties of the Purchase Release - Line, Deferred - ATO process, select 
the process in the navigator tree, then select Properties from the Edit menu. The 
Purchase Release - Line, Deferred - ATO process is a subprocess. This process is not 
runnable, which indicates that it cannot be assigned to a transaction type; it is a 
subprocess or a line flow.

The Details property page of the process activity indicates that the Purchase Release 
- Line, Deferred - ATO process has an error item type of WFERROR. This item type 
is associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process and 
prompt the administrator to retry the process in error. This error process is initiated 
only when an unexpected error with Oracle Workflow is encountered in the process. 
The Process window for the Purchase Release - Line, Deferred - ATO process shows 
that the process consists of 5 unique activities, comprising the 6 activity nodes that 
appear in the workflow diagram. 

The following image depicts the workflow diagram for the Purchase Release - Line, 
Deferred - ATO subprocess. Each node of this subprocess is numbered for 
referencing. The numbers themselves are not part of the process diagram.

Note: The Purchase Release - Line, Deferred ATO subprocess is 
identical to the Purchase Release - Line, Deferred process but is 
used specifically for ATO order lines.
Seeded Subprocess Definitions 5-61



OM Order Line Subprocesses
Figure 5–24 Purchase Release - Line Deferred - ATO Subprocess Workflow

The Purchase Release - Line, Deferred - ATO subprocess begins at node 1 with 
the Start activity.

The Purchase Release - Deferred activity at node 2 moves processing to the 
background engine. In the Purchase Release activity at node 3, the process 
releases a record to the Oracle Purchasing requisition import tables. If the 
Purchase Release activity returns an On Hold or Incomplete result, the process 
moves into the Purchase Release - Eligible activity at node 5. This activity 
enables you to manually progress the order.

If the Purchase Release activity returns a Complete or Not Eligible result, the 
process proceeds to an End activity and returns to its parent process.

Purchase Release - Line, Deferred - ATO Process Activities
The following table provides descriptions of each activity in the Purchase Release - 
Line, Deferred - ATO subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.
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Purchase Release - Line, Manual
The Purchase Release - Line, Manual subprocess interfaces to Oracle Purchasing for 
externally sourced lines. Purchase Release - Line, Manual enables you to manually 
progress the process instead of waiting for the background engine to pick it up.

The Purchase Release - Line, Manual process is contained in the Seeded Data 
File oexwford.wft and is associated with the OM Order Line item type.

Summary of the Purchase Release - Line, Manual Process
To view the properties of the Purchase Release - Line, Manual process, select the 
process in the navigator tree, then select Properties from the Edit menu. The 
Purchase Release - Line, Manual process is a subprocess. This process is not 
runnable, which indicates that it cannot be assigned to a transaction type; it is a 
subprocess or a line flow.

The Details property page of the process activity indicates that the Purchase Release 
- Line, Manual process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error handling 
process is to alert an administrator when an error occurs in a process and prompt 
the administrator to retry the process in error. This error process is initiated only 
when an unexpected error with Oracle Workflow is encountered in the process.

Table 5–23 Purchase Release - Line Deferred - ATO Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Purchase Release - 
Deferred (node 2)

WF_STANDARD.DEFER None Yes

Purchase Release 
(node 3)

OE_OEOL_SCH.RELEASE_TO_
PURCHASING

OM Subprocess Results, 
Handles Holds

Yes

Purchase Release - 
Eligible (node 5)

OE_STANDARD_
WF.STANDARD_BLOCK

None No

End (nodes 4, 6) WF_STANDARD.NOOP None Yes

Note: The Purchase Release - Line, Manual subprocess is identical 
to the Purchase Release - Line, Deferred process except that it 
does not contain a deferment activity.
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The Process window for the Purchase Release - Line, Manual process shows that the 
process consists of 4 unique activities, comprising the 5 activity nodes that appear in 
the workflow diagram. 

The following image depicts the workflow diagram for the Purchase Release - Line, 
Manual subprocess. Each node of this subprocess is numbered for referencing. The 
numbers themselves are not part of the process diagram.

Figure 5–25 Purchase release - Line Manual Subprocess Workflow

The Purchase Release - Line, Manual subprocess begins at node 1 with the Start 
activity.

In the Purchase Release - Eligible activity at node 2, the activity must be 
manually progressed to the Purchase Release activity at node 3. If the Purchase 
Release activity returns an On Hold or Incomplete result, the process returns to 
the Purchase Release - Eligible activity at node 2.

If the Purchase Release activity returns a Complete or Not Eligible result, the 
process proceeds to an End activity and returns to its parent process.

Purchase Release - Line, Deferred Process Activities
The following table provides descriptions of each activity in the Purchase Release - 
Line, Deferred subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.
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Reprice - Line
The Reprice - Line subprocess enables you to reprice an order line. This is useful for 
invoicing purposes. Reprice - Line is initiated as a subprocess of the following line 
flow:

■ Line Flow - Generic, with Repricing at Fulfillment

Each time an order line is saved in Oracle Order Management, the line is 
evaluated to determine which workflow is assigned to the line. If the assigned 
line flow is Line Flow - Generic, with Repricing at Fulfillment, the Reprice - Line 
process is initiated as a subprocess of the line flow.

Reprice - Line is contained in the Seeded Data File oexwford.wft and process is 
associated with the OM Order Line item type.

Summary of the Reprice - Line Process
To view the properties of the Reprice - Line process, select the process in the 
navigator tree, then select Properties from the Edit menu. The Reprice - Line process 
is a subprocess. This process is not runnable, which indicates that it cannot be 
assigned to a transaction type; it is a subprocess or a line flow.

The Details property page of the process activity indicates that the Reprice - Line 
process has an error item type of WFERROR. This item type is associated with the 
RETRY_ONLY error process. The purpose of this error handling process is to alert 
an administrator when an error occurs in a process and prompt the administrator to 
retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

The Process window for the Reprice - Line process shows that the process consists 
of 4 unique activities, comprising the 5 activity nodes that appear in the workflow 
diagram. 

Table 5–24 Purchase Release - Line Deferred Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Purchase Release - 
Eligible (node 2)

OE_STANDARD_
WF.STANDARD_BLOCK

None No

Purchase Release 
(node 3)

OE_OEOL_SCH.RELEASE_TO_
PURCHASING

OM Subprocess Results, 
Handles Holds

Yes

End (nodes 4, 5) WF_STANDARD.NOOP None Yes
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The following image depicts the workflow diagram for the Reprice - Line 
subprocess. Each node of this subprocess is numbered for referencing. The numbers 
themselves are not part of the process diagram.

Figure 5–26 Reprice - Line Subprocess Workflow

The Reprice - Line subprocess begins at node 1 with the Start activity. 

In the Reprice activity at node 2, the reprices the line. If the Reprice activity 
returns an Incomplete result then the process moves to the Reprice - Eligible 
activity at node 4. The process must be manually progressed to return to the 
Reprice activity. If the Purchase Release activity returns an Not Eligible or 
Complete result, the process proceeds to an End activity and returns to its parent 
process.

Reprice - Line Process Activities
The following table provides descriptions of each activity in the Reprice - Line 
subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.
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Return Receiving - Line
The Return Receiving - Line subprocess is used in returns. The Return Receiving - 
Line subprocess executes a series of activities that determine the status of a returned 
item.

Return Receiving - Line is initiated as a subprocess of the following line flows:

■ Line Flow - Return for Credit with Receipt

■ Line Flow - Return for Credit with Receipt and Approval

Each time an order line is saved in Oracle Order Management, the line is 
evaluated to determine which workflow is assigned to the line. If the assigned 
line flow is Line Flow - Return for Credit with Receipt or Line Flow - Return for 
Credit with Receipt and Approval, the Return Receiving - Line process is 
initiated as a subprocess of the line flow.

Return Receiving - Line is contained in the Seeded Data File oexwford.wft and 
process is associated with the OM Order Line item type.

Summary of the Return Receiving - Line Process
To view the properties of the Return Receiving - Line process, select the process in 
the navigator tree, then select Properties from the Edit menu. The Return Receiving 
- Line process is a subprocess. This process is not runnable, which indicates that it 
cannot be assigned to a transaction type; it is a subprocess or a line flow.

The Details property page of the process activity indicates that the Return Receiving 
- Line process has an error item type of WFERROR. This item type is associated 
with the RETRY_ONLY error process. The purpose of this error handling process is 
to alert an administrator when an error occurs in a process and prompt the 
administrator to retry the process in error. This error process is initiated only when 
an unexpected error with Oracle Workflow is encountered in the process. 

Table 5–25 Reprice - Line Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Reprice (node 2) OE_REPRICE_WF.START_
REPRICING

OM Subprocess Results No

Reprice - Eligible 
(node 3)

OE_STANDARD_
WF.STANDARD_BLOCK

None Yes

End (nodes 4, 5) WF_STANDARD.NOOP None Yes
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The Process window for the Return Receiving - Line process shows that the process 
consists of 4 unique activities, comprising the 5 activity nodes that appear in the 
workflow diagram. 

The following image depicts the workflow diagram for the Return Receiving - Line 
subprocess. Each node of this subprocess is numbered for referencing. The numbers 
themselves are not part of the process diagram.

Figure 5–27 Return Receiving - Line Subprocess Workflow

The Return Receiving - Line subprocess begins at node 1 with the Start activity.

In the Utility to Get Line Category activity at node 2 determines whether the line 
is an order or a return. If the line is a return, it is not eligible for return receiving 
and the process closes. In the Wait for Receiving activity at node 3 the process 
waits until the return item is received before progressing. If the return item is 
not eligible for receiving, the process ends.

If the return item is eligible for receiving, the process then moves to the Wait for 
Inspection activity at node 4. After the inspection is complete the process moves 
to the End (Complete) activity at node 5 and returns to its parent process.
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Return Receiving - Line Process Activities
The following table provides descriptions of each activity in the Return Receiving - 
Line subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Schedule - Line
The Schedule - Line subprocess schedules an order line for all order lines that must 
be shipped. This process is a subprocess of the following line flows:

■ Line Flow - ATO Item

■ Line Flow - ATO Model

■ Line Flow - Generic

■ Line Flow - Generic with Authorize to Ship (RLM)

■ Line Flow - Generic with Header Level Invoice Interface

■ Line Flow - Generic, With Export Compliance

■ Line Flow - Generic, Ship Only

■ Line Flow - Generic, with Repricing at Fulfillment

Table 5–26 Return Receiving - Line Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Utility to Get Line 
Category (node 2)

OE_STANDARD_WF.GET_
LINE_CATEGORY

Line Category No

Wait for Receiving 
(node 3)

OE_RMA_WF.WAIT_FOR_
RECEIVING

OM Subprocess Success 
Results

Yes

Wait for 
Inspection (node 
4)

WF_STANDARD.BLOCK None Yes

End (Complete) 
(node 5)

WF_STANDARD.NOOP None Yes

End (Not Eligible) 
(nodes 6, 7)

WF_STANDARD.NOOP None Yes
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Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 
the line is one of the previously mentioned flows, the Schedule - Line process is 
initiated as a subprocess of the line flow.

The Schedule - Line process is contained in the Seeded Data File oexwford.wft 
and is associated with the OM Order Line item type.

Summary of the Schedule - Line Process
To view the properties of the Schedule - Line process, select the process in the 
navigator tree, then select Properties from the Edit menu. The Schedule - Line 
process is a subprocess. This process is not runnable, which indicates that it cannot 
be assigned to a transaction type; it is a subprocess or a line flow.

The Details property page of the process activity indicates that the Schedule - Line 
process has an error item type of WFERROR. This item type is associated with the 
RETRY_ONLY error process. The purpose of this error handling process is to alert 
an administrator when an error occurs in a process and prompt the administrator to 
retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

The Process window for the Schedule - Line process shows that the process consists 
of 4 unique activities, comprising the 5 activity nodes that appear in the workflow 
diagram.

The following image depicts the workflow diagram for the Schedule - Line 
subprocess. Each node of this subprocess is numbered for referencing. The numbers 
themselves are not part of the process diagram.
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Figure 5–28 Schedule - Line Subprocess Workflow

The Schedule - Line subprocess begins at node 1 with the Start activity.

The Schedule activity at node 2 attempts to schedule the order line. If the 
Schedule activity returns a result of Incomplete or On Hold, the process moves 
to the Schedule - Eligible activity at node 4. From there the process must be 
manually progressed to return to the Schedule activity.

If the Schedule activity returns a Not Eligible or Complete result, the process 
proceeds to an End activity and returns to its parent process.

Schedule - Line Process Activities
The following table provides descriptions of each activity in the Schedule - Line 
subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.
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Schedule - Line, Deferred
The Schedule - Line subprocess schedules an order line for all order lines that must 
be shipped.

The Schedule - Line, Deferred process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

Summary of the Schedule - Line, Deferred
To view the properties of the Schedule - Line, Deferred process, select the process in 
the navigator tree, then select Properties from the Edit menu. The Schedule - Line, 
Deferred process is a subprocess. This process is not runnable, which indicates that 
it cannot be assigned to a transaction type; it is a subprocess or a line flow.

The Details property page of the process activity indicates that the Invoice Interface 
- Line, Deferred process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error handling 
process is to alert an administrator when an error occurs in a process and prompt 
the administrator to retry the process in error. This error process is initiated only 
when an unexpected error with Oracle Workflow is encountered in the process.

The Process window for the Schedule - Line, Deferred process shows that the 
process consists of 6 unique activities, comprising the 9 activity nodes that appear in 
the workflow diagram. The following image depicts the workflow diagram for the 

Table 5–27 Schedule - Line Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Schedule (node 2) OE_OEOL_SCH.SCHEDULE_
LINE

OM Subprocess Results, 
Handles Holds

No

Schedule - Eligible 
(node 3)

OE_STANDARD_
WF.STANDARD_BLOCK

None Yes

End (nodes 4, 5) WF_STANDARD.NOOP None Yes

Note: The Schedule - Line, Deferred subprocess is identical to 
the Schedule - Line process except that it contains two new 
activities: an activity to determine whether the line is scheduled, 
and a defer activity.
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Schedule - Line, Deferred subprocess. Each node of this subprocess is numbered for 
referencing. The numbers themselves are not part of the process diagram.

Figure 5–29 Schedule - Line Deferred Subprocess Workflow

The Schedule - Line, Deferred subprocess begins at node 1 with the Start 
activity. The Is Line Scheduled activity at node 2 determines whether the line 
has already been scheduled. If scheduling is complete or the line is not eligible 
for scheduling, the process ends and returns to its parent flow. If scheduling has 
not yet been completed, the process moves to the Schedule - Deferred activity at 
node 5. This activity moves scheduling to the background engine.

The Schedule activity at node 6 attempts to schedule the order line. If the 
Schedule activity returns a result of Incomplete or On Hold, the process moves 
to the Schedule - Eligible activity at node 8. From there the process must be 
manually progressed to return to the Schedule activity.

If the Schedule activity returns a Not Eligible or Complete result, the process 
proceeds to an End activity and returns to its parent process.
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Schedule - Line, Deferred Process Activities
The following table provides descriptions of each activity in the Schedule - Line, 
Deferred subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Ship - Line, Manual
Ship - Line, Manual enables you to manually initiate shipping for an order line. 
Ship - Line, Manual is initiated as a subprocess of the following line flows:

■ Line Flow - ATO Item

■ Line Flow - Configuration

■ Line Flow - Configuration with Authorize to Ship (RLM)

■ Line Flow - Generic

■ Line Flow - Generic with Authorize to Ship (RLM)

■ Line Flow - Generic with Header Level Invoice Interface

■ Line Flow - Generic, With Export Compliance

■ Line Flow - Generic, Ship Only

Each time an order line is saved in Oracle Order Management, the line is evaluated 
to determine which workflow is assigned to the line. If the appropriate line flow for 

Table 5–28 Schedule - Line Deferred Subprocess Activities

Activity Function Result Type Required

Start (node 1) WF_STANDARD.NOOP None Yes

Is Line Scheduled 
(node 2)

OE_OEOL_SCH.IS_LINE_
SCHEDULED

OM Subprocess Results No

Schedule - Deferred 
(node 5)

WF_STANDARD.DEFER None Yes

Schedule (node 6) OE_OEOL_SCH.SCHEDULE_
LINE

OM Subprocess Results, 
Handles Holds

No

Schedule - Eligible 
(node 8)

OE_STANDARD_
WF.STANDARD_BLOCK

None Yes

End (nodes 3, 4, 7, 
9)

WF_STANDARD.NOOP None Yes
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the line is one of the previously mentioned flows, the Ship - Line, Manual process is 
initiated as a subprocess of that line flow.

The Ship - Line, Manual process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type.

Summary of the Ship - Line, Manual Process
To view the properties of the Ship - Line, Manual process, select the process in the 
navigator tree, then select Properties from the Edit menu. The Ship - Line, Manual 
process is a subprocess. This process is not runnable, which indicates that it cannot 
be assigned to a transaction type; it is a subprocess or a line flow.

The Details property page of the process activity indicates that the Ship - Line, 
Manual process has an error item type of WFERROR. This item type is associated 
with the RETRY_ONLY error process. The purpose of this error handling process is 
to alert an administrator when an error occurs in a process and prompt the 
administrator to retry the process in error. This error process is initiated only when 
an unexpected error with Oracle Workflow is encountered in the process.

The Process window for the Ship - Line, Manual process shows that the process 
consists of 6 unique activities, comprising the 6 activity nodes that appear in the 
workflow diagram. 

The following image depicts the workflow diagram for the Ship - Line, Manual 
subprocess. Each node of this subprocess is numbered for referencing. The numbers 
themselves are not part of the process diagram.
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Figure 5–30 Ship - Line Manual Process Workflow

The Ship - Line, Manual subprocess begins at node 1 with the Ship activity, 
which returns one of the following four results:

■ Over Shipped Beyond Tolerance

■ Ship Confirm

■ Non Shippable

■ Unreserved

If the Ship activity returns the Over Shipped Beyond Tolerance result, a 
notification is sent and the process moves to an End activity and returns to its 
parent line flow. If the Ship activity returns a Ship Confirm, Non Shippable, or 
Unreserved result, the process moves to an End activity and returns to its parent 
line flow.
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Ship - Line, Manual Process Activities
The following table provides descriptions of each activity in the Ship - Line, Manual 
subprocess.

For more information about individual activities, refer to Chapter 6, Seeded 
Function Activity Definitions.

Wait to Firm - Line
The Wait to Firm - Line workflow process is used to hold order lines until they are 
firmed by the Firm Demand Process concurrent program. 

The Wait to Firm - Line process is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Order Line item type

Summary of the Wait to Firm - Line Process
To view the properties of the Wait to Firm - Line process, select the process in the 
navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type. The Details 
property page of the process activity indicates that the Wait to Firm - Line process 
has an error item type of OMERROR. This item type is associated with the R_
ERROR_RETRY error process. The purpose of this error handling process is to alert 
an administrator when an error occurs in a process and prompt the administrator to 

Table 5–29 Ship - Line Manual Subprocess Activities

Activity Function Result Type Required

Ship (node 1) OE_SHIPPING_WF.START_
SHIPPING

Shipping Results Yes

End (Ship 
Confirm) (node 2)

WF_STANDARD.DEFER None Yes

End (Over 
Shipped Beyond 
Tolerance) (node 
4)

WF_STANDARD.NOOP OM Subprocess Results, 
Handles Holds

Yes

End (Non 
Shippable)(node 
5)

WF_STANDARD.NOOP None Yes

End (Unreserve) 
(nodes 6)

WF_STANDARD.NOOP None Yes
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retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process. 

When you display the Process window for the Wait to Firm - Line, you see that the 
process consists of 3 unique activities and 3 subprocesses, which comprise the 6 
nodes that appear in the workflow diagram. The following diagram depicts the 
Line Flow - Standard Service process. Each node of this process is numbered for 
referencing.

Figure 5–31 Wait to Firm - Line Workflow

Wait to Firm - Line Activities
The following table provides descriptions of each activity in the Wait to Firm - Line 
Process.

For more information about individual function activities, see Seeded Function 
Activity Definitions.

Table 5–30 Wait to Firm - Line Activities

Activity Function Result Type Required

Start WF_
STANDARD.N
OOP

None Yes

End WF_
STANDARD.N
OOP

None Yes
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Negotiation Subprocesses

Submit Draft - Negotiation
The Submit - Draft Negotiation subprocess is included in the seeded Negotiation 
workflows. Submit Draft - Negotiation is initiated if it is part of the Negotiation 
workflow that is attached to the transaction type for the sales document.

Submit Draft - Negotiation is contained in the Seeded Data File oexwford.wft 
and is associated with the OM Negotiation Header item type.

Summary of the Submit Draft - Negotiation Process
To view the properties of the Submit Draft - Negotiation process, select the 
process in the navigator tree and then select Properties from the Edit menu. This 
process is runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the Submit Draft 
- Negotiation process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process 
and prompt the administrator to retry the process in error. This error process is 
initiated only when an unexpected error with Oracle Workflow is encountered 
in the process.

The Process window displays the activities of the Submit Draft - Negotiation 
process, which comprise the nodes that appear in the workflow diagram. 

The following diagram depicts the Submit Draft - Negotiation process.
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Figure 5–32 Submit Draft - Negotiation Process Workflow

Submit Draft - Negotiation Activities
The following table provides descriptions of each activity in the Submit Draft - 
Negotiation Process.

For more information about individual function activities, see Seeded Function 
Activity Definitions.

Table 5–31 Submit - Draft Process Activities

Activity Function Result Type Required

Start WF_
STANDARD.N
OOP

None Yes

Submit Draft - Eligible OE_
STANDARD_
WF.STANDAR
D.BLOCK

Submit Draft, 
Lost

Yes

Submit Draft OE_
NEGOTIATE_
WF.Submit_
Draft_Internal

End Yes

End WF_
STANDARD.N
OOP

None Yes
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Complete - Negotiation
The Complete - Negotiation subprocess is included in the seeded Negotiation 
workflows. Complete - Negotiation is initiated if it is part of the Negotiation 
workflow that is attached to the transaction type for the sales document.

Complete - Negotiation is contained in the Seeded Data File oexwford.wft and is 
associated with the OM Negotiation Header item type.

Summary of the Complete - Negotiation Process
To view the properties of the Complete - Negotiation process, select the process in 
the navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type. The Details 
property page of the process activity indicates that the Complete - Negotiation 
process has an error item type of WFERROR. This item type is associated with the 
RETRY_ONLY error process. The purpose of this error handling process is to alert 
an administrator when an error occurs in a process and prompt the administrator to 
retry the process in error. This error process is initiated only when an unexpected 
error with Oracle Workflow is encountered in the process.

The Process window displays the activities of the Complete - Negotiation process, 
which comprise the nodes that appear in the workflow diagram. The following 
diagram depicts the Complete - Negotiation process.

Figure 5–33 Complete - Negotiation Workflow
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Complete - Negotiation Activities
The following table provides descriptions of each activity in the Complete - 
Negotiation Process.

For more information about individual function activities, see Seeded Function 
Activity Definitions.

Internal Approval - Negotiation
The Internal Approval - Negotiation subprocess is used for approvals in Oracle 
Order Management.

The Internal Approval - Negotiation subprocess is included in the seeded 
Negotiation workflows. Internal Approval - Negotiation is initiated if it is part of 
the Negotiation workflow that is attached to the transaction type for the sales 
document.

Internal Approval - Negotiation is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Negotiation Header item type.

Summary of the Internal Approval Process
To view the properties of the Internal Approval - Negotiation subprocess, select 
the process in the navigator tree and then select Properties from the Edit menu. 
This process is runnable, which indicates that it can be assigned to a transaction 
type.

The Details property page of the process activity indicates that the Internal 
Approval - Negotiation process has an error item type of WFERROR. This item 
type is associated with the RETRY_ONLY error process. The purpose of this 
error handling process is to alert an administrator when an error occurs in a 

Table 5–32 Complete - Negotiation Activities

Activity Function Result Type Required

Start WF_STANDARD.NOOP None Yes

Negotiation Complete OE_NEGOTIATE_
WF.Negotiation_
Complete

Incomplete, 
End

Yes

Negotiation Complete - 
Eligible

OE_STANDARD_
WF.STANDARD_
BLOCK

Negotiation 
Complete, Lost

Yes

End WF_STANDARD.NOOP None Yes
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process and prompt the administrator to retry the process in error. This error 
process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

The Process window displays the activities and subprocesses of the Internal 
Approval - Negotiation process, which comprise the nodes that appear in the 
workflow diagram. The following diagram depicts the Internal Approval - 
Negotiation process.

Figure 5–34 Internal Approval Workflow

Internal Approval - Negotiation Activities
The following table provides descriptions of each activity in the Internal 
Approval - Negotiation Process. 

For more information about individual function activities, see Seeded Function 
Activity Definitions.

Table 5–33 Internal Approval - Negotiation Activities

Activity Function Result Type Required

Initiate 
Approval

OE_APPROVALS_
WF.Initiate_Approvals

Complete, Not 
Eligible

Yes
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Customer Acceptance - Negotiation Process
The Customer Acceptance - Negotiation workflow process is used for 
negotiation in Oracle Order Management.

The Customer Acceptance - Negotiation subprocess is included in the seeded 
Negotiation workflows. Customer Acceptance - Negotiation is initiated if it is 
part of the Negotiation workflow that is attached to the transaction type for the 
sales document.

Customer Acceptance - Negotiation is contained in the Seeded Data File 
oexford.wft and is associated with the OM Negotiation Header item type.

Summary of the Customer Acceptance - Negotiation Process
To view the properties of the Customer Acceptance - Negotiation process, select 
the process in the navigator tree and then select Properties from the Edit menu. 
This process is runnable, which indicates that it can be assigned to a transaction 
type.

The Details property page of the process activity indicates that the Customer 
Acceptance - Negotiation process has an error item type of WFERROR. This item 
type is associated with the RETRY_ONLY error process. The purpose of this 
error handling process is to alert an administrator when an error occurs in a 
process and prompt the administrator to retry the process in error. This error 
process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

The Process window displays the activities and subprocesses of the Customer 
Acceptance - Negotiation process, which comprise the nodes that appear in the 

Get Next 
Approver

OE_APPROVALS_
WF.Get_Next_Approver

Yes, No Yes

Approval Timeout OE_APPROVALS_
WF.Approval_Timeout

Continue, 
Reject

Yes

Internal Approved OE_APPROVALS_
WF.Approve_Approval

None Yes

Internal Rejected OE_APPROVALS_
WF.Reject_Approval

None Yes

End WF_STANDARD.NOOP None Yes

Table 5–33 Internal Approval - Negotiation Activities

Activity Function Result Type Required
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workflow diagram. The following diagram depicts the Customer Acceptance - 
Negotiation process.

Figure 5–35 Customer Acceptance - Negotiation Workflow

Customer Acceptance - Negotiation Activities
The following table provides descriptions of each activity in the Customer 
Acceptance Process.

For more information about individual function activities, see Seeded Function 
Activity Definitions.

Table 5–34 Customer Acceptance Activities

Activity Function Result Type Required

Customer Acceptance OE_NEGOTIATE_
WF.Customer_
Acceptance

Accept, 
Reject

Yes

Customer Accepted OE_NEGOTIATE_
WF.Update_Customer_
Accepted

None Yes

Customer Rejected OE_NEGOTIATE_
WF.Update_Customer_
Rejected

None Yes

End WF_STANDARD.NOOP None Yes
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Offer Expiration - Negotiation Process
The Offer Expiration - Negotiation workflow process is used for Quotes in 
Oracle Order Management. Blanket Sales Agreements do not include the Offer 
Expiration - Negotiation process.

The Offer Expiration - Negotiation subprocess is included in the seeded 
Negotiation workflows. Offer Expiration - Negotiation is initiated if it is part of 
the Negotiation workflow that is attached to the transaction type for the sales 
document.

Offer Expiration - Negotiation is contained in the Seeded Data File oexford.wft 
and is associated with the OM Negotiation Header item type.

Summary of the Offer Expiration - Negotiation Process
To view the properties of the Offer Expiration - Negotiation process, select the 
process in the navigator tree and then select Properties from the Edit menu. This 
process is runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the Offer 
Expiration - Negotiation process has an error item type of WFERROR. This item 
type is associated with the RETRY_ONLY error process. The purpose of this 
error handling process is to alert an administrator when an error occurs in a 
process and prompt the administrator to retry the process in error. This error 
process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

The Process window displays the activities and subprocesses of the Offer 
Expiration - Negotiation process, which comprise the nodes that appear in the 
workflow diagram. The following diagram depicts the Offer Expiration - 
Negotiation process.
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Figure 5–36 Offer Expiration - Negotiation Workflow

Offer Expiration - Negotiation Activities
The following table provides descriptions of each activity in the Offer Expiration 
- Negotiation Process.

For more information about individual function activities, see Seeded Function 
Activity Definitions.

Table 5–35 Offer Expiration - Negotiation Activities

Activity Function Result Type Required

Assign WF_
STANDARD.ASSIGN

None Yes

Check 
Expiration Date

OE_NEGOTIATION_
WF.Check_Expiration_
Date

Complete, 
Expire Today, 
No 
Pre-expiration 
Reminder, 
Expired

Yes

Wait for 
Expiration

WF_
STANDARD.BLOCK

Timeout, Date 
Changed

Yes

Set Final 
Expiration Date

OE_NEGOTIATE_
WF.Set_Final_
Expiration_Date

Expired Yes

Wait for Final 
Expiration

WF_
STANDARD.BLOCK

Timeout, Date 
Changed

Yes

Offer Expired OE_NEGOTIATE_
WF.Offer_Expired

Expired Yes
Seeded Subprocess Definitions 5-87



Negotiation Subprocesses
Blanket Agreement/Sales Order Generation
The following sub-flow is s standalone subprocess that is not part of any seeded 
flow. However, you can put it in the runnable negotiation flow as needed and is 
available to copy and extend the seeded flow through addition of this sub-flow.

Blanket Agreement/Sales Order Generation is contained in the Seeded Data File 
oexwford.wft and is associated with the OM Negotiation Header item type.

Summary of the Blanket Agreement/Sales Order Generation Process
To view the properties of the Blanket Agreement/Sales Order Generation process, 
select the process in the navigator tree and then select Properties from the Edit 
menu. This process is runnable, which indicates that it can be assigned to a 
transaction type.

The Details property page of the process activity indicates that the Blanket 
Agreement/Sales Order Generation process has an error item type of WFERROR. 
This item type is associated with the RETRY_ONLY error process. The purpose of 
this error handling process is to alert an administrator when an error occurs in a 
process and prompt the administrator to retry the process in error. This error 
process is initiated only when an unexpected error with Oracle Workflow is 
encountered in the process.

The Process window displays the activities of the Blanket Agreement/Sales Order 
Generation process, which comprise the nodes that appear in the workflow 
diagram. The following diagram depicts the Blanket Agreement/Sales Order 
Generation process.

End WF_STANDARD.NOOP None Yes

Table 5–35 Offer Expiration - Negotiation Activities

Activity Function Result Type Required
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Figure 5–37 Blanket Agreement/Sales Order Generation Workflow

Blanket Agreement/Sales Order Generation Activities
The following table provides descriptions of each activity in the Blanket 
Agreement/Sales Order Generation Process.

For more information about individual function activities, see Seeded Function 
Activity Definitions.

Table 5–36 Blanket Agreement/Sales Order Generation Process Activities

Activity Function Result Type Required

Start WF_STANDARD.NOOP None Yes

End WF_STANDARD.NOOP None Yes
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Blanket Sales Agreement Subprocesses

Notifications for Blanket Sales Agreement Processes

Enter—Blanket
The Enter - Blanket subprocess is included in the seeded Blanket workflows. 
Enter - Blanket is initiated if it is part of the Blanket workflow that is attached to 
the transaction type for the sales document.

Enter—Blanket is contained in the Seeded Data File oexwford.wft and is 
associated with the OM Blanket Header item type.

Summary of the Enter—Blanket Process
To view the properties of the Enter—Blanket process, select the process in the 
navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the 
Enter—Blanket process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process 
and prompt the administrator to retry the process in error. This error process is 
initiated only when an unexpected error with Oracle Workflow is encountered 
in the process.

The Process window displays the activities of the Enter—Blanket process, which 
comprise the nodes that appear in the workflow diagram. The following diagram 
depicts the Enter—Blanket process.

Table 5–37 Notifications for Blanket Sales Agreement Processes

Display Name Result Type Message

Blanket Pre-Expiration 
Notification

FYI Notify Sender of Blanket Pre 
Expire

Blanket Expiration 
Rejection

FYI Notify Sender of Blanket Rejection

Notify Sender of Blanket 
Termination

FYI Notify Sender of Blanket 
Termination
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Figure 5–38 Enter—Blanket Workflow

Enter—Blanket Activities
The following table provides descriptions of each activity in the Enter—Blanket 
Process.

For more information about individual function activities, see Seeded Function 
Activity Definitions.

Execute - Blanket
The Execute - Blanket workflow process is used for the Fulfillment flow of 
Blanket Sales Agreements in Oracle Order Management.

The Execute - Blanket subprocess is included in the seeded Blanket workflows. 
Execute - Blanket is initiated if it is part of the Blanket workflow that is attached 
to the transaction type for the sales document.

Table 5–38 Enter-Blanket Process Activities

Activity Function Result Type Required

Check 
Negotiation 
Exists

OE_BLANKET_
WF.Check_Negotiation_ 
Exists

Yes, No Yes

Submit Draft - 
Eligible

OE_STANDARD_
WF.STANDARD_BLOCK

Submit Draft, 
Incomplete

Yes

Submit Draft OE_BLANKET_
WF.Submit_Draft

Incomplete, 
Default

Yes

End WF_STANDARD.NOOP None Yes
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Execute - Blanket is contained in the Seeded Data File oexwford.wtf and is 
associated with the OM Blanket Header item type.

Summary of the Execute - Blanket Process
To view the properties of the Execute - Blanket process, select the process in the 
navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the Execute - 
Blanket process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process 
and prompt the administrator to retry the process in error. This error process is 
initiated only when an unexpected error with Oracle Workflow is encountered 
in the process.

The Process window displays the activities and subprocesses of the Execute - 
Blanket process, which comprise the nodes that appear in the workflow 
diagram. The following diagram depicts the Execute - Blanket process.

Figure 5–39 Execute - Blanket Process
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Execute - Blanket Activities
The following table provides descriptions of each activity in the Execute - 
Blanket Process.

For more information about individual function activities, see Seeded Function 
Activity Definitions.

Table 5–39 Execute - Blanket Activities

Activity Function Result Type Required

Assign WF_
STANDARD.ASSIGN

Calculate 
Effective Dates

Yes

Calculate Effective Dates OE_BLANKET_
WF.CALCULATE_
EFFECTIVE_DATES

Start Date 
Reached, Expire 
Today, No 
Expiration 
Reminder, 
Expired, No 
End Date

Yes

Set Final Expiration Date OE_BLANKET_WF.Set_
Final_Expiration_Date

Blanket 
Expired, 
Blanket Active 
- Wait for Final 
Expiration

Yes

Blanket Active - Wait for 
Expiration

WF_
STANDARD.BLOCK

Timeout, Date 
Changed, 
Terminate

Yes

Blanket Active - Wait for 
Final Expiration

WF_
STANDARD.BLOCK

Timeout, Date 
Changed, 
Terminate

Yes

Blanket - Expired OE_BLANKET_
WF.Expired

End Yes

Wait for Start Date WF_STANDARD_
BLOCK

Timeout, 
Terminate, Date 
Changed

Yes

Blanket Active - No 
End Date

WF_STANDARD_
BLOCK

Terminate, Date 
Changed

Yes

End WF_STANDARD.NOOP None Yes
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Terminate—Blanket 
The Terminate—Blanket process is used in the Fulfillment phase in Oracle Order 
Management.

The Terminate - Blanket subprocess is included in the seeded Blanket 
workflows. Terminate - Blanket is initiated if it is part of the Blanket workflow 
that is attached to the transaction type for the sales document.

Terminate—Blanket is contained in the Seeded Data File oexwford.wft and is 
associated with the OM Blanket Header item type.

Summary of the Terminate—Blanket Process
To view the properties of the Terminate—Blanket process, select the process in 
the navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the 
Terminate—Blanket process has an error item type of WFERROR. This item type 
is associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process and 
prompt the administrator to retry the process in error. This error process is initiated 
only when an unexpected error with Oracle Workflow is encountered in the 
process. The Process window displays the activities and subprocesses of the 
Terminate—Blanket process, which comprise the nodes that appear in the 
workflow diagram. The following diagram depicts the Terminate—Blanket 
process.

Figure 5–40 Terminate - Blanket Process

Terminate—Blanket Activities
The following table provides descriptions of each activity in the Terminate—Blanket 
Flow Process.
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For more information about individual function activities, see Seeded Function 
Activity Definitions.

Close—Blanket
The Close—Blanket process is used for the Blanket Sales Agreement Fulfillment 
flow in Oracle Order Management.

The Close - Blanket subprocess is included in the seeded Blanket workflows. 
Close - Blanket is initiated if it is part of the Blanket workflow that is attached to 
the transaction type for the sales document.

Close—Blanket is contained in the Seeded Data File oexwford.wtf and is associated 
with the OM Blanket Header item type.

Summary of the Close—Blanket Process
To view the properties of the Close—Blanket process, select the process in the 
navigator tree and then select Properties from the Edit menu. This process is 
runnable, which indicates that it can be assigned to a transaction type.

The Details property page of the process activity indicates that the 
Close—Blanket process has an error item type of WFERROR. This item type is 
associated with the RETRY_ONLY error process. The purpose of this error 
handling process is to alert an administrator when an error occurs in a process 
and prompt the administrator to retry the process in error. This error process is 
initiated only when an unexpected error with Oracle Workflow is encountered 
in the process.

The Process window displays the activities and subprocesses of the 
Close—Blanket process, which comprise the nodes that appear in the workflow 
diagram. The following diagram depicts the Close—Blanket process.

Table 5–40 Terminate - Blanket Activities

Activity Function Result Type Required

Terminate—Blanket OE_BLANKET_
WF.Update_Status_
Terminate

None Yes

End WF_STANDARD.NOOP None Yes
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Figure 5–41 Close - Blanket Process

Close—Blanket Activities
The following table provides descriptions of each activity in the Close—Blanket 
process.

For more information about individual function activities, see Seeded Function 
Activity Definitions.

Table 5–41 Close - Blanket Activities

Activity Function Result Type Required

Start WF_
STANDARD.NOOP

None Yes

Close Blanket - Eligible OE_STANDARD_
WF.STANDARD_BLOCK

Complete, 
Extend

Yes

Close - Blanket OE_BLANKET_WF.Close Incomplete, 
End

Yes

End WF_STANDARD.NOOP None Yes
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Seeded Function Activity Definitions

Topics covered in this chapter include the following:

■ OM Order Header on page 6-2

■ OM Order Line on page 6-7

■ OM Standard on page 6-31

■ Standard on page 6-32

■ Negotiation on page 6-33

■ Blanket Sales Agreements on page 6-37
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Approve - Continue Line
The Approve - Continue Line activity is an OM Order Header activity that uses 
standard Oracle Workflow functionality to continue the workflow in progress. 
Approve - Continue Line activity is used to mark the position in the process where, 
upon completion the approval process, the halted process will continue.

The Approve - Continue Line activity calls the PL/SQL procedure named WF_ 
STANDARD.CONTINUEFLOW.

The Approve - Continue Flow activity contains two activity attributes:

■ Waiting Flow

■ Waiting Activity

The Approve - Continue Line activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Header item type.

Book
The Book activity calls the PL/SQL procedure named OE_BOOK_WF.BOOK_ORDER 
to book an order. The Book activity uses the lookup OM Subprocess Results, 
Handles Holds. This lookup contains the following result codes:

■ Complete

■ Incomplete

■ On Hold

■ Not Eligible

The Book activity will complete with one of these results.

The Book activity is contained in the Seeded Data File oexwford.wft, and is 
associated with the OM Order Header item type.

Book - Continue Line (Complete)
The Book - Continue Line (Complete) activity is an OM Order Header activity that 
uses standard Oracle Workflow functionality to continue the workflow in progress. 
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Book - Continue Line (Complete) marks the position in the process where, upon 
completion of booking, the halted line level process will continue.

The Book - Continue Line (Complete) activity calls the PL/SQL procedure named 
WF_STANDARD.CONTINUEFLOW.

The Book - Continue Flow (Complete) activity contains two activity attributes:

■ Waiting Flow

■ Waiting Activity

The Book - Continue Line (Complete) activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Header item type.

Book - Deferred
The Book - Deferred function activity is an OM Order Header activity that uses 
standard Oracle Workflow functionality to defer the booking activity to the 
background engine.

To use Book - Deferred, the Book activity must be placed immediately after it in the 
process flow.

The Book - Deferred activity calls the PL/SQL procedure named WF_ 
STANDARD.DEFER.

Defer activities defer the subsequent process thread to the background queue 
without requiring you to change the cost of each activity in that thread to a value 
above the Workflow Engine threshold. This activity always interrupts the process 
thread by causing a disconnect to occur in the current database session, even if the 
thread is already deferred.

The Book - Deferred activity is contained in the Seeded Data File oexwford.wft, and 
is associated with the OM Order Header item type.

Book - Eligible
To enable a function for manual completion, you must place a special block activity 
before the actual function activity. For booking, the Book - Eligible activity is the 
special block activity that facilitates manual booking.

A process will stop upon reaching the Book - Eligible activity. The Progress Order 
LOV on the Sales Order form will show you that this order is eligible for booking. 
You can book such an order either by selecting OK on the LOV, or by selecting Book 
on the Sales Order form.
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The Book - Eligible activity calls the PL/SQL procedure named OE_STANDARD_ 
WF.STANDARD_BLOCK.

The Book - Eligible activity is contained in the Seeded Data File oexwford.wft, and 
is associated with the OM Order Header item type.

Close
The Close activity calls the PL/SQL procedure named OE_CLOSE_WF.CLOSE_ 
ORDER to close an order. The Close activity uses the lookup OM Subprocess 
Results, Handles Holds. This lookup contains the following result codes:

■ Complete

■ Incomplete

■ On Hold

■ Not Eligible

The Close activity will complete with one of these results.

The Close activity is contained in the Seeded Data File oexwford.wft, and is 
associated with the OM Order Header item type.

Close - Wait for Line
An order cannot close until all of its lines have been closed. The Close - Wait for 
Line activity is an OM Order Header activity that uses standard Oracle Workflow 
functionality to pause the process until all line processes are complete. Close - Wait 
for Line marks the position in the process where, when all the lines are closed, the 
halted header level process will continue.

The Close - Wait for Line activity calls the PL/SQL procedure named WF_ 
STANDARD.WAITFORFLOW.

The Close - Wait for Line activity contains two activity attributes:

■ Continuation Activity

■ Continuation Flow

The Close - Wait for Line activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Header item type.

Enter
The Enter activity is an OM Order Header activity that is used to mark the start of 
an OM Order Header process. Enter is a Noop activity. A Noop activity acts as a 
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place holder activity that performs no action. You can use this activity anywhere 
you want to place a node without performing an action.

The Enter activity calls the PL/SQL procedure named WF_STANDARD.NOOP. The 
Enter activity is contained in the Seeded Data File oexwford.wft, and is associated 
with the OM Order Header item type.

Fulfill - Wait for Line
This activity is user in header level invoicing processes to halt invoicing until after 
all lines in an order are fulfilled. The Fulfill - Wait for Line activity is an OM Order 
Header activity that uses Oracle Workflow functionality to pause the process until 
all the order lines are fulfilled. Once fulfilled, the header level invoicing process can 
proceed with invoicing.

The Fulfill - Wait for Line activity calls the PL/SQL procedure named WF_ 
STANDARD.WAITFORFLOW.

The Fulfill - Wait for Line activity contains the following activity attributes:

■ Waiting Flow

■ Waiting Activity

The Fulfill - Wait for Line activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Header item type.

Header Invoice Interface - Eligible
To enable a function for manual completion, you must place a special block activity 
before the actual function activity. For header level invoice interface, the Header 
Invoice Interface - Eligible activity is the special block activity that facilitates this. 
The Header Invoice Interface - Eligible activity calls the PL/SQL procedure named 
OE_STANDARD_WF.STANDARD_BLOCK.

The Header Invoice Interface - Eligible activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Header item type.

Invoice Interface - Continue Line
The Invoice Interface - Continue Line activity is an OM Order Header activity that 
uses standard Oracle Workflow functionality to continue the workflow in progress. 
Invoice Interface - Continue Line marks the position in the process where, once 
invoice interface is complete, the line level process will continue.
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The Invoice Interface - Continue Line activity calls the PL/SQL procedure named 
WF_STANDARD.CONTINUEFLOW.

The Invoice Interface - Continue Flow activity contains two activity attributes:

■ Waiting Flow

■ Waiting Activity

The Invoice Interface - Continue Line activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Header item type.

Invoice Interface - Header Level
The Invoice Interface - Header Level activity is an OM Order Header activity that 
calls the PL/SQL procedure named OE_INVOICE_WF.INVOICE_INTERFACE to 
conduct header level invoice interfacing.

Invoice Interface - Header Level uses the lookup (has a result type of) Invoice

Results. This lookup contains the following result codes:

■ Complete

■ Incomplete

■ Not Eligible

■ On Hold

■ Partial

The Invoice Interface - Header Level activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Header item type.
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OM Order Line

Authorize to Ship - Check Status
The Authorize to Ship - Check Status activity is an OM Order Line activity that calls 
the PL/SQL procedure named OE_RLM_WF.CHECK_AUTHORIZE_TO_SHIP to 
determine whether an order line is authorized for shipping.

Authorize to Ship - Check Status uses the lookup (has a result type of) Yes/No. This 
lookup contains the following result codes:

■ Yes

■ No

The Authorize to Ship - Check Status activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Authorize to Ship - Wait for Authorization
The Authorize to Ship - Wait for Authorization activity is an OM Order Line activity 
that uses the Oracle Workflow block functionality to pause a process until 
authorization for shipping is determined. Authorize to Ship - Wait for 
Authorization marks the position in the process where, when the line is authorized, 
the halted process will continue.

The Authorize to Ship - Wait for Authorization activity calls the PL/SQL procedure 
named WF_STANDARD.BLOCK.

The Authorize to Ship - Wait for Authorization activity is contained in the Seeded 
Data File oexwford.wft, and is associated with the OM Order Line item type.

AutoCreate FAS
The AutoCreate FAS activity is an OM Order Line activity that calls the Oracle 
Configure to Order PL/SQL procedure named CTO_WORKFLOW.SUBMIT_CONC_ 
PROG_WF. This PL/SQL procedure submits a concurrent program to create a work 
order and reserve it to the order line

AutoCreate FAS contains the following attributes:

■ Arguments 11-100

■ Application Short Name
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■ Program Short Name

■ Number Of Arguments

■ Item Attribute Name

■ Order Number

■ Dummy Field

■ Offset Days

■ Load Type

■ Status Type

■ AFAS Org ID

■ Class Code

■ Failed Req ID

■ Order Line ID

■ Batch ID

The AutoCreate FAS activity uses the lookup (has a result type of) Concurrent 
Program Status. This lookup contains the following result codes:

■ Cancelled

■ Error

■ Normal

■ Terminated

■ Warning

The AutoCreate FAS activity is contained in the Seeded Data File oexwford.wft, and 
is associated with the OM Order Line item type.

AutoCreate PO Req
The AutoCreate PO Req activity is an OM Order Line activity that calls the Oracle 
Configure to Order PL/SQL procedure named CTO_WORKFLOW_API_PK.AUTO_ 
CREATE_PUR_REQ to place a record in the PO req interface tables for the order line. 
Requisition import creates a requisition and reserves it to the sales order line

The AutoCreate PO Req activity uses the lookup (has a result type of) Config 
Process Results. This lookup contains the following result codes:
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■ Complete

■ Incomplete

The AutoCreate PO Req activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Branch on Source Type
The Branch on Source Type activity is an OM Order Line activity that calls the 
PL/SQL procedure named OE_OEOL_SCH.BRANCH_ON_SOURCE_TYPE to 
determine source type for a line.

The Branch on Source Type activity uses the lookup (has a result type of) Source 
Type. This lookup contains the following result codes:

■ ATO Item

■ Build

■ Dropship

■ Stock

The Branch on Source Type activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Calculate Cost Rollup
The Calculate Cost Rollup activity is an OM Order Line activity that calls the CTO 
PL/SQL procedure named CTO_WORKFLOW.CALCULATE_COST_ROLLUP_WF_ML to 
calculate the cost of a configuration.

The Calculate Cost Rollup activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Calculate Lead Time
The Calculate Lead Time activity is an OM Order Line activity that calls the Oracle 
Configure to Order PL/SQL procedure named CTO_WORKFLOW.SUBMIT_AND_ 
CONTINUE_WF. This procedure calculates the actual lead time of a configuration and 
updates the lead time attributes on the item master in the organization where the 
configuration will be manufactured.

Calculate Lead Time contains the following attributes:

■ Arguments 13-100
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■ Application Short Name

■ Program Short Name

■ Number of Arguments

■ Item Attribute name

■ LT Org

■ BOM/ENG

■ Specific/Range

■ LT Item

■ Routing Revision

■ LT Date

■ From Item

■ To Item

■ LT Category Set Name

■ Category Structure

■ Category From

■ Category To

The Calculate Lead Time activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Calculate Lead Time - Setup Parameters
The Calculate Lead Time - Setup Parameters is an OM Order Line activity that calls 
the Configure to Order PL/SQL procedure named CTO_WORKFLOW.SET_ 
PARAMETER_LEAD_TIME_WF_ML to prepare to launch the lead time calculation 
concurrent program. This is accomplished by setting up the line number as the 
parameter of the concurrent program.

The Calculate Lead Time - Setup Parameters activity uses the lookup (has a result 
type of) Lead Time Result. This lookup contains the following result codes:

■ Complete

■ No Routing

The Calculate Lead Time - Setup Parameters activity is contained in the Seeded 
Data File oexwford.wft, and is associated with the OM Order Line item type.
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Calculate Purchase Price
The Calculate Purchase Price activity is an OM Order Line activity that calls the 
Oracle Configure to Order PL/SQL procedure named CTO_WORKFLOW.Purchase_ 
price_calc_wf to determine the purchase price of the configuration.

The Calculate Purchase Price activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Check Reservation
The Check Reservation activity is an OM Order Line activity that calls the Oracle 
Configure to Order PL/SQL procedure named CTO_WORKFLOW.RSV_BEFORE_ 
BOOKING_WF to check if a reservation exists before creating supply for the order 
line.

The Check Reservation activity uses the lookup (has a result type of) Reserved 
Status. This lookup contains the following result codes:            Process AutoCreate PO

■ Reserved

The Check Reservation activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Check Supply Type
The Check Supply Type activity is an OM Order Line activity that calls the Oracle 
Configure to Order PL/SQL procedure named CTO_WORKFLOW.CHECK_SUPPLY_ 
TYPE_WF to determine supply type for an order line.

The Check Supply Type activity uses the lookup (has a result type of) Check Supply 
Type Results. This lookup contains the following result codes:

■ Buy (in the shipping organization, the item has a planning type of buy, or buy 
type sourcing rules)

■ Drop Ship (order line has source type of External)

■ Flow Schedule (in the shipping organization, the item has a planning type of 
make or Make at Sourcing Rules, and the primary routing is flow routing)

■ Incomplete

■ Work Order (in the shipping organization, the item has a planning type of Make 
or Make at Sourcing Rules, and the primary routing is discrete routing)

The Check Supply Type activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.
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Close
The Close activity is an OM Order Line activity that calls the PL/SQL procedure 
named OE_CLOSE_WF.CLOSE_LINE to close an order line.

The Close activity uses the lookup (has a result type of) OM Subprocess Results, 
Handles Holds. This lookup contains the following result codes:

■ Complete

■ Incomplete

■ Not Eligible

■ On Hold

The Close activity is contained in the Seeded Data File oexwford.wft, and is 
associated with the OM Order Line item type.

Close - Continue Header
The Close - Continue Header activity is an OM Order Line activity that uses 
standard Oracle Workflow functionality to continue the workflow in progress. The 
Close - Continue Header activity is used to mark the position in the process where, 
upon completion the of Close activity, the halted header level process will continue. 
The Close - Continue Header activity calls the PL/SQL procedure named WF_ 
STANDARD.CONTINUEFLOW.

The Close - Continue Header activity contains the following attributes:

■ Waiting Activity

■ Waiting Flow

The Close - Continue Header activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Close - Deferred
The Close - Deferred activity is an OM Order Line activity that uses the standard 
Oracle Workflow defer functionality to defer the closing functionality to the 
background engine.

To use Close - Deferred, the Close activity must be placed immediately after it in the 
process flow.

The Close - Deferred activity calls the PL/SQL procedure named WF_ 
STANDARD.DEFER.
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The Close - Deferred activity is contained in the Seeded Data File oexwford.wft, and 
is associated with the OM Order Line item type.

Configuration - Check Status
The Configuration - Check Status activity is an OM Order Line activity that calls the 
Oracle Configure to Order PL/SQL procedure named CTO_WORKFLOW.CHECK_ 
RESERVATION_STATUS_WF to determine the status of configuration for an order 
line.

The Configuration - Check Status activity uses the lookup (has a result type of) 
Config Data Results. This lookup contains the following result code:

■ Config Data Created

The Configuration - Check Status activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Configuration - Create BOM and Routing
The Configuration - Create BOM and Routing activity is an OM Order Line activity 
that calls the Oracle Configure to Order PL/SQL procedure named CTO_ 
WORKFLOW.CREATE_BOM_AND_ROUTING_WF to create bill of material and routing 
for an order line.

The Configuration - Create BOM and Routing activity uses the lookup (has a result 
type of) Config Incomplete. This lookup contains the following result codes:

■ Complete

■ Incomplete

■ On Hold

The Configuration - Create BOM and Routing activity is contained in the Seeded 
Data File oexwford.wft, and is associated with the OM Order Line item type.

Create Configuration
The Create Configuration activity is an OM Order Line activity that calls the Oracle 
Configure to Order PL/SQL procedure named CTO_WORKFLOW.CREATE_CONFIG_ 

Note: This function activity is not used in current processes and 
subprocesses and is listed for reference only. Do not use this activity 
when creating or extending workflow processes and subprocesses.
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ITEM_WF to create configuration for an order line. This activity creates the new line 
on the order for the configuration item, creates the new item, and creates the BOM 
and Routing.

The Create Configuration activity uses the lookup (has a result type of) Config 
Incomplete. This lookup contains the following result codes:

■ Complete

■ Incomplete

■ On Hold

The Create Configuration activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Create Configuration - Eligible
The Create Configuration - Eligible activity is an OM Order Line block activity that 
holds the order line until the user progresses the order manually or runs the 
autocreate configuration batch program.

The Create Configuration - Eligible activity calls the PL/SQL procedure named OE_ 
STANDARD_WF.STANDARD_BLOCK.

The Create Configuration - Eligible activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Create Flow Schedule
The Create Flow Schedule activity is an OM Order Line activity that calls the Oracle 
Configure to Order PL/SQL procedure named CTO_WORKFLOW.CREATE_FLOW_ 
SCHEDULE_WF to create a flow schedule for an order line.

The Create Flow Schedule activity uses the lookup (has a result type of) Config 
Incomplete. This lookup contains the following result codes:

■ Complete

■ Incomplete

■ On Hold

The Create Flow Schedule activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.
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Create or Match Config Item
The Create or Match Config Item activity is an OM Order Line activity that calls the 
PL/SQL procedure named OE_SOURCING.CREATE_CONFIG_WF.

The Create or Match Config Item activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Create Supply Order - Eligible
The Create Supply Order - Eligible activity is an OM Order Line block activity that 
stops an order line workflow until the user progresses the order manually or runs 
the autocreate supply batch programs (Autocreate FAS, Autocreate Purchase Req, 
or Autocreate Dropship).

The Create Supply Order - Eligible activity calls the PL/SQL procedure named OE_ 
STANDARD_WF.STANDARD_BLOCK.

The Create Supply Order - Eligible activity uses the lookup (has a result type of) 
Reserved Status. This lookup contains the following result codes:

■ Process AutoCreate PO

■ Reserved

The Create Supply Order - Eligible activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Create Work Order - Set Up Parameters
The Create Work Order - Set Up Parameters activity is an OM Order Line activity 
that calls the PL/SQL procedure named CTO_WORKFLOW.SET_PARAMETER_WORK_ 
ORDER_WF to prepare to launch the autocreate supply batch programs by setting 
up the line number as the parameter to be used.

The Create Work Order - Set Up Parameters activity uses the lookup (has a result 
type of) Config Incomplete. This lookup contains the following result codes:

■ Complete

■ Incomplete

Note: This function activity is not used in current processes and 
subprocesses and is listed for reference only. Do not use this activity 
when creating or extending workflow processes and subprocesses.
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■ On Hold

The Create Work Order - Set Up Parameters activity is contained in the Seeded Data 
File oexwford.wft, and is associated with the OM Order Line item type.

End
The End activity marks the end of a process and does not perform any action. The 
End activity calls the PL/SQL procedure named WF_STANDARD.NOOP. The End 
activity is contained in the Seeded Data File oexwford.wft, and is associated with 
the OM Order Line item type.

End (Complete)
The End activity marks the end of a process and does not perform any action. 

The End (Complete) activity calls the PL/SQL procedure named WF_ 
STANDARD.NOOP.

The End (Complete) activity is contained in the Seeded Data File oexwford.wft, and 
is associated with the OM Order Line item type.

End (Incomplete)
The End (Incomplete) activity marks the end of a process and does not perform any 
action.

The End (Incomplete) activity calls the PL/SQL procedure named WF_ 
STANDARD.NOOP.

The End (Incomplete) activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

End (Non Shippable)
The End (Non Shippable) activity marks the end of a process and does not perform 
any action.

The End (Non Shippable) activity calls the PL/SQL procedure named WF_ 
STANDARD.NOOP.

The End (Non Shippable) activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.
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End (Not Eligible)
The End (Not Eligible) activity marks the end of a process and does not perform 
any action.

The End (Not Eligible) activity calls the PL/SQL procedure named WF_ 
STANDARD.NOOP.

The End (Not Eligible) activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

End (Over Shipped Beyond Tolerance)
The End (Over Shipped Beyond Tolerance) activity marks the end of a process and 
does not perform any action.

The End (Over Shipped Beyond Tolerance) activity calls the PL/SQL procedure 
named WF_STANDARD.NOOP.

The End (Over Shipped Beyond Tolerance) activity is contained in the Seeded Data 
File oexwford.wft, and is associated with the OM Order Line item type.

End (Ship Confirm)
The End (Ship Confirm) activity marks the end of a process and does not perform 
any action.

The End (Ship Confirm) activity calls the PL/SQL procedure named WF_ 
STANDARD.NOOP.

The End (Ship Confirm) activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

End (Unreserve)
The End (Unreserve) activity marks the end of a process and does not perform any 
action.

The End (Unreserve) activity calls the PL/SQL procedure named WF_ 
STANDARD.NOOP.

The End (Unreserve) activity is contained in the Seeded Data File oexwford.wft, and 
is associated with the OM Order Line item type.

Export Compliance Screening
Oracle Order Management provides a subprocess for export compliance screening, 
The Export Compliance Screening-Line is a subprocess to the seeded Line 
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Flow—Generic With Export Compliance workflow process, and executes 
International Trade Management functions. ITM handles all export related 
compliance checks, including Restricted Party Screening, Embargo Country 
Screening, License Determination, Document Generation and other partner 
supported screening such as EPCI.

It is recommended to add this subprocess after Scheduling.

The Export Compliance Screening activity calls the PL/SQL procedure named OE_ 
EXPORT_COMPLIANCE_WF.ECS_REQUEST.

The Export Compliance Screening activity uses the lookup (has a result type of) OM 
Export Compliance Results. This lookup contains the following result codes:

■ Complete

■ Hold Applied

■ Incomplete

■ Override

The Export Compliance Screening activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Export Compliance Screening - Eligible
The Export Compliance Screen - Eligible activity is an OM Order Line activity that 
determines export compliance.

The Export Compliance Screening - Eligible activity calls the PL/SQL procedure 
named OE_STANDARD_WF.STANDARD_BLOCK.

The Export Compliance Screening - Eligible activity is contained in the Seeded Data 
File oexwford.wft, and is associated with the OM Order Line item type.

Firm Demand
The Firm Demand activity is an OM Order Line activity that calls the PL/SQL 
procedure named OE_OEOL_SCH.FIRM_DEMAND to firm the order line.

The Firm Demand activity is contained in the Seeded Data File oexwford.wft, and is 
associated with the OM Order Line item type.
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Firm Eligible
The Firm Eligible activity is an OM Order Line activity that calls the PL/SQL 
procedure named OE_STANDARD_WF.STANDARD_BLOCK to determine 
whether an order line is eligible to be firmed.

The Firm Eligible activity is contained in the Seeded Data File oexwford.wft, and is 
associated with the OM Order Line item type.

Fulfill
The Fulfill activity is an OM Order Line activity that calls the PL/SQL procedure 
named OE_FULFILL_WF._FULFILLMENT to perform fulfillment for an order line. 
The Fulfill activity contains the following attributes:

■ Fulfillment Activity Name

■ Completion Result

■ Inbound Fulfillment Activity Name

■ Inbound Completion Result

The Fulfillment activity coordinates the fulfillment of lines so that they progress 
together to invoicing.  It applies to models and kits (shippable and 
non-shippable lines), fulfillment sets, and service lines attached to goods.  The 
Fulfill activity also derives and stores additional data needed for Oracle Daily 
Business Intelligence (DBI) and service lines.

The Fulfill activity is contained in the Seeded Data File oexwford.wft, and is 
associated with the OM Order Line item type.

Fulfill - Continue Header Flow
The Fulfill - Continue Header Flow activity is an OM Order Line activity that uses 
standard Oracle Workflow functionality to continue the workflow in progress after 
an order line is fulfilled. The Fulfill - Continue Header Flow activity is used to mark 
the position in the process where, upon completion the Fulfill activity by all lines, 
the halted header level process will continue.

The Fulfill - Continue Header Flow activity calls the PL/SQL procedure named WF_ 
STANDARD.CONTINUEFLOW.

The Fulfill - Continue Header Flow activity contains the following attributes:

■ Waiting Activity

■ Waiting Flow
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The Fulfill - Continue Header Flow activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Fulfill - Deferred
The Fulfill - Deferred activity is an OM Order Line activity that uses standard 
Oracle Workflow functionality to defer fulfillment to the background engine.

To use Fulfill - Deferred, the Fulfill activity must be placed immediately after it in 
the process flow.

The Fulfill - Deferred activity calls the PL/SQL procedure named WF_ 
STANDARD.DEFER.

The Fulfill - Deferred activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Inventory Interface
The Inventory Interface activity is an OM Order Line activity that calls the PL/SQL 
procedure named OE_INV_IFACE_WF.INVENTORY_INTERFACE to interface with 
Oracle Inventory to relieve reservations and demand for non-shippable order lines. 
The Inventory Interface activity uses the lookup (has a result type of) OM 
Subprocess Results, Handles Holds. This lookup contains the following result 
codes:

■ Complete

■ Incomplete

■ Not Eligible

■ On Hold

The Inventory Interface activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Inventory Interface - Deferred
The Inventory Interface - Deferred activity is an OM Order Line activity that uses 
standard Oracle Workflow functionality to defer inventory interface to the 
background engine.To use Inventory Interface - Deferred, the Inventory Interface 
activity must be placed immediately after it in the process flow.

The Inventory Interface - Deferred activity calls the PL/SQL procedure named WF_ 
STANDARD.DEFER.
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The Inventory Interface - Deferred activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Inventory Interface - Eligible
To enable a function for manual completion, you must place a special block activity 
before the actual function activity. For inventory interface, the Inventory Interface - 
Eligible activity is the special block activity that facilitates this.

The Inventory Interface - Eligible activity calls the PL/SQL procedure named OE_ 
STANDARD_WF.STANDARD_BLOCK.

The Inventory Interface - Eligible activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Invoice Interface
The Invoice Interface activity is an OM Order Line activity that calls the PL/SQL 
procedure named OE_INVOICE_WF.INVOICE_INTERFACE to interface with 
Oracle Receivables for an invoice.

The Invoice Interface activity uses the lookup (has a result type of) Invoice Results. 
This lookup contains the following result codes:

■ Complete

■ Incomplete

■ Not Eligible

■ On Hold

■ Partial

The Invoice Interface activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Invoice Interface - Deferred
The Invoice Interface - Deferred activity is an OM Order Line activity that uses 
standard Oracle Workflow functionality to defer the invoice interface with Oracle 
Receivables to the background engine.

To use Invoice Interface - Deferred, the Inventory Interface activity must be placed 
immediately after it in the process flow.

The Invoice Interface - Deferred activity calls the PL/SQL procedure named WF_ 
STANDARD.DEFER.
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The Invoice Interface - Deferred activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Invoice Interface - Eligible
To enable a function for manual completion, you must place a special block activity 
before the actual function activity. For invoice interface, the Invoice Interface - 
Eligible activity is the special block activity that facilitates this.

The Invoice Interface - Eligible activity calls the PL/SQL procedure named OE_ 
STANDARD_WF.STANDARD_BLOCK.

The Invoice Interface - Eligible activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Is Line Firmed
The Is Line Firmed activity is an OM Order Line activity that calls the PL/SQL 
procedure named OE_OEOL_SCH.IS_LINE_FIRMED to determine whether an 
order line is firmed.

The Is Line Firmed activity uses the lookup (has a result type of) OM SubProcess 
Results. The lookup contains the following result codes:

■ Incomplete

The Is Line Firmed activity is contained in the Seeded Data File oexwford.wft, and 
is associated with the OM Order Line item type.

Is Line Scheduled
The Is Line Scheduled activity is an OM Order Line activity that calls the PL/SQL 
procedure named OE_OEOL_SCH.IS_LINE_SCHEDULED to determine whether an 
order line is scheduled.

The Is Line Scheduled activity uses the lookup (has a result type of) OM Subprocess 
Results. This lookup contains the following result codes:

■ Complete

■ Incomplete

■ Not Eligible

The Is Line Scheduled activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.
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Purchase Release
The Purchase Release activity is an OM Order Line activity that calls the PL/SQL 
procedure named OE_OEOL_SCH.RELEASE_TO_PURCHASING to release order line 
data to Oracle Purchasing.

The Purchase Release activity uses the lookup (has a result type of) OM Subprocess 
Results, Handles Holds. This lookup contains the following result codes:

■ Complete

■ Incomplete

■ Not Eligible

■ On Hold

The Purchase Release activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Purchase Release - Deferred
The Purchase Release - Deferred activity is an OM Order Line activity that uses 
standard Oracle Workflow functionality to defer the release of order line data to 
Oracle Purchasing to the background engine.

To use Purchase Release - Deferred, the Purchase Release activity must be placed 
immediately after it in the process flow.

The Purchase Release - Deferred activity calls the PL/SQL procedure named WF_ 
STANDARD.DEFER.

The Purchase Release - Deferred activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Purchase Release - Eligible
To enable a function for manual completion, you must place a special block activity 
before the actual function activity. For purchase release, the Purchase Release - 
Eligible activity is the special block activity that facilitates this.

The Purchase Release - Eligible activity calls the PL/SQL procedure named OE_ 
STANDARD_WF.STANDARD_BLOCK.

The Purchase Release - Eligible activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.
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Reprice
The Reprice activity is an OM Order Line activity that calls the PL/SQL procedure 
named OE_REPRICE_WF.START_REPRICING to reprice an order line.

The Reprice activity contains the following attributes:

■ Repricing Date

■ Repricing Event

■ Honor Calculate Price Flag

The Reprice activity uses the lookup (has a result type of) OM Subprocess Results. 
This lookup contains the following result codes:

■ Complete

■ Incomplete

■ Not Eligible

The Reprice activity is contained in the Seeded Data File oexwford.wft, and is 
associated with the OM Order Line item type.

Reprice - Eligible
To enable a function for manual completion, you must place a special block activity 
before the actual function activity. For repricing, the Reprice - Eligible activity is the 
special block activity that facilitates this.

The Reprice - Eligible activity calls the PL/SQL procedure named OE_STANDARD_ 
WF.STANDARD_BLOCK.

The Reprice - Eligible activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Schedule
The Schedule activity is an OM Order Line activity that calls the PL/SQL procedure 
named OE_OEOL_SCH.SCHEDULE_LINE to schedule an order line.

The Schedule activity uses the lookup (has a result type of) OM Subprocess Results, 
Handles Holds. This lookup contains the following result codes:

■ Complete

■ Incomplete

■ Not Eligible
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■ On Hold

The Schedule activity is contained in the Seeded Data File oexwford.wft, and is 
associated with the OM Order Line item type.

Schedule - Deferred
The Schedule - Deferred activity is an OM Order Line activity that uses standard 
Oracle Workflow functionality to defer the order line scheduling to the background 
engine.

To use Schedule - Deferred, the Schedule activity must be placed immediately after 
it in the process flow.

The Schedule - Deferred activity calls the PL/SQL procedure named WF_ 
STANDARD.DEFER.

The Schedule - Deferred activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Schedule - Eligible
To enable a function for manual completion, you must place a special block activity 
before the actual function activity. For scheduling, the Schedule - Eligible activity is 
the special block activity that facilitates this.

The Schedule - Eligible activity calls the PL/SQL procedure named OE_STANDARD_ 
WF.STANDARD_BLOCK.

The Schedule - Eligible activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Ship
The Ship activity is an OM Order Line activity that calls the PL/SQL procedure 
named OE_SHIPPING_WF.START_SHIPPING to initiate shipping for an order line. 
The Ship activity uses the lookup (has a result type of) Shipping Results. This 
lookup contains the following result codes:

■ Non Shippable

■ Over Shipped Beyond Tolerance

■ Ship Confirm

■ Unreserve
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The Ship activity is contained in the Seeded Data File oexwford.wft, and is 
associated with the OM Order Line item type.

Ship - Deferred
The Ship - Deferred activity is an OM Order Line activity that uses standard Oracle 
Workflow functionality to defer shipping to the background engine.

To use Ship - Deferred, the Ship activity must be placed immediately after it in the 
process flow.

The Ship - Deferred activity calls the PL/SQL procedure named WF_ 
STANDARD.DEFER.

The Ship activity is contained in the Seeded Data File oexwford.wft, and is 
associated with the OM Order Line item type.

Start
The Start activity marks the start of a process and does not perform any action. 
Although it is not necessary, you may include it in your process diagram to visually 
mark the start of a process as a separate node.

The Start activity calls the PL/SQL procedure named WF_STANDARD.NOOP. The 
Start activity is contained in the Seeded Data File oexwford.wft, and is associated 
with the OM Order Line item type.

Utility - Is Return Line Receivable?
The Utility - Is Return Line Receivable? activity is an OM Order Line activity that 
calls the PL/SQL procedure named OE_RMA_WF.IS_LINE_RECEIVABLE to 
determine whether an return order line must be received.

The Utility - Is Return Line Receivable? activity uses the lookup (has a result type 
of) Yes/No. This lookup contains the following result codes:

■ Yes

■ No

The Utility - Is Return Line Receivable? activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Utility to Get Line Category
The Utility to Get Line Category activity is an OM Order Line activity that calls the 
PL/SQL procedure named OE_STANDARD_WF.GET_LINE_CATEGORY to determine 
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the category of an order line. An order line can either be an order or a return. The 
Utility to Get Line Category activity uses the lookup (has a result type of) Line 
Category. This lookup contains the following result codes:

■ Order

■ Return

The Utility to Get Line Category activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Utility to Get Supply Source Type
The Utility to Get Supply Source Type is an OM Order Line activity that calls the 
PL/SQL procedure named OE_STANDARD_WF.GET_SUPPLY_SOURCE_TYPE to 
determine the supply source type for an order line. A supply source can be either 
internal or external.

The Utility to Get Supply Source Type activity uses the lookup (has a result type of) 
Supply Source Type. This lookup contains the following result codes:

■ Internal

■ External

The Utility to Get Supply Source Type activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Wait for Approval
The Wait for Approval activity is an OM Order Line activity that ensures an 
unapproved order does not proceed in its workflow process. The Wait For Approval 
activity uses standard Oracle Workflow functionality to pause the process until the 
order line is approved. Wait for Approval marks the position in the process where, 
when all the order line is approved, the halted process will continue.

The Wait for Approval activity calls the PL/SQL procedure named WF_ 
STANDARD.WAITFORFLOW.

The Wait for Approval activity contains the following attributes:

■ Continuation Activity

■ Continuation Flow

The Wait for Approval activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.
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Wait for Booking
The Wait for Booking activity is an OM Order Line activity that ensures an order 
line does not proceed in its workflow process until the order is booked. The Wait 
For Booking activity uses standard Oracle Workflow functionality to pause the 
process until the order is booked. Wait for Booking marks the position in the 
process where, when the order is booked, the halted line level process will continue. 
The Wait for Booking activity calls the PL/SQL procedure named WF_ 
STANDARD.WAITFORFLOW.

The Wait for Booking activity contains the following attributes:

■ Continuation Activity

■ Continuation Flow

The Wait for Booking activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Wait for Create Configuration
The Wait for Create Configuration activity is an OM Order Line activity which 
verifies that the configuration manufacturing data subprocess performs its 
calculations only when necessary. It is not necessary to perform these calculations if 
the configuration data is already created by the autocreate config batch program. If 
this is the case, the subprocess would end.

Wait for Create Configuration calls the PL/SQL procedure named WF_ 
STANDARD.BLOCK.

The Wait for Create Configuration activity uses the lookup (has a result type of) 
Config Data Results. This lookup contains the following result codes:

■ Config Data Created

The Wait for Create Configuration activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Wait for CTO
The Wait for CTO activity is an OM Order Line activity which verifies that an ATO 
Model order line does not proceed in its workflow process until the configuration 
line level process associated with the model line is complete. The configuration line 
level process completes when the configuration ships. The Wait For CTO activity 
uses standard Oracle Workflow functionality to pause the process until these results 
are received. Wait for CTO marks the position in the process where, when the 
results are received, the halted process will continue.
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Wait for CTO calls the PL/SQL procedure named WF_STANDARD.BLOCK.

The Wait for CTO activity uses the lookup (has a result type of) Config Item Results. 
This lookup contains the following result codes:

■ Complete

■ De-link

The Wait for CTO activity is contained in the Seeded Data File oexwford.wft, and is 
associated with the OM Order Line item type.

Wait for Inspection
The Wait for Inspection activity is an OM Order Line activity that ensures an order 
line does not proceed in its workflow process until the returned item is inspected. 
The Wait For Inspection activity uses standard Oracle Workflow functionality to 
pause the process. Wait for Inspection marks the position in the process where, 
when the item is inspected, the halted process will continue.

The Wait for Inspection activity calls the PL/SQL procedure named WF_ 
STANDARD.BLOCK.

The Wait for Inspection activity uses the lookup (has a result type of) RMA Wait 
Result. This lookup contains the following result codes:

■ Complete

■ Correct Receiving

The Wait for Inspection activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Wait for Invoice Interface
The Wait for Invoice Interface activity is an OM Order Line activity that ensures an 
order line does not proceed in its workflow process until the invoice interface with 
Oracle Receivables is performed. The Wait For Invoice Interface activity uses 
standard Oracle Workflow functionality to pause the process. Wait for Invoice 
Interface marks the position in the process where, after invoice interface is 
complete, the halted process will continue.

The Wait for Invoice Interface activity calls the PL/SQL procedure named WF_ 
STANDARD.WAITFORFLOW.

Wait for Invoice Interface contains the following attributes:

■ Continuation Activity
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■ Continuation Flow

The Wait for Invoice Interface activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Order Line item type.

Wait for PO Receipt
The Wait for PO Receipt activity is an OM Order Line activity that ensures an order 
line does not proceed in its workflow process until Oracle Purchasing returns a 
receipt for the order line. The Wait For PO Receipt activity uses standard Oracle 
Workflow functionality to pause the process. Wait for PO Receipt marks the position 
in the process where, when the receipt is received, the halted process will continue. 
The Wait for PO Receipt activity calls the PL/SQL procedure named OE_ 
STANDARD_WF.STANDARD_BLOCK.

The Wait for PO Receipt activity uses the lookup (has a result type of) Config 
Process Results. This lookup contains the following result codes:

■ Complete

■ Incomplete

The Wait for PO Receipt activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.

Wait for Receiving
The Wait for Receiving activity is an OM Order Line activity that ensures an order 
line does not proceed in its workflow process until the returned item is received. 
The Wait For Receiving activity uses standard Oracle Workflow functionality to 
pause the process. Wait for Receiving marks the position in the process where, 
when the item is received, the halted process will continue.

The Wait for Receiving activity calls the PL/SQL procedure named OE_RMA_ 
WF.WAIT_FOR_RECEIVING.

The Wait for Receiving activity uses the lookup (has a result type of) OM 
Subprocess Success Results. This lookup contains the following result codes:

■ Complete

■ Incomplete

■ Not Eligible

The Wait for Receiving activity is contained in the Seeded Data File oexwford.wft, 
and is associated with the OM Order Line item type.
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Wait for Required for Revenue or Delivery
The Wait for Required for Revenue or Delivery activity is an OM Order Line activity 
that ensures an order line does not proceed in its workflow process until the order 
line is invoiced. The Wait For Revenue or Delivery activity uses standard Oracle 
Workflow functionality to pause the process. Wait for Revenue or Delivery marks 
the position in the process where the halted process will continue.

The Wait for Required for Revenue or Delivery activity calls the PL/SQL procedure 
named WF_STANDARD.BLOCK.

The Wait for Required for Revenue or Delivery activity is contained in the Seeded 
Data File oexwford.wft, and is associated with the OM Order Line item type.

OM Standard

OM Standard

Approvals
A workflow process for Approvals allows you to leverage any business process 
where Approvals may be required. The Approver list is set up in Oracle Order 
Management and tied to a specific transaction type; workflow notifications provide 
details of the approval or rejection.The Approval activity is seeded in the 
negotiation phase as well as in the Oracle iStore Returns flow. A list of approvers 
can be defined through the Transaction Types or Approvals window, which can be 
accessed from the Transaction Types window or the Transaction Types menu.

Utility - Set Notification Approver
The Utility - Set Notification Approver activity calls the PL/SQL procedure named 
OE_ORDER_WF_UTIL.SET_NOTIFICATION_APPROVER to determine the approver 
for the notification located immediately after this activity in a workflow process. 

The Utility - Set Notification Approver activity contains the following attribute:

■ Source (used to select the notification approver)

The Utility - Set Notification Approver activity is contained in the Seeded Data File 
oexwford.wft, and is associated with the OM Standard item type
Seeded Function Activity Definitions 6-31



Standard
Standard

Standard
Oracle Workflow provides some generic activities you can use to control your 
processes. The activities are associated with the Standard item type but can be used 
within any process you define. The Standard item type is automatically installed on 
your Oracle Workflow server. The following are the Standard activities used by 
Oracle Order Management. For more information about the Oracle Workflow 
Standard activities, refer to the Oracle Workflow User’s Guide.

End
The End activity marks the end of a process and does not perform any action. You 
can use it to return a result for a completed process by specifying a Result Type for 
the activity. Although it is not necessary, you may include it in your process 
diagram to visually mark the end of your process as a separate node.

The End activity calls the PL/SQL procedure named WF_STANDARD.NOOP.

Start
The Start activity marks the start of a process and does not perform any action. 
Although it is not necessary, you may include it in your process diagram to visually 
mark the start of a process as a separate node.

The Start activity calls the PL/SQL procedure named WF_STANDARD.NOOP.

Wait
The Wait activity pauses the process for the time you specify. You can wait until:

■ A specific date

■ A given day of the month

■ A given day of the week

■ A period of time after this activity is encountered

The Wait activity has six activity attributes:

1. Wait Mode: use this attribute to specify how to calculate the wait. You can 
choose one of the following wait modes:

■ Absolute Date: to pause the activity until the date specified in the Absolute 
Date activity attribute is reached.
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■ Relative Time: to pause the activity until the number of days specified in the 
Relative Time activity attribute passes.

■ Day of Month: to pause the activity until a specified day of the month, as 
indicated in the Day of Month activity attribute.

■ Day of Week: to pause the activity until a specified day of the week, as 
indicated in the Day of Week activity attribute.

2. Absolute Date: if Wait Mode is set to Absolute Date, enter an absolute date.

3. Relative Time: if Wait Mode is set to Relative Time, enter a relative time 
expressed in <days>.<fraction of days>. For example, enter 0.5 for a wait time 
of half a day (12 hours).

4. Day of Month: If Wait Mode is set to Day of Month, choose a day of the month 
from the list. If the day you choose has already passed in the current month, 
then the activity waits until that day in the following month.

5. Day of Week: If Wait Mode is set to Day of Week, choose a day of the week from 
the list. If the day you choose has already passed in the current week, then the 
activity waits until that day in the following week.

6. Time of Day: The Wait activity always pauses until midnight of the time 
specified, unless you use this Time of Day activity attribute to specify a time 
other than midnight that the Wait activity should pause until.

The Wait activity calls the PL/SQL procedure named WF_STANDARD.WAIT.

Negotiation

Negotiation
The following are identified as status requirements for the negotiation phase that is 
applicable to both Quotes in Sales Orders as well as Blanket Sales Agreements.

Approved
This signifies the sales proposal has received internal approval, by all approvers. 
The version that has been approved should be exactly what is presented to the 
customer for acceptance, otherwise if changes are made, the document should 
go through approval again.
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Approval Timeout
The proposal has not been approved or rejected and has reached the timeout 
point.

Assign
The offer is assigned to the first approver.

Customer Acceptance
This activity enables the customer to choose whether to accept or reject the 
proposal.

Customer Accepted
This signifies that the proposal has received the customer’s approval and is 
accepted by the customer. Typically, the proposal should not be modified once 
the customer has accepted it. You must set this up with processing constraints. 
This includes the sign and counter sign process.

See Change Management in the Oracle Order Management Implementation Guide for 
more information on Processing Constraints.

Customer Rejected
This signifies that the proposal has been received and the customer has rejected 
the proposal.

Draft
When a quote is created and is being assembled and negotiated, it is being 
'drafted'; the document has not been approved internally or accepted by the 
customer yet, and is therefore not in effect yet. Changes can be made to a draft 
document and there are no formal change approvals required.

Draft-Customer Rejected
If the customer rejects the sales proposal, it returns to the “Draft” activity. The 
status is updated to Draft-Customer Rejected.

Draft-Internal Rejected
A sales proposal in the internal approval process that is rejected returns to the 
“Draft” status. It will return to the same activity in the flow as when it was in the 
“Draft” status, but the status will be update to “Draft-Internal Rejected” The 
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rejection reason (comments) should be viewable so that modifications can be 
made, and the document can be re-submitted for approval.

Get Next Approver
The next approver in the list of approvers is notified that the proposal approval 
has been sent to them and action is required.

Initiate Approval
The proposal approval time has begun.

Internal Approved
The proposal has been approved. (See Approval List setup for a list of Internal 
Approvers).

Internal Rejected
The proposal has been rejected.

Negotiation Complete
This status indicates that the negotiation is complete.

Negotiation Complete - Eligible
This status indicates that the negotiation is eligible to be completed.

Negotiation Lost
This status signifies that the proposal has been lost. Neither the Internal 
management nor the Customer was able to reach an agreement. The proposal 
can only be transitioned to Lost if it is in the Draft stage. Once the proposal has 
been transitioned to Lost, it cannot be reinstated. However, it can be copied to 
restart the negotiation process.

Offer Expired
A Quote (negotiation) can have an expiration date. When the quote reaches this 
date, it expires and cannot become a firm order. To use it again, you must copy 
the quote. This status does not apply to blanket sales agreements.
Seeded Function Activity Definitions 6-35



Negotiation
Pending Customer Acceptance
Once the sale proposal is approved internally, it waits at the customer 
acceptance block. The status is updated to “Pending Customer Acceptance” to 
signify that the proposal is waiting for customer acceptance.

Pending Internal Approval
When a proposal is sent for internal approval, the document is awaiting 
approval. If there were multiple approvers in an approval chain, the document 
would stay in “Pending Approval” status until all approvers have approved the 
document, or until someone rejects the document. Typically once the document 
has entered the approval process, no changes are allowed.

Submit Draft
The Draft phase of the quote has been completed and submitted for further 
processing.

Submit Draft - Eligible
The Draft phase of the quote has started and is eligible.

Quotes

Check Expiration Date
The offer Expiration Date is checked to see if it exists, does not exist, or if it has 
already expired.

Set Final Expiration Date
If an Expiration Date exists, Set Final Expiration Date will activate and set the final 
expiration date for the proposal.

Wait for Expiration
The proposal final expiration date has been set and the system is waiting for the 
expiration of the proposal.

Wait for Final Expiration
Final expiration has been determined and the system is waiting for that expiration 
to occur.
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Blanket Sales Agreements

Blanket Sales Agreements
The following are the statuses for Blanket Sales Agreements (BSA) that are needed 
in addition to the negotiation phase statuses.

Enter—Blanket
If the BSA did not start from the negotiation phase but began with the fulfillment 
phase, then the BSA will have an Entered status as the first status.

Check Negotiation Exists
Check Negotiation Exists executes a search to ensure that negotiation exists for the 
blanket sales agreement.

Blanket Submit Draft - Eligible
The blanket draft is eligible for submission.

Blanket Submit Draft
The blanket draft is ready to be submitted.

Calculate Effective Dates
Blanket effective dates are calculated.

Fulfillment

Execute Blanket
The blanket execution is ready.

Wait for Start Date
The effective date of the blanket has not yet passed. The blanket is waiting to 
become active.

Blanket Active - Wait for Expiration
The blanket sales agreement is active, but the expiration date has not yet passed.
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Blanket Active - Wait for Final Expiration
The blanket sales agreement is active, but the final expiration date has not yet 
passed.

Blanket Active - No End Date
The blanket sales agreement is active with no end date specified.

Blanket - Expired
When an agreement reaches its end-date (Effective End Date Reached), it 
expires.

Close - Blanket
The blanket sales agreement has expired and is ready to be closed.

Close Blanket - Eligible
The blanket sales agreement is eligible to be closed.

Terminate—Blanket
When a BSA is in effect (active) either the customer or the supplier may 
terminate the BSA. Typically there are termination clauses in the contract 
specifying who can terminate, when, and under what conditions penalties will 
apply. Draft or approved proposals cannot be terminated.

Awaiting Start Date
The Effectivity start date of the BSA has not yet occurred. This status can also 
occur when Negotiation—Customer Acceptance is met but the start date has not 
yet occurred. This status is also applicable if the BSA is entered from the 
Fulfillment phase, is at Submit-Draft, and the start date has not yet occurred.

Blanket—Active
After the proposal has been signed by both the parties, and the effective date has 
been reached, the BSA reaches Blanket—Active status when the start date is 

Note: The Effective End Date can be extended and the BSA 
returned to Active status. If you do not want any changes made to 
an expired BSA, configure a processing constraint accordingly.
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reached. For a BSA that begins in the Negotiation phase, Customer Acceptance 
must also be reached. Note that for Fulfillment there is no formal acceptance—a 
signature is not required.
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Windows and Navigator Paths

This appendix discusses windows and navigator paths associated with using Oracle 
Workflow in Oracle Order Management. The following topics is addressed: 

■ Windows and Navigator Paths on page A-2
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The following table lists the navigation path for windows accessible through Oracle 
Order Management:

Window Name Navigation Path

Application Utilities: ITEM_TYPE 
Lookups

Setup > Items > Item Types

Application Utilities: ITEM_TYPE 
Lookups

(INV)

Setup > Items > Item Types

Application Utilities: Order 
Management

Setup > QuickCodes > Order Management 

ATO Configured Item Orders, Returns > Sales Orders > Line Items Tab >  
Configurator 

AutoCreate Configuration Items Reports, Requests Reports > Run Requests [OK] > 
AutoCreate Configuration Items

AutoCreate Final Assembly Orders Reports, Requests Reports > Run Requests [OK] > 
AutoCreate Final Assembly Orders

Book Order Orders, Returns > Sales Orders > [Book Order]

Business Purposes Customers > Standard > (Addresses) > [Open] > 
(Business Purposes) 

Cancel Orders Orders, Returns > Orders Organizer > Order 
Information > [Actions] > Cancel

Cancel Lines Orders, Returns > Orders Organizer >Lines Tab > 
[Actions] > Cancel

Configurator Orders, Returns > Orders Organizer > [Find] > Sales 
Orders > Lines tab > [Configurator] 

Orders, Returns > Sales Orders >Lines Tab> 
[Configurator]

Export Compliance Workbench Orders, Returns > Export Compliance > Export 
Compliance Workbench

Export Compliance Screening 
Concurrent Program

Reports, Requests > Export Compliance Screening

Enable Parameters Setup > Parameters
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Find Holds Orders, Returns > Order Organizer > [Find Orders] 
> Order Information Tab > [Find]

or 

Orders, Returns > Order Organizer > Hold 
Information Tab > [Find}

Find Items Items > Item Search > [Find] > Item Search

Find Order and Line Approvals Orders, Returns > Order Organizer > Tools Menu > 
Workflow Monitor

Find Orders Orders, Returns > Orders Organizer

Holds Setup > Orders > Holds

Holds (Line) Orders, Returns > Orders Organizer > Lines Tab > 
Tools Menu> Create Hold Sources> [Apply Holds]

or

Orders, Returns > Sales Orders > Lines Tab > Tools 
Menu > Create Hold Sources > [Apply Holds]

Inventory Interface Shipping > Interfaces > Inventory Interface SRS

Inventory Interface - No Ship Report, Requests > Run Requests > [OK] > 
Inventory Interface - No Ship

Item Assignment Setup > Items > Categories > Category Sets > 
[Assign]

Item Attribute Controls Setup > Items > Attribute Controls

Item Attributes Items > Item Information > [Attributes]

Line Information Orders, Returns > Order Organizer > [Actions] > 
Line Information Tab

Notification Orders, Returns > Order Organizer > [Actions] > 
Notification

Notifications (Approval) Workflow Notifications > Worklist

Notifications List Orders, Returns > Order Organizer > [Find] > Sales 
Orders > Tools Menu > Workflow Status

Oracle Pricing Lookups Pricing > Lookups

Oracle Receivables Lookup Setup > QuickCodes > Receivables

Order Details Order Information User: Order Status: Run a Simple 
or Advanced Search: Click a Sales Order Number

Window Name Navigation Path
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Order Line Sort Criteria Orders, Returns > Sales Orders > Lines Tab > 
Folders Menu > Sort Data

Order Management Lookup Setup > QuickCodes > Order Management

Purge Messages Orders, Returns > Purge Messages

Release Expired Holds Reports, Requests > Run Requests > [OK] > Release 
Expired Holds

Release Holds Orders, Returns > Order Organizer > [Find Orders] 
> Hold Information Tab > Release Sources > Release 
Tab Release

Release Sources (Holds) Orders, Returns > Holds > Release > [Hold Sources]

Requisition Import Orders, Returns > Requisition Import or 

Reports, Returns > Run Requests > [OK] > 
Requisition Import

Rollup Groups Setup > Financials > Flexfields > Key > Groups > 
[Find]

Sales Orders Orders, Returns > Sales Orders OR

Orders, Returns > Orders Organizer > [New Order]

Schedule Orders Orders, Returns > Sales Orders > Tools Menu > 
Schedule > Scheduling Actions > [Schedule...] 

or 

Orders, Returns > Sales Orders > Lines Tab > 
Shipping Tab > Scheduled Ship Date

or 

Orders, Returns > Schedule Order

Scheduling Actions Orders, Returns > Sales Orders > Tools Menu > 
Scheduling

Security Rules Setup > Rules > Security

Service Interface Orders, Returns > Service Interface

Shipping Tolerances Setup > Shipping Tolerances

Shipping Transactions Shipping > Transactions

Skip Screening ITM Adapter > Administration > Skip Screening

Transaction Types Setup > Transaction Types > Define

Window Name Navigation Path
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Transaction Types Setup > Financials > Transaction Types

Usage Rules Setup > Credit > {Find} Assign Usage Rules

View Cycle Status and Approval 
History

Orders, Returns > Order Organizer or Sales Orders > 
Query orders > [Actions] > Viewing Cycle Status 
and Approval History

View Bills of Material Bills > Bills

View Hierarchies Setup > Financials > Validation > Value > [Find] > 
[View Hierarchies]

View Holds Orders, Returns > Orders Organizer > [Find Orders] 
>Holds Tab> [Find] > [View Holds]

View Orders Orders, Returns > Order Organizer > [Find Orders] 
> Order Information Tab

View Order Info Orders, Returns > Order Organizer > [Find Orders] 
> Order Information Tab

Workflow Notification WF Notifications

Workflow Status Tools > Workflow Status

Window Name Navigation Path
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Troubleshooting

This chapter discusses troubleshooting when using Oracle Workflow in Oracle 
Order Management. The following topics are addressed: 

■ Expected Errors on page B-2

■ Unexpected Errors on page B-3
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Expected Errors
There are two error types that can occur in order and line flows: unexpected errors 
and expected errors. Expected errors are errors that business processes anticipate. 
For example, booking requires that a customer is specified on the order. If you 
attempt to book an order that does not specify a customer, the order will not book. 
The Book activity will end with a result of Incomplete.

Other examples of expected errors include the following:

■ A line is on hold and cannot be invoice interfaced.

■ Booking cannot complete because no price list is specified on the order.

To anticipate these errors, activities are set to end with a ON_HOLD result if it 
cannot complete because of a hold, or end with an INCOMPLETE result. The flow 
must then transition to a block (which can be completed from the Sales Order 
window) or to a wait activity. 

For example, the invoicing activity finds a hold on a line. The activity posts a 
message indicating the line is on hold and then completes to the Wait activity with 
an ON_HOLD result. The Wait activity is set to wait for a response for eight hours. 
After eight hours it transitions back to the invoicing activity. 

As another example, the booking activity finds a hold on an order. The activity 
posts a message indicating that the order is on hold and then completes to the 
booking eligibility block with an ON_HOLD result.

When an activity is completed via the Sales Order window, the Processing Messages 
window appears to display messages that indicate errors. 

When an activity is process by the Background Engine (the activity is deferred), 
error messages are stored in the Oracle Order Management processing message 
table. View these messages via the Processing Message window using the 
concurrent program request number, the workflow activity, and/or order or line 
basis.

Repricing Errors
You can still reprice an order line if Reprice - Line encounters an expected error, 
such as an invalid repricing event or pricing engine failure to locate a price list. 
Complete the following steps to reprice a line that failed the Reprice activity:

1. Navigate to the Sales Order Process Messages window to view the error 
condition.
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2. Correct the error condition.

3. Navigate to the Sales Order window and query the order where the repricing 
error occurred.

4. Select the Lines tab and locate the line with the repricing error.

5. Select the line, select Actions, and then select Progress Order. 

6. Select Reprice Eligible from the menu to reprice the line again.

7. Repeat Steps 1 through 6 until the error is resolved.

8. Save your work.

Errors Viewing Workflow Status From Within Oracle Order Management
If you encounter an error when trying to view workflow processes from within 
Oracle Order Management, your Oracle Workflow setup or your browser setup on 
your computer could be incorrect. For more information about workflow viewing 
problems from within Oracle Applications, refer to the Oracle Workflow User’s Guide.

Unexpected Errors
Unexpected errors are those that an Oracle Order Management function activity 
does not anticipate. Causes of unexpected errors can include the following:

■ Data integrity errors

■ The table does not exist

■ Rollback segments cannot be extended

■ The package does not exist

To avoid unexpected errors, specify an error process when defining function 
activities and processes. All seeded Oracle Order Management function activities 
and process have a specified error process.

The default error process, Retry Only, is a seeded Oracle Workflow error process. 
The activity that encountered an unexpected error is marked with an Error status 
(in WF_ITEM_ACTIVITY_STATUSES) and a notification listing the error details is 
sent to the role specified in the OM Workflow Administrator item attribute. The 
Role item attribute WF_ADMINISTRATOR is defined for the header and line work 
item, and is set as SYSADMIN. The error process sends notifications about the error 
to this role. 
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Once the problems have been corrected, the administrator can select the Retry 
option on the notification and complete it. This initiates a retry of the activity in 
error. The administrator can also opt to retry the activity from the Workflow 
Monitor. 

For more information on setting the OM Workflow Administrator item attribute, 
refer to Assigning Workflows to Transaction Types.
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access level

A numeric value ranging from 0 to 100 that represents who the data is protected 
from for modification. When workflow data is defined, it can either be set to 
customizable (1000), meaning anyone can modify it or it can be assigned a 
protection level that is equal to the access level of the user defining the data. In the 
latter case, only users operating at an access level equal to or lower than the data’s 
protection level can modify the data.

activity

A unit of work performed during a business process.

activity attribute 

A parameter for an Oracle Workflow function activity that controls how the 
function activity operates. You define an activity attribute by displaying the 
activity’s Attributes properties page in the Activities window of Oracle Workflow 
Builder. You assign a value to an activity attribute by displaying the activity node’s 
Attribute Values properties page in the Process window. 

activity (item type, name, version) 

An Activity is the definition of a unit of work performed in the course of a business 
process. All activities are associated with an Item Type, and are identified by name. 
Rows in this table represent the re-usable portion of the activity definition. 
Additional properties are associated with activities per usage in a process.   
Multiple versions of an activity definition are maintained in this table, which enable 
definitions to be updated without disturbing processes that are in progress. 
Activities must be one of three types: function, notification, or process. Function 
Activities are defined by a PL/SQL function executed directly by the workflow 
engine. Function activities are used to perform fully automated steps in the process. 
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The defining PL/SQL functions accept standard arguments and return a completion 
result. Functions have a cost which indicates the amount of work the function 
represents. Notification Activities are completed by some external entity (e.g. 
human). These activities have a “notification function” which is run to signal the 
external entity of its need to perform a task. Human notifications are associated 
with a Message defined in the Notification system. All notification activities may 
have a time-out limit within which the activity must be performed. Process 
Definitions are also modeled as activities, which can then be referenced by other 
processes. The network of activities and transitions that define the process are 
maintained by in the Process Activities and Activity Transitions tables.

approval 

A positive response to a notification.

archive 

Data Repository for non-live orders. Historical data that is independent from the 
live standing and transaction data.

assemble-to-order (ATO) 

An environment where you open a final assembly order to assemble items that 
customers order. Assemble-to-order is also an item attribute that you can apply to 
standard, model, and option class items.

assemble-to-order (ATO) item 

An item you make in response to a customer order.

assemble-to-order (ATO) model

A configuration you create for customer order that includes optional items. 

assembly   

An item that has a bill of materials. You can purchase or manufacture an assembly 
item. See assemble-to-order, bill of materials.

ATO

See assemble-to-order.

ATO item

See assemble-to-order item.
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ATO model

See assemble-to-order model.

ATP

See available to promise.

attribute 

See activity attribute, item type attribute, or message attribute.

authorization 

The act of marking a notification as approved or not approved. This would release 
or confirm a hold on an Order.

authorized quantity 

The authorized quantity is how many of an item that can be sent back to the 
warehouse from the customer. This is the booked quantity. 

AutoInvoice 

A program that imports invoices, credit memos, and on account credits from other 
systems to Oracle Receivables.

Available To Promise (ATP)

The quantity of on-hand stock, outstanding receipts and planned production which 
are not committed through a reservation or placing demand. In Oracle Inventory, 
you define the types of supply and demand that should be included in your ATP 
calculation. 

background engine

A supplemental Oracle Workflow engine that processes deferred or timed out 
activities.

bill of materials

A list of component items associated with a parent item and information about how 
each item relates to the parent item. Oracle Manufacturing supports standard, 
model, option class, and planning bills. The item information on a bill depends on 
the item type and bill type. The most common type of bill is a standard bill of 
material. A standard bill of material lists the components associated with a product 
or subassembly. It specifies the required quantity for each component plus other 
information to control work in process, material planning, and other Oracle 
Manufacturing functions. 
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booking   

An action on an order signifying that the order has all the necessary information to 
be processed through its order flow. 

closed order   

An order and its order lines that have completed all activities in its process flow and 
for which the close activity is complete.

concurrent process 

A task in the process of completing. Each time you submit a task, you create a new 
concurrent process. A concurrent process runs simultaneously with other 
concurrent processes to help you complete multiple tasks at once with no 
interruptions to your terminal.

config item 

An item which represents a unique configuration of model (ATO) and it’s classes 
and options. A customer will enter his choice of classes and options for a given ATO 
model. This valid configuration of selected items is represented by a config item. A 
config item goes through the manufacturing process cycle, and is a shippable item.

configuration   

A product a customer orders by choosing a base model and a list of options. It can 
be shipped as individual pieces as a set (kit) or as an assembly (configuration item). 

configuration bill of materials 

The bill of materials for a configuration item.

configuration item 

An item that corresponds to a base model and a specific list of options. Bills of 
Materials create configuration items for assemble-to-order models.

configurator   

A window that enables you to choose options available for a particular model to 
define a particular configuration for the model.

configure-to-order   

An environment where you enter customer orders by choosing a base model and 
then selecting options from a list of choices.
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cost 

A relative value that you can assign to a function or notification activity to inform 
the Workflow Engine how much processing is required to complete the activity. 
Assign a higher cost to longer running, complex activities. The Workflow Engine 
can be set to operate with a threshold cost. Any activity with a cost above the 
Workflow Engine threshold cost gets set to Deferred and is not processed. A 
background engine can be set up to poll for and process deferred activities.

credit check   

A process that enables you to control the risk incurred when generating orders for 
your customers. Credit Checking is a feature of Oracle Receivables that enables 
Order Management to automatically checks a customer order total against pre-
defined order and total order limits. If an order exceeds either limit, Oracle Order 
Management places the order on hold for review. 

credit order type 

This is any header level transaction type that allows for return lines. The type is 
used to specify defaulting values for this credit order and an associated workflow. 

delivery 

A set of order lines to be shipped to a customer’s ship-to location on a given date in 
a given vehicle. Multiple deliveries can be grouped into a single departure. A single 
delivery may include items from different sales orders and may include back orders 
as well as regular orders. 

delivery date

The date on which the product is to arrive at the Ship-To Location. This date is 
either specified by the customer on a delivery-based demand transaction, or 
calculated by applying in-transit lead time to a customer-specified Shipment Date.

delivery detail

Contains items to be shipped out of a warehouse. This may be a sales order line, an 
RMA line, a WIP line or a PO line. They can be referred to as deliverables. 

delivery lead time 

Time (in days) is takes for items to reach the customer once it is shipped. It accounts 
for any non-working days in between. 
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delivery line 

A shippable and booked line from the planning pool which has been allocated to a 
delivery. After allocation, the line is no longer available in the planning pool. After 
the delivery is closed, the delivery line will also be considered closed.

directory services 

A mapping of Oracle Workflow users and roles to a site’s directory repository.

drop shipment 

A method of fulfilling sales orders by selling products without handling, stocking, 
or delivering them. The selling company buys a product from a supplier and has 
the supplier ship the product directly to customers.

drop ship item 

An item to be sourced externally from the vendor directly to a customer. 

export licenses 

A government license to supply certain products to certain countries that would 
otherwise be restricted.

export paper

A document required by governmental agencies that provides information on 
goods shipped out of or into a country.

external functions 

Programs that are executed outside of Oracle8.

fulfillment

Fulfilled sales order lines have successfully completed all Oracle Workflow 
processing activities up to eligibility for invoicing. 

fulfillment activity

The synchronization point or gate in the workflow process at which lines wait for 
other lines to be fulfilled.

fulfillment set 

Items in a fulfillment set will be available for scheduling and shipping only when 
all the items are available and ready to be scheduled/shipped. Fulfillment sets can 
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be complete only, or partially allowed but in proportions. ATO model, and a PTO 
Ship model Complete will be in a fulfillment set.

function

A PL/SQL stored procedure referenced by an Oracle Workflow function activity 
that can enforce business rules, perform automated tasks within an application, or 
retrieve application information. The stored procedure accepts standard arguments 
and returns a completion result.

function activity

An automated Oracle Workflow unit of work that is defined by a PL/SQL stored 
procedure. see function.

hold

A feature that prevents an order or order line from progressing through the order 
cycle. You can place a hold on any order or order line.

hold criteria

Criteria used to place a hold on an order or order line. A hold criteria can include 
customers, customer sites, orders, and items.

hold source 

An instruction for Oracle Order Management to place a hold on all orders or lines 
that meet criteria you specify. Create a hold source when you want to put all current 
and future orders for a particular customer or for a particular item on automatic 
hold. Oracle Order Management gives you the power to release holds for specific 
orders or order lines, while still maintaining the hold source. Oracle Order 
Management holds all new and existing orders for the customer or item in your 
hold source until you remove the hold source. 

hold type 

Indicates the kind of hold you place on an order or order line. 

inbound/outbound Lines

In the Oracle Order Management, lines on a header are either outbound (sales order 
lines in which material on the header is leaving the warehouse to go to a customer) 
or inbound (return lines in which material on the header is arriving at the 
warehouse to be credited back to the customer). In Order Management, headers can 
be Return (all inbound), Order (all outbound), or Mixed (both inbound and 
outbound lines).
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invoice

A document you create in Oracle Receivables that lists amounts owed for the 
purchases of goods or services. This document may list any tax and freight charges. 

A summarized list of charges, including payment terms, invoice item information, 
and other information that is sent to a customer for payment.

item 

A specific process, document, or transaction that is managed by a workflow 
process. 

Anything you make, purchase, or sell, including components, subassemblies, 
finished products, or supplies. Oracle Manufacturing also uses items to represent 
planning items that you can forecast, standard lines that you can include on 
invoices, and option classes you can use to group options in model and option class 
bills.

item attribute 

See Item Type Attribute. 

item type 

A grouping of all items of a particular category that share the same set of item 
attributes. For example, PO Requisition is an item type used to group all 
requisitions created by Oracle Internet Commerce’s Web Requisitions page. Item 
type is also used as a high level grouping for processes.

item type attribute 

A feature associated with a particular item type, also known as an item attribute. 
An item type attribute is defined as a variable whose value can be looked up and set 
by the application that maintains the item. An item type attribute and its value is 
available to all activities in a process.

lead time line

The production line Oracle Bills of Material uses to calculate the processing lead 
time for a particular repetitive assembly, since lead times may vary on different 
production lines.

lead time rollup 

An Oracle Bills of Material program that computes cumulative lead times for items.
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line lead time

The time required to complete the first assembly on a production line.

Lookup 

Attributes are validated by a lookup type. The lookup code is stored in the attribute, 
but the code’s translated meaning is displayed whenever the attribute value is 
viewed by an end user.

lookup code

The internal name of a value defined in an Oracle Workflow lookup type. see 
lookup type.

lookup type

An Oracle Workflow predefined list of values. Each value in a lookup type has an 
internal and a display name. 

message 

The information that is sent by a notification activity. A message must be defined 
before it can be associated with a notification activity. A message contains a subject, 
a priority, a body, and possibly one or more message attributes. 

message attribute

A variable that you define for a particular message to either provide information or 
prompt for a response when the message is sent in a notification. You can use a 
predefine item type attribute as a message attribute. Defined as a Send source, a 
message attribute gets replaced with a runtime value when the message is sent. 
Defined as a Respond source, a message attribute prompts a user for a response 
when the message is sent.

model 

An item whose bill of material lists options and option classes available when you 
place an order for the model item.

node 

An instance of an activity in a process diagram as shown in the Process window.

notification 

An instance of a message delivered to a user.
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notification activity 

A unit of work that requires human intervention. A notification activity sends a 
message to a user containing the information necessary to complete the work.

notification mailer 

A concurrent program that sends e-mail notifications to users via a mail application, 
and processes e-mail responses.

notification web page 

A web page that you can view from any web browser to query and respond to 
workflow notifications.

order category 

An Order Transaction Type can exist for any of the following order categories: 
Order, Return or Mixed. Line Transaction Types can be for any of the categories: 
Order or Return. When an order is created with a particular Transaction Type, the 
Order Category code determines which lines are permitted for that order. If the 
category code is Order, then the order can have only regular lines. If the category 
code is Return, then the order can have only return lines. If the category code is 
Mixed, then the order can have both kinds of lines.     

order scheduling   

See scheduling. 

order type 

Classification of an order. In Oracle Order Management, this controls an order’s 
workflow activity, order number sequence, credit check point, and transaction type.

parameter 

A variable used to restrict information in a report, or determine the form of a report. 
For example, you may want to limit your report to the current month, or display 
information by supplier number instead of supplier name.

performer 

A user or role assigned to perform a human activity (notification). Notification 
activities that are included in a process must be assigned to a performer.

pick-to-order

A configure-to-order environment where the options and included items in a model 
appear on pick slips and order pickers gather the options when they ship the order. 
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Alternative to manufacturing the parent item on a work order and then shipping it. 
Pick-to-order is also an item attribute that you can apply to standard, model, and 
option class items.

pick-to-order (PTO) item

A predefined configuration order pickers gather as separately finished included 
items just before they ship the order. 

pick-to-order (PTO) model 

An item with an associated bill of material with optional and included items. At 
order entry, the configurator is used to choose the optional items to include for the 
order. The order picker gets a detailed list of the chosen options and included items 
to gather as separately finished items just before the order is shipped.

picking

The process of withdrawing items from inventory to be shipped to a customer.

PO   

See purchase order.

process

A set of Oracle Workflow activities that need to be performed to accomplish a 
business goal. 

process activity 

A process modeled as an activity so that it can be referenced by other processes.

A process activity represents an activity that is referenced by a process. Each row 
specifies the usage of an activity as the child of a process. These instances are 
marked with machine-generated ID’s to uniquely identify multiple instances of the 
same activity in the same process.

process definition 

An Oracle Workflow process as defined in the Oracle Workflow Builder. See 
process.

process item type 

Oracle Workflow processes can exist for different process item types. A header flow 
will have a workflow process item type OEOH and a line flow will have a workflow 
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process item type OEOL. Process item types enable high level grouping of Oracle 
Workflow Processes.

profile option   

A set of changeable options that affect the way your applications run. In general, 
profile options can be set at one or more of the following levels: site, application, 
responsibility, and user.

protection level 

see access level.

PTO item   

See pick-to-order item.

PTO model   

See pick-to-order model.

purchase order 

A type of purchase order you issue when you request delivery of goods or services 
for specific dates and locations. You can order multiple items for each planned or 
standard purchase order. Each purchase order line can have multiple shipments and 
you can distribute each shipment across multiple accounts. 

Purchase Order (PO) / Sales Order (SO) 

The term Purchase Order represents the order as defined in Oracle Purchasing. The 
term Sales Order represents the order data as defined in Oracle Order Management.

received quantity

The quantity of an inventory item returned by a customer for which you are not 
issuing a credit. Sometimes this is temporary, while you evaluate the condition of 
the item; at other times you return the items to the customer, or keep them but do 
not allow a credit. 

receiving

Ad dock at the receiving facility to receive goods from suppliers or customers.

receiving and inspection 

A condition of a returned inventory item signifying it has been received but is being 
inspected for damage. If in acceptable condition, the items are transferred to stock 
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and a credit can be issued. If unacceptable, the items can be returned to the 
customer or scrapped.

release 

An actual order of goods and services you issue against a blanket purchase 
agreement. The blanket purchase agreement determines the characteristics and the 
prices of the items. The release specifies the actual quantities and dates ordered for 
the items. You identify a release by the combination of blanket purchase agreement 
number and release number.

release of hold 

The action of removing the hold on an order.

release reason 

Justification for removing a hold on an order or order line. 

repricing

Repricing is the ability to automatically, or through a workflow activity, cause the 
recalculation of the base price of an order line or for the entire order. Certain 
attribute changes to an order line can trigger automatic reprice. You can also insert 
the workflow Reprice activity within your order line workflow to force a order or 
line reprice at a particular point in time, according to your business practices.

reservation 

A guaranteed allotment of product to a specific sales order. A hold is placed on 
specific terms that assures that a certain quantity of an item is available on a certain 
date when transacted against a particular charge entity. Once reserved, the product 
cannot be allocated to another sales order or transferred in inventory. Oracle Order 
Management checks ATR (Available to Reserve) to verify an attempted reservation. 
Also known as hard reservation.

result code 

The internal name of a result value, as defined by the result type.

result type 

The name of the lookup type that contains an activity’s possible result values.

result value

The value returned by a completed activity.
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return

In Oracle Purchasing, an AutoCreate option that lets a buyer return a requisition 
line and all other unpurchased requisition lines on the same requisition to the 
requisition preparer.   In Order Management, it is the opposite of a sales order. It 
involves receipt of goods previously sold to a customer, credit to a customer, and 
possibly replacement with an identical or similar product.

role 

One or more users grouped by a common responsibility or position.

scheduling 

Order scheduling includes assigning demand or reservations, warehouses, 
shipment dates, and lots or sub inventories to an order line.

service item 

An inventory item used to define a service program or warranty. Service items can 
be recorded against serviceable products. A synonym for serviceable item is a 
serviceable product.

service order 

An order containing service order lines. Service may be for new products or for 
existing, previously ordered products.

ship confirm 

A process in Shipping Execution which allows you to identify shipped quantities, 
assign inventory control information for released lines, assign freight charges, and 
specify whether or not to back order unfulfilled quantities of released line items.

shippable item 

An item with the shippable inventory item attribute set to Yes, indicating that this 
item will appear on pick slips and pack slips. 

supply 

A quantity of materials available for use. Supply is replenished in response to 
demand or anticipated demand.

supply type   

A bill of material component field that controls issue transactions from inventory to 
work in process.
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transaction type

A feature that allows you to specify default values for orders and order lines 
including the customer, the ship-to location, and internal or external orders. 

timeout 

The amount of time during which a notification activity must be performed before 
the Workflow Engine transitions to an error process or an alternate activity if one is 
defined.

transition 

The relationship that defines the completion of one activity and the activation of 
another activity within a process. In a process diagram, the arrow drawn between 
two activities represents a transition.

WIP 

See work in process.

workflow definitions loader

A concurrent program that lets you upload and download workflow definitions 
between a flat file and a database.

workflow engine 

The Oracle Workflow component that implements a workflow process definition. 
The Workflow Engine manages the state of all activities for an item, automatically 
executes functions and sends notifications, maintains a history of completed 
activities, and detects error conditions and starts error processes. The Workflow 
Engine is implemented in server PL/SQL and activated when a call to an engine 
API is made.

Workflow Process 

This determines the header flow for an order transaction type or line flows possible 
for a line transaction type. There can be only one header flow associated with an 
order transaction type but a line transaction type can be coupled with different 
order types and item types and there can be different flow couplings for the 
permitted transaction type, item type combinations.

work in process 

An item in various phases of production in a manufacturing plant. This includes 
raw material awaiting processing up to final assemblies ready to be received into 
inventory.
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approve - continue line, 6-2
approve return - order, 5-2
approved, 6-33
assigning workflows to transaction types, 2-7
ato processes, 2-5
authorize to ship - check status, 6-7
authorize to ship - wait for authorization, 6-7
auto create po req, 6-8
autocreate FAS, 6-7
awaiting start date, 6-38

B
blanket - active, 6-38
blanket - expired, 6-38
blanket execution process, 5-91
blanket flow - generic, 4-61
blanket sales agreements, 6-37
blankets processes, 4-60
book, 6-2
book - continue line (complete), 6-2
book - deferred, 6-3
book - eligible, 6-3
book - order deferred, 5-4
book - order manual, 5-4, 5-6
branch on source type, 6-9

C
calculate cost rollup, 6-9
calculate lead time, 6-9

calculate lead time - setup parameters, 6-10
calculate price flag, 2-14
calculate purchase price, 6-11
check reservation, 6-11
check supply type, 6-11
close, 6-4, 6-12
close - blankets flow, 5-95
close - continue header, 6-12
close -- deferred, 6-12
close - order, 5-8
close - wait for line, 6-4
configuration - check status, 6-13
configuration - create BOM and routing, 6-13
create configuration, 6-13
create configuration - eligible, 6-14
create flow schedule, 6-14
create or match config item, 6-15
create supply order - eligible, 6-15
create work order - set up parameters, 6-15
cto change order, 1-18
cto change order process, 4-2
ctochord.wft, 1-9
customer acceptance process, 5-84
customer accepted, 6-34
customizations, 3-2

D
default error process, B-3
dependencies, 3-4
draft, 6-34
draft - customer rejected, 6-34
draft - internal rejected, 6-34
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E
end, 6-16, 6-32
end (complete), 6-16
end (incomplete), 6-16
end (non shippable), 6-16
end (not eligible), 6-17
end (over shipped beyond tolerance), 6-17
end (ship confirm), 6-17
end (unreserve), 6-17
enter, 6-4
enter - blankets, 6-37
error handling, B-1

expected, B-2
repricing, B-2

error processes, B-3
errors, B-1
exceptions, 3-3
expected errors, B-2
export compliance screening, 6-17
export compliance screening - eligible, 6-18
extending workflow, 3-3

example, 3-6
examples

approvals, 3-7
deferred booking, 3-8
process parameters, 3-6
time-out transition for notifications, 3-8

F
fulfill, 6-19
fulfill - continue header flow, 6-19
fulfill - deferred, 6-20
fulfill - wait for line, 6-5

G
generic processes, 2-3
guidelines, 3-5

H
header invoice interface - eligible, 6-5
header level processes, 2-3
hi volume order processing, 2-12

HVOP, 2-12

I
inbound processes, 2-6
internal approval process, 5-82
inventory interface, 6-20
inventory interface - deferred, 6-20
inventory interface - eligible, 6-21
invoice interface, 6-21
invoice interface - continue line, 6-5
invoice interface - deferred, 6-21
invoice interface - eligible, 6-22
invoice interface - header level, 6-6
is line scheduled, 6-22
item types

cto change order, 1-18
om blanket header, 1-20
om change order, 1-10
om negotiation header, 1-19
om order header, 1-11
om order line, 1-12
om standard, 1-15

L
line flow - ATO item, 2-5, 4-12
line flow - ATO model, 2-5, 4-15
line flow - configuration, 2-5, 4-17
line flow - configuration with authorize to ship 

(RLM), 2-6, 4-20
line flow - generic, 2-4, 4-23
line flow - generic bill only, 4-37
line flow - generic bill only with inventory 

interface, 4-39
line flow - generic ship only, 4-41
line flow - generic with authorize to ship 

(RLM), 2-6, 4-29
line flow - generic with export compliance, 4-34
line flow - generic with header level invoice 

interface, 2-4, 4-32
line flow - generic with repricing at 

fulfillment, 4-43
line flow - generic, bill only, 2-4
line flow - generic, bill only with inventory 
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interface, 2-4
line flow - generic, performance, 4-25
line flow - generic, ship only, 2-5
line flow - generic, with export compliance, 2-4
line flow - return for credit only, 2-6, 4-46
line flow - return for credit only with 

approval, 2-6
line flow - return for credit with receipt, 2-6, 4-50
line flow - return for credit with receipt and 

approval, 2-7
line flow - standard service, 2-7, 4-55
line flow return for credit only with 

approval, 4-48
line flow return for credit with receipt and 

approval, 4-52
line level processes, 2-3
line workflow assignments, 2-9
lost, 6-35

N
navigator paths, A-1
negotiation, 6-33
negotiation and blanket sales agreement 

processes, 2-7
negotiation flow generic, 4-57
negotiation flow with approval, 2-7, 4-58
negotiation process, 4-56
notifications for blanket sales agreement 

processes, 5-90

O
oexwford.wft, 1-7
offer - expire process, 5-86
offer expired, 6-35
om blanket header, 1-20
om change order, 1-10
om change order process, 4-4
om negotiation header, 1-19
om order header, 1-11, 6-2
om order header subprocesses, 5-2
om order line, 1-12, 4-11, 6-7
om standard, 1-15, 6-31
Oracle Release Management processes, 2-6

order flow - generic, 4-6
order flow - generic with header level invoice 

interface, 4-7
order flow - return with approval, 4-9

P
pending customer acceptance, 6-36
pending internal approval, 6-36
pricing date, 2-13
pricing phases, 2-13
purchase release, 6-23
purchase release - deferred, 6-23
purchase release - eligible, 6-23

R
reprice, 6-24
reprice - eligible, 6-24
repricing

handling errors in, B-2
troubleshooting, B-2

repricing at the line fulfillment date, 2-15
repricing at the line ship/schedule date, 2-14
repricing order lines, 2-13
Retry Only error process, B-3

S
schedule, 6-24
schedule - deferred, 6-25
schedule - eligible, 6-25
schedule workflow activity, 2-11
scheduling workflows, 2-11
seeded data files, 1-6
seeded function activity definitions, 6-1
seeded subprocess definitions, 5-1
seeded workflow definitions, 4-1

cto change order process, 4-2
om change order process, 4-4
om order header process, 4-5
om order line, 4-11

selecting workflows, 2-2
service item processes, 2-7
ship, 6-25
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ship - deferred, 6-26
standard, 6-32
start, 6-26, 6-32
submit draft, 6-36

T
terminate - blanket flow, 5-94
terminate - blankets, 6-38
troubleshooting, B-1

expected errors, B-2
repricing, B-2
viewing workflow status, B-3

unexpected errors, B-3
viewing workflow status, B-3

U
unexpected errors, B-3
utility - is return line receivable?, 6-26
utility - set notification approver, 6-31
utility to get line category, 6-26
utility to get supply source type, 6-27

V
viewing workflow status errors, B-3

W
wait, 6-32
wait for approval, 6-27
wait for booking, 6-28
wait for create configuration, 6-28
wait for CTO, 6-28
wait for inspection, 6-29
wait for invoice interface, 6-29
wait for PO receipt, 6-30
wait for receiving, 6-30
wait for required for revenue or delivery, 6-31
wait to firm - line service, 5-77
windows, A-1
workflow background engine processing, 2-10
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